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Handouts Outline 
The table below contains the type, number, and description of each handout. The data needed 
column identifies major datasets required to complete the activity. The data provided column 
identifies if that dataset is provided in the zip folder E0170_ActivityData for download. 

Type Number Description Data Needed Data 
Provided? 

Exercise 1.2  Build a 
hurricane study 
region. 

TX  No 

Activity 2.1 Explore the 
Comprehensive 
Data 
Management 
System 
(CDMS).  

FL No 

Exercise 2.2 Update state 
database using 
CDMS and 
create a new 
study region. 

FL; 
GBS.mdb,MedicalCareFacilities.mdb 

No; 
Yes 

Activity 3.2 Explore the 
Hazus 
inventory. 

N/A N/A 

Exercise 4.1 Create multiple 
historic storm 
scenarios and 
review the 
results. 

1916-6.pdf, 1919-2.pdf, 
harvey2017.pdf 

Yes 

Activity 4.2 Import 
Hurricane 
Harvey data 
using 
HURREVAC. 

N/A N/A 

Exercise 4.3 Create a Harvey_Winfield_HazusReady.dat Yes 
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Type Number Description Data Needed Data 
Provided? 

scenario with 
.dat data. 

Activity 4.4 Import 
Hurricane Irma 
data using a .bin 
file.  

FL; 
IrmaLandfallTrack.bin 

No; 
Yes 

Activity 5.2 Run a 
probabilistic 
scenario. 

Probabilistic.hpr Yes 

Demonstration 6.1 Review and 
discuss curve 
viewers.  

Irma_Hurricane.hpr Yes 

Exercise 6.2 Modify the 
surface 
roughness 
parameters in 
order to see the 
effect on the 
damages and 
losses. 

N/A N/A 

Demonstration 7.1 View results and 
reports from a 
hurricane 
analysis. 

Irma_ResultsReport.hpr Yes 

Exercise 7.2 Learn methods 
for displaying 
hurricane 
results. 

HurricaneMichael.hpr, 
TotalExposure.mdb 

Yes 

Exercise 8.2 Run a historic 
scenario and 
modify the 
economic loss 
parameters. 

FL; 
case1.pdf, case2.pdf, case3.pdf, 
case4.pdf, case5.pdf, case6.pdf 

No; 
Yes 
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Type Number Description Data Needed Data 
Provided? 

Demonstration 9.1 Show how to 
view shelter and 
tree parameters 

HurricaneMichael.hpr Yes 

Exercise 9.2 Explore the 
impact of 
altering tree and 
sheltering 
parameters 

N/A N/A 

Activity 10.2 Create a 
combined 
Flood/Hurricane 
study region.  

FL No 

Exercise 10.3 Explore the 
Surge menu 
items in the 
hurricane model 
and flood 
model. Discuss 
the reports and 
tables from the 
combined 
losses. 

Irma_Surge.hpr Yes 

Discussion 11.1 Discuss 
mitigation 
options. 

N/A N/A 

Exercise 11.2 Run various 
mitigation 
scenarios. 
Compare and 
contrast the 
results.  

FL No 

Demonstration 12.1 Discuss and 
demonstrate 
Forecast 

Demo12.1_Forecast39.hpr, 
Demo12.1_Forecast44.hpr 

Yes 
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Type Number Description Data Needed Data 
Provided? 

Advisory 
Uncertainties. 

Exercise 12.2 Run various 
user-defined 
scenarios.  
Compare the 
results.  

TX; 
forecast advisory 21 global summary 
report.pdf, Harve Forecast Advisory 
21.pdf, 
Harvey_Windfield_HazusReady.dat, 
hurrevac gloval summary report.pdf, 
hwind global summary report.pdf 

No; 
Yes 

Exercise 13.1 Modify 
uncertain and 
sensitive 
variables in 
Hazus. Run 
multiple 
scenarios. 
Compare the 
results. 

FL; 
IrmaLandfallTrack.bin 

No; 
Yes 

 

Data Dictionary 

The table below contains the type, number, and data file name for each exercise. The data 
provided can be found in the zip folder E0170_ActivityData for download.  

Type Numbe
r 

Data Folder Name Data Provided  

Exercis
e 

1.2 N/A N/A 

Activit
y 

2.1 Activity_2.1 N/A 

Exercis
e 

2.2 Exercise_2.2 GBS.mdb, 
MedicalCareFacilities.mdb 
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Type Numbe
r 

Data Folder Name Data Provided  

Activit
y 

3.2 N/A N/A 

Exercis
e 

4.1 Exercise_4.1/Results 1916-6.pdf, 1919-2.pdf, 
harvey2017.pdf 

Activit
y 

4.2 N/A N/A 

Exercis
e 

4.3 Exercise_4.3 Harvey_Winfield_HazusReady.dat 

Activit
y 

4.4 Activity_4.4 IrmaLandfallTrack.bin 

Activit
y 

5.2 Activity_5.2 Probabilistic.hpr 

Demon
stration 

6.1 Demonstration_6.1 Irma_Hurricane.hpr 

Activit
y 

6.2 N/A N/A 

Demon
stration 

7.1 Demonstration_7.1 Irma_ResultsReport.hpr 

Exercis
e 

7.2 Exercise_7.2 HurricaneMichael.hpr, 
TotalExposure.mdb 

Exercis
e 

8.2 Exercise_8.2/Results case1.pdf, case2.pdf, case3.pdf, 
case4.pdf, case5.pdf, case6.pdf 

Demon
stration 

9.1 Demonstration_9.1 HurricaneMichael.hpr 

Exercis
e 

9.2 N/A N/A 
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Type Numbe
r 

Data Folder Name Data Provided  

Activit
y 

10.2 N/A N/A 

Exercis
e 

10.3 Exercise_10.3 Irma_Surge.hpr 

Discus
sion 

11.1 N/A N/A 

Exercis
e 

11.2 Exercise_11.2 N/A 

Demon
stration 

12.1 Demonstration_12.1 Demo12.1_Forecast39.hpr, 
Demo12.1_Forecast44.hpr 

Exercis
e 

12.2 Exercise_12.2 forecast advisory 21 global summary 
report.pdf, Harve Forecast Advisory 
21.pdf, 
Harvey_Windfield_HazusReady.dat, 
hurrevac gloval summary report.pdf, 
hwind global summary report.pdf 

Exercis
e 

13.1 Exercise_13.1 IrmaLandfallTrack.bin 

 

A Note on Understanding Images 

Please note that many of these documents contain images that assist in the completion of the 
activities. These images are explained both by the surrounding text and by the alt text provided 
with the image. For individuals accessing the course with the relevant technology, please read 
the surrounding text and the alt text to gain a full understanding of the image. 
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Lesson 1: Hazus for Hurricanes 



August 2020 E0170: Hazus for Hurricanes 

Lesson 1: Hazus for Hurricanes  SM-10 

Visual 1: Lesson 1: Introductions and Overview 
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Visual 2: Let's Get Acquainted! 
• Participant introductions 

• Name 
• Organization  
• Role in organization  
• Hazus, GIS, and hazard analysis experience  
• Goals and expectations for this class  

• Instructor introduction 
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Visual 3: Course Agenda 
Day One: 

• Lesson 1: Introduction and Overview 
• Lesson 2: Hazus Inventory 
• Lesson 3: Hurricane Wind Model 
• Lesson 4: Deterministic Scenarios 
• Lesson 5: Probabilistic Scenarios 

  
Day Two: 

• Lesson 6: Damage Models 
• Lesson 7: Hurricane Model Results 
• Lesson 8: Economic Loss Methodology 
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Visual 4: Course Agenda 
Day Three: 

• Lesson 9: Hurricane Surge Model 
• Lesson 10: Shelter and Debris Models 
• Lesson 11: Mitigation Analysis 
• Lesson 12: Hazus Response and Recovery Applications 

  
Day Four: 

• Lesson 13: Uncertainty and Sensitivity 
• Lesson 14: Capstone Exercise 
• Lesson 15: Course Wrap Up 
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Visual 5: Course Prerequisites 
• Have a broad understanding of the goals of loss estimation and hurricane hazards 

• This course will provide an introduction to assessing risks associated with natural 
hazards and orients participants to Hazus capabilities  

• This course will focus on Basic and Intermediate analyses  
• Have familiarity with ArcGIS  
• Have successfully completed E0313: Basic Hazus 

 

 

Student 
Manual 

 

Course Prerequisites 
Information from National Preparedness Course Catalog Website. 
(https://www.firstrespondertraining.gov/frt/npccatalog/EMI#anc-search-results) 

 

http://www.firstrespondertraining.gov/frt/npccatalog/EMI#anc-search-results
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Visual 6: Course Tasks 
• Lecture  
• Discussion  
• Demonstration: Instructor-Only 

• Students observe instructor completing task  
• Activity: Instructor-Led  

• Guided Practice  
• Students follow along and complete task with Instructor  

• Exercise: Student-Led  
• Individual or Small Group Practice  
• Hands-on  
• Shows how to apply material from this course to an actual incident  
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Visual 7: Hints for Success 
Ask LOTS of questions! There are NO "silly" questions. 
Share your experiences with the rest of the class - they will learn from you and you from them. 
Try to apply the concepts presented in class to your own needs. If you don't see applicability, ask 
for an example. 
Practice the skills that you learn in class right away. 

• In class (exercises and activities) 
• After class (use it or lose it) 
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Visual 8: Lesson 1: Goal and Objectives 
Goal: To provide an overview of Hazus and review the Hazus Hurricane Model.  
After completing this lesson you will be able to: 

• Describe Hazus and the various hazards it supports.  
• Differentiate between the Hazus Hurricane Model and Surge Model.  
• Explain the differences in Hazus analysis levels as they pertain to the hurricane model.  
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Visual 9: What is Hazus? 
• A package of software tools and support system designed by FEMA for the purpose of 

providing communities with the means to identify and reduce risk from natural hazards 
• Used by a variety of communities and organizations  
• Available from FEMA free of charge (requires ArcGIS license with Spatial Analyst 

extension) 
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Visual 10: Supported Hazards 
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Visual 11: History 
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Visual 12: FEMA Hazus Website 
 
Primary FEMA resource for updated 
information related to Hazus: 
FEMA Hazus Website (www.fema.gov/hazus)  

 
 

 

http://www.fema.gov/hazus
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Visual 13: Using Hazus to Support Emergency 
Management 
  

 
• Identify vulnerable areas  
• Estimate potential impacts of hazards  
• Inform resource allocation  
• Prioritize mitigation measures  
• Assess level of readiness and 

preparedness  
• Inform response and post-disaster 

recovery efforts  
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Visual 14: Who is a Hazus User? 
• Hazus is used by a variety of communities and organizations across the United States:  

• Local and State Government  
• Federal Agencies  
• Educational Institutions  
• Private Industry  
• Others  

• Considerable international interest 
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Visual 15: User Levels 
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Visual 16: Hurricane Levels of Analysis 
• Level 1: Analysis Based on Default Information  

• Default general building stock and essential facility databases  
• Default database of surface roughness and tree coverage  

• Level 2: Analysis with User-Supplied Inventory  
• Modify the general building stock and essential facility databases based on local 

expertise  
• Develop maps of tree coverage  
• Use local data concerning direct economic analysis parameters  

• Level 3: Analysis with Advanced Data  
• Supply local terrain (surface roughness data)   
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Visual 17: Inventory (Exposure) 
General building types and occupancies  

• Lifelines  
• Replacement costs 
• Demographics 

Hazard-specific 
• Specific building types 
• First floor elevations 
• Building configurations  
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Visual 18: Loss Estimation Process 
 

• Identify hazard  
• Identify physical landscape  
• Consider what is at risk 
• Produce maps, tables, and reports  
• Analyze social and economic impacts  
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Visual 19: Integrating User-Provided Data 
Non-Hazard Data Integration Tools 

• Comprehensive Data Management System (CDMS) enables integration of locally 
developed non-hazard data 

• CDMS validates that user data are compliant with Hazus requirements 
Hazard Data Integration 

• ShakeMap (for EQ) and Hurrevac (for HU) hazard data integration 
• Each model includes tools for integrating user-provided hazard data 

Techniques for integrating user-provided data are covered in other courses 
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Visual 20: Hazus 4.2 Capabilities 
Hazus 4.2 
Capabilities 

Earthquake Flood Hurricane Tsunami 

Inputs 

Ground 
Shaking  
Ground 
Failure  

Frequency 
|Depth 
Riverine 
|Coastal Surge 

Wind 
Surge 

Depth 
|Momentum 

Flux  
Runup 

|Velocity  

 Historic x x x  

 Deterministic x x x x 

 Probabilistic x x x  

 User-supplied x x x x 

 Other supported 
inputs 

Real-time & 
scenario USGS 

ShakeMaps  

Risk MAP, User-
supplied depth 

grids (ArcGRID, 
GeoTIFF, 

IMAGINE), 
HEC-RAS 

(.FLT)  

Hurrevac, User-
supplied wind 

files (.dat)  

NOAA PMEL 
SIFT, State 

models  
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Visual 21: Hardware and Software Requirements 
• Memory: 4 GB or higher  
• Disk space: 10GB for one multi-hazard large urban study region, plus inventory data size 

(varies by state), or 70 GB to store entire U.S. inventory data  
• Graphics Adaptor: 24-bit capable video card with at least 128 MB of video memory, 

resolution of 1078 x 768 or higher  
• Operating Systems: Windows 10 Pro and Enterprise, Windows 8.1*, and Windows 7 

Pro* (64-bit); only U.S. English version are supported for use** 
• Supporting Software: Appropriate version of Esri ArcGIS for Desktop and the Spatial 

Analyst extension for the flood and tsunami models 
*Hazus is no longer supported but still operates on these platforms 
**Hazus can be installed on other windows operating systems/service packs, but Hazus may not 
operate as expected with those operating systems/service packs. 
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 1: Hazus for Hurricanes  SM-31 

Visual 22: Installation 
• Log in with a full Administrator account 
• Download Hazus from the Map Service Center website. 

(msc.fema.gov/portal/resources/hazus) 
• Unzip the downloaded file 
• Right-click on setup.exe file and select “Run as Administrator” option  
• “Administrator Rights” can vary - consult the “Getting Started.pdf” document to ensure a 

proper installation 
 

http://msc.fema.gov/portal/resources/hazus
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Visual 23: Study Region Location 
 

• All study regions will be created in the 
folder specified in this window 

• All data related to the Study Region 
will be stored in this location 

• Default location is 
C:\HazusData\Regions  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 1: Hazus for Hurricanes  SM-33 

Visual 24: Study Region Size 
• Size limit of 10 GB per database for SQL Server 2014 Express  
• The success of a Hazus analysis will depend on the available system resources of the PC  
• Large flood (riverine or coastal) and combined flood/wind analyses require large amounts 

of system resources even for small geographic areas (e.g., a single county) 
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 1: Hazus for Hurricanes  SM-34 

Visual 25: Study Region Options 
 
Hazus Startup Dialog  

• Create a new region  
• Open a region  
• Delete a region  
• Duplicate a region  
• Export/Backup a region  
• Import a region  
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Visual 26: Study Region Creation by Scenario 
 

• Unique to a hurricane-only study region  
• When a user creates a hurricane-only 

study region, it can be defined by a 
scenario (historic, user-defined, etc.).  

• The counties that would experience 
damage by intersecting with hurricane 
windspeeds are included in the region.  

 

 
NOTE: After clicking "Yes" the screen takes you to the scenario wizard. 
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Visual 27: Components of Hazus Hurricane Wind 
Model 
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Visual 28: Hazus Combined Hurricane Wind and 
Storm Surge Model 

• User works in Hurricane Wind model then runs the surge using the Flood model  
• Utilizes industry standard models:  

• SLOSH - Sea, Lake, and Overland Surges from Hurricanes; National Weather 
Service's Meteorological Development Laboratory.  

• SWAN - Simulating Waves Nearshore; Delft University of Technology  
• Modified WHAFIS - to propagate waves inland from the shoreline  
• Allows for estimation of combined economic losses to general building stock for 

hurricane scenarios on coastal flood regions  
• Avoids double counting of flood and wind losses  
• Service Pack 3 allows users to import and run a combined wind/surge with user-defined 

surge products* 
  
*for user-defined flood hazard information, please reach out to the help desk at hazus-
support@riskmapcds.com 
 

mailto:hazus-support@riskmapcds.com
mailto:hazus-support@riskmapcds.com
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Visual 29: Discussion 1.1: Hazus Applications 
Goal: Identify two ways that you would like to apply the information that Hazus generates in 
support of one or more of the following emergency management activities:  

• Mitigation  
• Preparedness  
• Response  
• Recovery  

 
Groups: 3 to 6 people  
Time: 10 minutes  
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Discussion 1.1: Hazus Applications 
Goal: Identify two ways that you would like to apply the information that 
Hazus generates in support of one or more of the following emergency 
management activities:  

• Mitigation  
• Preparedness  
• Response  
• Recovery  

Groups: 3 to 6 people  
Time: 10 minutes  
Discussion Steps:  

1. Listen to the instructor’s directions.  
2. Ask questions if they need directions clarified.  
3. Discuss the questions with your group.  
4. Designate a group member to share your answers with the class.  
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Visual 30: Exercise 1.2: Hurricane Study Region 
Goal: Build a hurricane study region.  
Time: 15 minutes  
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Manual 

 

Exercise 1.2: Hurricane Study Region 
Goal: Build a hurricane study region. 
Time: 15 minutes  
Exercise Steps:  

1. Listen to the instructor’s directions.  
2. Ask questions if clarification is needed.  
3. Work individually on the goal.  
4. Ask questions to the instructor if needed.  
5. Complete the assigned goal.  
6. Be prepared to share your answers/results.  
7. Ask any final questions.  
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Visual 31: Exercise 1.2: Tasks 
Task 1: Create a New Study Region. 
Task 2: Select Areas Affected by Hurricane Harvey. 
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Exercise 1.2: Tasks 
• Refer to Activities Document “01.2_Exercise_Hurricane Study 

Region.” 
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Exercise 1.2: Hurricane Study Region  
Type: Instructor-Led Exercise 
Time: 15 minutes  
Goals: Build a hurricane study region. 
 

Task 1: Create a New Study Region.   

1. Open Hazus from your desktop and select “Create a new region.”  
2. Click “OK.”  
 

 

 
 

 
3. Click “Next” on the Create New Scenario Wizard.  
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4. Enter a name and a brief description (optional) for your study region. Click “Next.”  
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5. Select “Hurricane” as the Hazard type. Click “Next.”  
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6. Select “No” when prompted to create the study region using the Hurricane Scenario 
Wizard. By continuing to create the study region only, you will be able to use the study region 
for multiple scenarios later. If you create a study region using the Hurricane Scenario Wizard, 
the study region will be used for ONLY that scenario. 
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Task 2: Select Areas Affected by Hurricane Harvey.    

1. Select “County” as the aggregation level.  
2. Click “Next.”  
 

 

 
 

 
3. Select “Texas” from the list of states.  
4. Click “Next.”  
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5. Select “Aransas” and “Nueces” from the list of counties and click “Next.”  
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6. Click “Finish” to complete the Create New Region Wizard.  
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7. After a few minutes, a dialog box will appear indicating that your region was aggregated 
successfully. Click “OK.” 
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Visual 32: Lesson 1: Review 
1. What is Hazus?  
2. What are the four hazards supported by Hazus?  
3. Explain the Hazus Hurricane Model. Then, explain The Surge Model. 
4. Provide an example of a basic and advanced analysis using the Hazus hurricane model.  
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Visual 33: Capstone Exercise Preview 
Goal: Use Hazus to help a county assess hurricane risk in order to develop hurricane mitigation 
OR response and recovery strategies.  
Planning:  

• Day 2 afternoon  
• Day 3 afternoon  
• Day 4 morning  

Presentation:  
• Day 4 afternoon  
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Visual 34: Capstone Exercise Preview 
• There is no written final exam for this course  
• Participants will be evaluated based on:  

• Completeness of the final presentation  
• Use of the ideas learned in this class  
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Visual 35: Capstone Exercise Explanation 
• The county planning board has hired your team to give a 20-minute PowerPoint 

presentation at its next public meeting on the severity of hurricane hazards in the county 
and the possible methods for mitigating or responding to future hurricane damage in that 
county.  

• You, as the consultants and Hazus experts, have decided to use Hazus to analyze the 
county’s hurricane risk.  

• The results of your study will be presented at the monthly commissioners meeting.  
• Each group will present while the remaining participants assume the role of the 

commissioners. 
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Visual 36: Capstone Exercise Explanation 
Required issues to be addressed:  

• Which major hurricane(s) have impacted this region in the past?  
• What damage would the worst of these storms produce if it happened again today?  
• What is the approximate return period for the worst historic winds?  
• Summarize the number and value of buildings at risk to hurricanes.  
• Provide a map of essential facilities, high potential loss facilities, and any additional 

features you deem important for risk communication.  
• What are potential benefits of mandating shutters on all new single-family dwellings? 

Summarize the assumptions made in your benefit analysis.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 1: Hazus for Hurricanes  SM-55 

Visual 37: Capstone Exercise Explanation 
Presentation Guidelines:  

• Prepare using PowerPoint. 
• Include maps, tables, or other media you deem appropriate and helpful for conveying 

your message.  
• Information should be primarily derived from Hazus, but may be supplemented by other 

sources.  
• 10-15 minutes in length, allowing 5 minutes for questions 

Commissioner Guidelines: 
• Class will assume the role of commissioners.  
• Commissioners may ask questions related to the presentation.  
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Visual 38: Capstone Exercise Preparation 
• Capstone Exercise Strategy  
• Past Presentation Examples  
• Preparation  

• Discuss strategies.  
• Select a state to use for the analysis.  
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Capstone Exercise Preparation 
• Capstone Exercise Strategy  

• Everyone needs a role and to work with Hazus.  
• Make sure goals are achievable within the time frame.  
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Visual 39: Questions? 
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Lesson 2: Hazus Inventory 
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Visual 1: Lesson 2: Hazus Inventory 
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Visual 2: Lesson 2: Goals and Objectives 
Goal: To provide an overview of the data included with Hazus, emphasizing hurricane-specific 
inventory, and of the tools and processes to update the data.  
After completing this lesson you will be able to:  

• Describe the types of aggregate and point inventory supported by the Hazus hurricane 
model.  

• List the options that Hazus provides for updating inventory. 
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Visual 3: Inventory Components: Aggregate 
Inventory 
 
Aggregate Inventory  

• Demographics  
• General Building Stock broken down by 

type (how constructed) and occupancy 
(how used)  

Hazard-Specific Inventory (both aggregate and 
site-specific)  
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Visual 4: Inventory Components: Site Specific 
Inventory 
 
Site-Specific Inventory  
Hazard-Specific Inventory (both aggregate and 
site-specific)  
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Visual 5: Inventory Update Tools 
State and Study Region Updates 

• Comprehensive Data Management System (CDMS) 
Study Region Only Updates 

• Access databases - use import tools in Hazus 
• ArcGIS editing tools 

  
NOTE: E0317: CDMS provides considerably more detail about inventory updates. 
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Visual 6: Comprehensive Data Management 
System 
  

 
• System for integrating user provided 

site-specific and aggregate data into the 
Hazus state databases. 

• CDMS supported data includes: 
• Site-specific / Aggregate 
• Data Types 

 xls 
 shp 
 mdb  
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Visual 7: Comprehensive Data Management 
System 
Functions:  

• Validates user provided data  
• Parses data into appropriate Hazus tables  
• Provides historical tracking of database updates  
• Can import/export data from/to a variety of formats  
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Visual 8: Demographic Data 
 

• Aggregated at census tract (hurricane 
and earthquake) level  

• Detailed by:  
• Age  
• Income  
• Ethnicity  
• Ownership  
• Gender  
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Visual 9: What is the General Building Stock? 
 
An engineering based estimation of buildings 
for the US represented by:  

• Floor area (Sq Ft)  
• Value ($)  
• Count of all structures by occupancy 

type  
Data Sources: 

• Residential: from US Census Data  
• Commercial / Industrial: from Dun & 

Bradstreet   
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Visual 10: Aggregate Inventory: General Building 
Stock 
Specific Occupancy Categories  

• 33 Specific Occupancy Types  
• You can view the categories from the Inventory menu  

Specific Occupancy General Occupancy Description 

AGR1 Agriculture Agriculture 

COM1 Commercial Trade 

COM2 Commercial Wholesale Trade 

COM3 Commercial Personal and Repair Service 

COM4 Commercial Professional/Technical 
Service 

COM5 Commercial Banks 

COM6 Commercial Hospital 
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Visual 11: GBS: Building Count 
 
Square Footage Factors  

• Average square footage for each 
specific occupancy determined during 
model development  

• Building counts computed by dividing 
floor area by average square footage  

 

 
NOTE: RES1 (single family homes) and RES2 (manufactured housing) are derived from 
census housing unit counts. 
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Visual 12: Activity 2.1: Comprehensive Data 
Management System 
Goal: Explore the Comprehensive Data Management System.    
Time: 30 minutes  
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Visual 13: Activity 2.1: Tasks 
Task 1: How to Use CDMS to Update Inventory.  
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Activity 2.1: Comprehensive Data Management System 
Type: Student Activity  
Time: 30 minutes  
Goal: Explore the Comprehensive Data Management System.  
 

Task 1: How to Use CDMS to Update Inventory.  

1. Double click the CDMS icon on the desktop to start CDMS.  
2. Navigate to Tools and then select “Specify Hazus Data Location”.  
 

 

 
 

 
3. Click “Browse” and navigate to C:\HazusData\Inventory\FL to set the Hazus State Data 
location to “Florida”. 
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4. Click OK.  
5. Click “Query/Export Statewide Datasets”.  
6. Under Search By Geographic Area, select “County” from the drop down selection.  
7. Click to highlight Broward county and select the right arrow to move it to the selected list.  
8. Choose “Essential Facilities” from the drop down under Search by Data Layer.  
9. Click to highlight the Fire Station Facilities and select the right arrow to move it to the 
selected list.  
10. Click the checkbox next to Hurricane Wind for this exercise.  
11. The CDMS screen should appear as below:  
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12. Click “Search” at the bottom of the screen to find all of the fire stations in the county.  
13. Click “Export to Excel” to export the fire stations to an Excel file.  
Note: If you are unable to export to Excel, export to a geodatabase first. Then, convert it to an 
.xls. The .xls can be edited and imported back into CDMS.  
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14. Choose the radio button next to "Export currently selected layer" and click Submit. 
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15. Navigate to the C:\E0170_ActivityData\Activity_2.1 folder and name the folder 
“Broward_FireStations” and click “Save”.  
16. Click OK once complete.  
17. Click Delete All Records for Selected Inventory to delete all of the fire stations for the 
county.  
18. Click “Yes” on the warning that it cannot be undone.  
19. Minimize CDMS.  
20. Open the Excel file saved to C:\E0170_ActivityData\Activity_2.1 and change the address of 
the first fire station.  
21. Save the changes to the Excel table (be sure not to save to the Office 2007 format) and close 
Excel.  
22. Maximize CDMS and click CDMS Home.  
23. Click Import into CDMS Repository from File to import the edited Excel file.  
 

 

 
 

 
24. Select “Browse” and navigate to C:\E0170_ActivityData\Activity_2.1 to import the edited 
Excel file. You may need to change the file type at the bottom of the screen to Microsoft Excel 
File (*.xls) in order for the file to appear.  
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25. Uncheck the boxes next to Earthquake and Flood.  
26. From the Inventory Category drop down, select “Essential Facilities”.  
27. From the Inventory Dataset (Layer) select “Fire Stations”.  
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28. Click “Continue”. 
29. Change the Import table to "Fire Station Facilities.”  
30. From the drop down menu under Select Hazus ID-Field select No HAZUS ID.  
31. Select “Latitude” from the Latitude (Y) Field drop down menu and select “Longitude” from 
the Longitude (X) Field drop down menu.  
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32. Click “Continue”.  
33. Click OK to Categorize Fields. These data values are already matched to the proper Hazus 
fields since they were exported from Hazus.  
34. Click continue on the following screens until the import is successfully completed.  
35. Click OK on the message stating the import was successful.  
36. In the CDMS Repository click on the View/Edit button.  
37. Notice that the address of the first record reflects the changes you made in Excel.  
38. Click Close.  
39. Click Transfer to Statewide Dataset.  
40. Select the radio button next to the Append/Update option and click Submit.  
41. Query the county for which you imported the fire stations and look for the updated  
42. Click Yes to confirm you want to transfer the layer.  
43. Close CDMS.  
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Visual 14: GBS: Damage States 
GBS results for damage can be mapped by occupancy and building type  

• Damage represented by damage states (moderate, severe, etc.)  
• Damage state values represent the expected fraction of building square footage in each 

damage state  
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Visual 15: General Occupancy Categories 
 
Seven general occupancy classes: 

• Majority of Building Stock 
1. Residential 
2. Commercial 
3. Industrial 

• Others 
4. Agriculture 
5. Religion 
6. Government 

7. 
Education 
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Visual 16: Specific Occupancy Categories 
33 Specific Occupancy Types:  

• 11 Residential Classes  
• 10 Commercial Classes  
• 6 Industrial Classes  
• 2 Government Classes  
• 2 Education Classes  
• 1 Agriculture Class  
• 1 Religious Class  
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Visual 17: General Building Types 
Five General Building Types: 
1. Wood 
2. Steel 
3. Concrete 
4. Masonry 
5. Manufactured Housing (Mobile Home) 
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-84 

Visual 18: General Building Type Mapping 
• Mapping Scheme Management:  

• View 
• Copy 
• Edit 
• Delete 
• Import 
• Export  

 

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-85 

Visual 19: Aggregated Building Stock 
Building Count: By building type 
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Visual 20: Specific Building Types (SBT) 
 
Thirty-nine Specific Building Types:  

• 5 Wood  
• 9 Steel  
• 6 Concrete  
• 14 Masonry  
• 5 Manufactured Housing (Mobile 

Home)  
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Visual 21: Specific Building Type Mapping 
• Mapping Scheme Management:  

• View 
• Copy 
• Edit 
• Delete 
• Import 
• Export  
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Visual 22: Hurricane-Specific Inventory 
 
Wind-Building Mapping 
Schemes 
Florida: 4 Regions  
Hawaii: 4 Regions  
Other States: 4 Regions  

1. Northeast Inland  
2. Northeast 

Coastal  
3. Southeast Inland  
4. Southeast 

Coastal  

 
A map of the different Wind-Building Mapping Schemes for the 
"Other" states and Florida. 
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Visual 23: Hurricane-Specific Inventory 
 
Wind-Building Mapping Schemes 
Florida building stock regions  

• Different building codes  
• Southeast Florida has historically 

stronger wind provisions for past 
decade 

• Different building practices  
• More wood frame in northern 

portion of Florida than southern 
Florida 
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Key Points 
Florida is divided into 4 regions. 

• Southeast Florida  
• South Florida  
• Middle Florida  
• North Florida  
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Visual 24: Hurricane-Specific Inventory 
 
Wind-Building Mapping Schemes 
Hawaii Building Stock Regions 

• Different wall construction type  
• Single wall vs. double wall 

• Different roof deck construction  
• Metal roof deck  

• Different foundation type  
• Applies only to single-family models  
• All other SBT models are identical to 

mainland US.  
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Key Points 
Hawaii is divided into 4 regions:  

• Hawaii Hawaii - Island of Hawaii 
• Hawaii Honolulu - Island of Oahu 
• Hawaii Maui - Islands of Maui, Kaho'olawe, Lanai, and Molokai 
• Hawaii Kauai - Islands of Kauai and Ni'ihau 

Hawaii has different construction types, therefore different building mapping 
schemes were developed.  
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Visual 25: Hurricane-Specific Inventory: Wind-
Building Mapping Schemes 

• Eight Mapping Schemes  
• Consider: 

• Roof type 
• Secondary water resistance 
• Roof deck attachment 
• Roof wall connection 
• Shuttering  
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Visual 26: Pre-FIRM Sub-Assembly Replacement 
Values 
Reference your manual for the table of Pre-FIRM Sub-Assembly Replacement Values 
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Sub-Assembly Replacement Values 
Pre-FIRM Sub-Assembly Replacement Values 

Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES1: 
Single 

6% 2% 13% 5% 5% 20% 49% 100% 

RES2: 
MH 

6% 2% 10% 3% 5% 20% 54% 100% 

RES3A: 
Duplex 

6% 2% 13% 5% 5% 20% 49% 100% 

RES3B: 
3-4 units 

6% 2% 13% 5% 5% 20% 49% 100% 

RES3C: 
5-9 units 

5% 1% 10% 2% 3% 10% 69% 100% 

RES3D: 
10-19 
units 

5% 1% 10% 2% 3% 10% 69% 100% 

RES3E: 
20-49 
units 

5% 1% 13% 1% 3% 10% 67% 100% 

RES3F: 
50+ 
units 

3% 0% 13% 1% 1% 13% 69% 100% 

RES4: 
Temp. 
Lodging 

3% 1% 9% 1% 2% 10% 74% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES5: 
Instituti
onal 
Dormito
ry 

4% 0% 14% 1% 3% 14% 64% 100% 

RES6: 
Nursing 
Home 

5% 0% 10% 3% 2% 13% 67% 100% 

COM1: 
Retail 

6% 1% 10% 5% 5% 10% 63% 100% 

COM2: 
Wholesa
le 

20% 1% 7% 9% 7% 11% 45% 100% 

COM3: 
Personal 
& repair 
services 

10% 1% 8% 7% 3% 10% 61% 100% 

COM4: 
Professi
onal/Bu
siness 

4% 1% 11% 1% 3% 17% 63% 100% 

COM5: 
Banks 

6% 0% 10% 4% 9% 8% 63% 100% 

COM6: 
Hospital 

2% 0% 7% 1% 4% 7% 79% 100% 

COM7: 
Medical 

5% 1% 5% 3% 2% 12% 72% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

Office 

COM8: 
Entertai
nment 

9% 1% 10% 4% 3% 8% 65% 100% 

COM9: 
Theaters 

6% 1% 10% 5% 6% 10% 62% 100% 

COM10
: 
Parking 

12% 0% 40% 0% 10% 9% 29% 100% 

IND1: 
Heavy 

14% 1% 3% 7% 3% 10% 62% 100% 

IND2: 
Light 

15% 1% 4% 9% 7% 11% 53% 100% 

IND3: 
Food/Ch
emical 

11% 1% 4% 8% 6% 11% 59% 100% 

IND4: 
Metals/
Mineral 
Processi
ng 

7% 0% 25% 2% 6% 8% 52% 100% 

IND5: 
High 
Technol
ogy 

11% 0% 5% 4% 4% 4% 72% 100% 

IND6: 20% 1% 7% 9% 7% 11% 45% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

Constru
ction 

AGR1: 
Agricult
ure 

26% 0% 8% 9% 9% 12% 36% 100% 

REL1: 
Church 

10% 1% 12% 4% 17% 10% 46% 100% 

GOV1: 
General 
Services 

10% 1% 12% 6% 4% 8% 59% 100% 

GOV2: 
Emerge
ncy 
Respons
e 

6% 0% 15% 2% 2% 12% 63% 100% 

EDU1: 
School 

4% 1% 12% 3% 6% 10% 64% 100% 

EDU2: 
College 

4% 1% 10% 2% 3% 8% 72% 100% 

Wood 6% 1% 13% 4% 4% 16% 56% 100% 

Steel 4% 0% 12% 1% 2% 15% 66% 100% 

Masonr
y 

7% 1% 14% 3% 3% 18% 54% 100% 

Concret
e 

4% 0% 12% 1% 2% 15% 66% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

MH 6% 2% 10% 3% 5% 20% 54% 100% 
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Visual 27: Post-FIRM Sub-Assembly Replacement 
Values 
Reference your manual for the table of Post-FIRM Sub-Assembly Replacement Values 
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-99 

Sub-Assembly Replacement Values  
Post-FIRM Sub-Assembly Replacement Values 

Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES1: 
Single 

11% 3% 10% 5% 5% 19% 47% 100% 

RES2: 
MH 

8% 2% 10% 3% 5% 20% 52% 100% 

RES3A: 
Duplex 

11% 3% 10% 5% 5% 19% 47% 100% 

RES3B: 
3-4 units 

11% 3% 10% 5% 5% 19% 47% 100% 

RES3C: 
5-9 units 

10% 1% 9% 2% 3% 9% 66% 100% 

RES3D: 
10-19 
units 

10% 1% 9% 2% 3% 9% 66% 100% 

RES3E: 
20-49 
units 

10% 1% 12% 1% 3% 10% 63% 100% 

RES3F: 
50+ 
units 

8% 0% 12% 1% 1% 12% 66% 100% 

RES4: 
Temp. 
Lodging 

8% 1% 8% 1% 2% 9% 71% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES5: 
Instituti
onal 
Dormito
ry 

9% 0% 13% 1% 3% 13% 61% 100% 

RES6: 
Nursing 
Home 

10% 1% 9% 3% 2% 12% 63% 100% 

COM1: 
Retail 

11% 1% 9% 5% 5% 9% 60% 100% 

COM2: 
Wholesa
le 

25% 1% 6% 9% 7% 10% 42% 100% 

COM3: 
Personal 
& repair 
services 

15% 1% 7% 7% 3% 9% 58% 100% 

COM4: 
Professi
onal/Bu
siness 

9% 1% 10% 1% 3% 16% 58% 100% 

COM5: 
Banks 

11% 0% 9% 4% 9% 7% 60% 100% 

COM6: 
Hospital 

7% 0% 6% 1% 4% 6% 76% 100% 

COM7: 
Medical 

10% 1% 4% 3% 2% 11% 69% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

Office 

COM8: 
Entertai
nment 

14% 1% 9% 4% 3% 7% 62% 100% 

COM9: 
Theaters 

11% 1% 9% 5% 6% 9% 59% 100% 

COM10
: 
Parking 

17% 0% 39% 0% 10% 8% 26% 100% 

IND1: 
Heavy 

19% 1% 2% 7% 3% 9% 59% 100% 

IND2: 
Light 

20% 1% 3% 9% 7% 10% 50% 100% 

IND3: 
Food/Ch
emical 

16% 1% 3% 8% 6% 10% 56% 100% 

IND4: 
Metals/
Mineral 
Processi
ng 

12% 0% 24% 2% 6% 7% 49% 100% 

IND5: 
High 
Technol
ogy 

16% 0% 4% 4% 4% 3% 69% 100% 

IND6: 25% 1% 6% 9% 7% 10% 42% 100% 
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Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

Constru
ction 

AGR1: 
Agricult
ure 

31% 0% 7% 9% 9% 11% 33% 100% 

REL1: 
Church 

15% 1% 11% 4% 17% 9% 43% 100% 

GOV1: 
General 
Services 

15% 1% 11% 6% 4% 7% 56% 100% 

GOV2: 
Emerge
ncy 
Respons
e 

11% 0% 14% 2% 2% 11% 60% 100% 

EDU1: 
School 

9% 1% 11% 3% 6% 9% 61% 100% 

EDU2: 
College 

9% 1% 9% 2% 3% 7% 69% 100% 

Wood 11% 1% 12% 4% 4% 15% 53% 100% 

Steel 9% 0% 11% 1% 2% 14% 63% 100% 

Masonr
y 

12% 1% 13% 3% 3% 17% 51% 100% 

Concret
e 

11% 0% 11% 3% 2% 11% 62% 100% 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-103 

Specific 
Occupa
ncy or 
General 
Building 
Type 

Foundat
ion 

Below 
First 
Floor 

Structur
e Frame 

Roof 
Coverin
g 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

MH 8% 2% 10% 3% 5% 20% 52% 100% 
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Visual 28: Site-Specific Inventory 
 

• Includes essential facilities, high 
potential loss facilities, user-defined 
facilities, transportation systems, utility 
systems, hazardous material sites  

• Represents discrete points of facilities 
and systems of inventory  

• Provides site-to-site results versus an 
aggregated table of damages and losses  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-105 

Visual 29: Essential Facilities 
 

• Fire Stations  
• Police Stations  
• Schools  
• Emergency Operations Centers (EOC)  
• Medical Care Facilities  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-106 

Visual 30: Essential Facility Classes 
Class Category Description Occupancy 

MDFLT DEFAULT Default for Medical COM6 

EFHL Medical Care Large Hospital 
(greater than 150 
beds) 

COM6 

EFHM Medical Care Medium Hospital (50 
to 150 Beds) 

COM6 

EFHS Medical Care Small Hospital (less 
than 50 Beds) 

COM6 

EFMC Medical Care Medical Clinics and 
Labs 

COM7 

PDFLT DEFAULT Default for Police GOV2 

EFPS Emergency Response Police Station GOV2 

FDFLT DEFAULT Default for Fire 
Station 

GOV2 

EFFS Emergency Response Fire Station GOV2 

EDFLT DEFAULT Default for 
Emergency Response 
Facility 

GOV2 

EFEO Emergency Response Emergency Operation 
Centers 

GOV2 

SDFLT DEFAULT Default for School EDU1 

EFS1 School Grade Schools 
(Primary/High 
Schools) 

EDU1 
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Class Category Description Occupancy 

EFS2 School Colleges/Universities EDU2 

Note the links between site-specific and GBS 
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Visual 31: User-Defined Facilities 
 

• Used to perform site-specific analysis of 
types of buildings found in the General 
Building Stock 

• Required fields for hurricane:  
• ID  
• Census Tract  
• Occupancy  
• Wind Building Type  
• Wind Building Scheme Name  
• Location  
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Visual 32: Other Inventory Table Options 
 

• Metadata  
• Data Dictionary  
• Export  
• Map  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 2: Hazus Inventory  SM-110 

Visual 33: Inventory Table Features: Metadata 
 

• Metadata can be accessed through 
context menu. 

• Metadata is essentially reference 
information.  
• Includes description, source, spatial 

reference, etc.  
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Visual 34: Inventory Table Features: Data Dictionary 
 

• The data dictionary can be accessed 
through the context menu. 

• The data dictionary describes the table 
(name, field definitions, etc.)  

• Also used to build a table for import. 
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Visual 35: Inventory Table Features: Export 
 

• The option to export can be accessed 
through the inventory menu. 

• Inventory can be exported to two file 
formats: txt and csv. 
• Used to manipulate data outside of 

Hazus. 
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Visual 36: Inventory Table Features: Map 
 

• Click on the column heading to select 
the field you wish to map.  

• Click “Map.”  
• Inventory item map layer is created and 

symbology is automatically populated.  
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Visual 37: Exercise 2.2: Comprehensive Data 
Management System 
Goals:  

• Update state database using CDMS.  
• Create a new study region.  

Time: 35 minutes  
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Visual 38: Exercise 2.2: Tasks 
Part 1: Update State Database 

Task 1: Start CDMS and Set State Database to be Updated.  
Task 2: Delete Existing Medical Care Facilities in State Database.  
Task 3: Import New Medical Care Facilities into CDMS Repository.  
Task 4: Transfer Medical Care Facilities to Statewide Database.  

Part II: Update the Aggregate Inventory:  
Task 1: Import the assessor’s data into the CDMS repository.  
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Exercise 2.2: Comprehensive Data Management 

System 
Type: Student-Led Exercise 
Time: 35 minutes  
Goals: 

• Update state database using CDMS. 
• Create a new study region.  

Background:  
Hazus provides a vast amount of information that can be used to complete a Level 1 analysis. 
However, this information is compiled based upon best available national data sources and 
frequently is not complete. This exercise will introduce you to some of the tools Hazus provides 
for improving the inventory data with your own data. The exercise is not intended to serve as a 
detailed exploration of inventory update tools and processes, but rather an overview. In addition, 
note that the inventory data used in this exercise, while very similar to actual data, has been 
modified explicitly for this course and should not be considered representative of actual 
conditions in the community used in the examples.  
 

Part I: Update State Database  

Use the Comprehensive Data Management System (CDMS) to update two types of inventory 
data in the state databases from which Hazus study regions are derived.  
 

Task 1: Start CDMS and Set State Database to be Updated 

1. Double-click the CDMS icon on your desktop to start CDMS. You can also choose “All 
Programs > FEMA RISK Assessment System > CDMS” from the Start menu.  
2. From the Tools menu, choose “Specify Hazus Data Location.” This specifies to CDMS which 
state data you are updating. You can only update data for one state at a time.  
3. Click “Browse” and navigate to the C:\HazusData\Inventory\FL folder. This folder contains 
the state data for Florida. You may elect to store your state data elsewhere for your own 
purposes.  
4. Click “OK” once you have selected the appropriate folder.  
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5. Click “OK” to close the CDMS Statewide DB Configuration window. 
 

Task 2: Delete Existing Medical Care Facilities in State Database 

Note: There are several approaches available for updating inventory data. This exercise will lead 
you through replacing the entire set of existing medical care facilities in Sarasota County, FL 
with a new set of medical care facilities. You also could add new medical care facilities or 
remove only medical care facilities that have been  
1. Click “Query/Export Statewide Datasets.”  
2. Select “County” as the Geographic Area option.  
3. Scroll through the list of counties, highlight “Sarasota” and then click the right arrow to move 
it to the Selected Geographic Areas list.  
4. Select “Essential Facilities” from the list of options under the Search By Data Layer label. It is 
possible to select more than one type of inventory at a time.  
5. Click on the “Medical Care Facilities” category and then click the right arrow to move it to the 
Selected Data Layers list.  
6. Select the “Hurricane Wind” hazards.  
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7. Click “Search.” CDMS will take just a moment to find the 6 medical care facilities. 
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8. Click “Delete All Records for Selected Inventory” and click “Yes” when prompted to indicate 
that you recognize that you are deleting all of the selected records. It may take a few moments to 
complete the process. When the process is complete the window will show No Records Found. 
Please try another layer.  
9. Click “CDMS Home.”  
 

Task 3: Import New Medical Care Facilities into CDMS Repository 

1. Click “Import into CDMS Repository from File” to view the Import into CDMS Repository 
options.  
2. Click “Browse” on the right side of the screen. Browse to the 
C:\E0170_ActivityData\Exercise_2.2 folder, double-click the “MedialCareFacilities.mdb” and 
click “Open.”  
Note: This database contains updated medical care facility records for Sarasota County, Florida. 
The replacement costs have been increased by 10% to reflect an increase in materials costs over 
5 years (created solely for the purposes of this course). The structure that this database must 
follow to be Hazus compliant is discussed in detail in the Comprehensive Hazus-Data 
Management course.  
3. Select “Essential Facilities” from the Select Hazus Inventory Category list.  
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4. Select “Medical Care Facilities” from the Select Hazus Inventory Dataset (Layer) list.  
5. Click “Continue” in the lower right corner of the CDMS window.  
6. Verify that “MedicalCareFacilities” is identified as the Select Import table. The 
MedicalCareFacilities table automatically appears since it is the only table in the database.  
7. Select “No Hazus ID” for the Select Hazus-ID field option. All site-specific inventory records 
must have a unique identifier. This can either be created by Hazus or it can be provided by the 
user if it is in a Hazus compliant format.  
 

 

 
 

 
8. Click “Continue” to view the Data Field Mapping window: 
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Note: Field matching is the process of telling CDMS how the fields in your table match up to 
those required by Hazus. CDMS will attempt to match fields that are similar in name. You can 
then manually match any fields that do not auto-match or you can un-match fields that are 
incorrectly matched. Observe there are several fields in the top half of the window that are 
shaded green. These are required fields, but CDMS will populate these with a default value if 
you do not provide a field in your table that contains the required information.  
9. Click “Continue.”  
10. CDMS will produce a window that states that default values will be used for the fields not 
matched. Click “Yes” to accept the default values.  
11. The Categorize fields window will appear showing the fields that need to be categorized. 
Categorizing is a process that involves telling CDMS how the values in your table related to the 
Hazus required values.  
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12. Click “OK” to move to the Back-up Power category value matching window.  
13. Back-up Power (Yes or No) was automatically matched to the correct value in the destination 
field by CDMS. Click “Continue”.  
14. EFHL and EFHM were already automatically matched to the correct value in the destination 
field by CDMS. Click “Continue” to move to the Facility Class category value matching 
window.  
15. Click “OK” when the window appears reporting Data was imported into CDMS Repository.  
16. When the process has completed, the CDMS Repository window will appear listing the 
essential facilities medical care facilities table that you just imported.  
17. Click “View/Edit” to open a window that shows each of the medical care facilities that you 
imported. From this window you can remove individual medical care facilities that you do not 
want to import into the state database.  
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18. Click “Close” to close the CDMS Detail Information window. 
 

Task 4: Transfer Medical Care Facilities to Statewide Database 

1. Click “Transfer to Statewide Dataset” to view Statewide Data Transfer Options. There are two 
options at this point: The “Append/Update Data” option adds new data to the statewide database. 
The “Replace data” option replaces everything in the statewide database with the new 
information that you select.  
2. Select the “Append/Update Data” option and then click “Submit.”  
3. Click “Yes” when prompted to indicate that you are sure you want to transfer this layer to the 
Statewide Datasets. It may take a minute or two to complete the update process.  
4. Click “OK” when prompted to acknowledge that the Statewide Data Transfer is complete.  
Note: The medical care facilities have now been moved from the CDMS Repository window to 
the Statewide Layer Modification History window. You can query the medical care facilities 
again to verify. You could also build a study region that includes the updated inventory at this 
point. However, you will use CDMS to update an aggregate inventory database prior to doing so.  
 

Part II: Update the Aggregate Inventory:  

In this part of the exercise we will update the general building stock inventory in the state 
database inventory using information about individual structures that could be acquired from a 
local assessor’s office or some other source. The goal is to introduce you to the tools that Hazus 
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provides for managing this type of inventory. However, the detailed steps that you would need to 
prepare your own data for importing in this fashion are covered in the Comprehensive Data 
Management course. 
 

Task 1: Import the assessor’s data into the CDMS repository  

1. Click “Import into CDMS Repository from File.”  
2. Click “Browse” on the right side of the screen.  
3. Browse to the C:\E0170_ActivityData\Exercise_2.2 folder and double-click the “GBS.mdb” 
geodatabase.  
Note: As noted above, this database was prepared specifically for this exercise. Keep in mind 
that creating a Hazus compliant database can be a time-consuming process. The detailed steps 
for completing this process are discussed in the Comprehensive Data Management course.  
4. Uncheck the “Earthquake” and “Flood” hazard importing option. Since you are only running a 
hurricane model analysis in this course it is not necessary to import information unique to the 
earthquake hazard.  
5. Select “Aggregated Data” from the Select Hazus Inventory Category drop-down list.  
6. Select “Import Site Specific Data to Aggregate Data.”  
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7. Click “Yes” to acknowledge updating the aggregate layers in the CDMS repository.  
8. Select the GBS table from the input table section drop-down menu and click “OK.”  
9. Select “BldgRepCost” in the Source from Fields box and find and highlight the matching field 
in the Destination box which should be called “Building Replacement Cost”. Click “Add 
Match”.  
10. Select “ContentRplcCost” in the Source from Fields box and find and highlight the matching 
field in the Destination box which should be called “Content Replacement Cost”. Click “Add 
Match”.  
11. Click “Continue”.  
12. Click “OK” to categorize the fields that require categorization:  
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13. Click “OK” for the Area Field Type categorization.  
Note: This value was already in thousands of square feet in the GBS file. It is important to know 
what the units of your data are in before you enter the categorization process. If you enter in the 
wrong value, CDMS will not know and you imported data will be incorrect.  
14. Click “OK” for the Building Value Field Type categorization.  
15. Click “OK” for the Content Value Field Type categorization.  
16. Click “OK” for the Number of Stories Value Field Type to indicate “Field is numeric. Use as 
is.”  
17. Click the radio button next to “Year is in 4-digit format (e.g. 1995)” for the Year Built Field 
Type and then click “OK.”  
18. Click “Continue”. You do not have to match any fields in the next step. CDMS recognizes 
the value and has automatically matched it.  
19. Click “OK” to acknowledge the data was imported into the CDMS repository to return to the 
CDMS Repository window. Aggregated data now appears as an entry under the CDMS 
Repository heading.  
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20. Click “View” to view the Aggregate Data Results. The data that you imported is organized 
by census block and tract. The number of records reflects the number of census blocks and tracts 
that you are updating in the state database.  
21. Click “Close.”  
22. Click “Transfer to Statewide Dataset” and click “Yes” when prompted to indicate that you 
understand that your action cannot be undone. This process will take approximately one minute 
to complete.  
23. In order to update the entire aggregated inventory, click “Select All” on the Transfer 
Aggregated Data to Statewide Databases window.  
24. Click “Process only imported tracts/blocks” and check the box to “Update General Building 
Mapping Schemes.”  
25. When finished click “OK.”  
26. The first selection updates all of the blocks you are updating (69). The second step updates 
all of the blocks in the county you are updated. In blocks where you are not importing data, they 
will keep the default inventory.  
27. Click the radio button next to “Replace all occupancies for this statewide transfer.” Click 
“Continue.” This assumes that for the blocks you are updating you have accounted for every 
building and have classified it correctly.  
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28. When the Statewide Data Transfer process is complete, click “OK” to move the Aggregated 
data entry to the Statewide Layer Modification History. This process may take a minute or two to 
complete.  
29. Exit CDMS.  
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Visual 39: Lesson 2: Review 
1. What is the purpose of the wind building characteristics distribution mapping scheme?  
2. What two states have their own set of mapping schemes?  
3. What types of buildings are considered by Hazus to be essential facilities?  
4. What is the tool provided by Hazus for updating the state databases?  
5. What are the only two site-specific dataset groups that are analyzed by the hurricane 

model?  
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Visual 40: Questions? 
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Lesson 3: Hurricane Wind Model 
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Visual 1: Lesson 3: Hurricane Wind Model 
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Visual 2: Lesson 3: Goal and Objectives 
Goal: To provide an overview of the hurricane wind model within Hazus.  
After completing this lesson you will be able to:  

• List the key components of hurricane development.  
• Describe the areas of the U.S. mainland that have the highest risk to major hurricanes. 
• Provide four scenario types that a user can select to run the hurricane model. 
• Understand two databases unique to the hurricane model.  
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Visual 3: Hurricane Basics 
• Rotate counter-clockwise in the Northern Hemisphere  
• Require ocean temperatures around 80° F or 27° C or above  
• Occurs between 5°N and 40°N in the Atlantic Ocean  
• Hurricane season: June 1 through November 30 (Atlantic Basin)  
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Visual 4: Tropical System Basics 
  

Type of Tropical Cyclone Maximum Sustained Winds 

Tropical Depression 38 mph (33 knots) or less 

Tropical Storm 39-73 mph (34-63 knots) 

Hurricane Category 1 74-95 mph (64-82 knots) 

Hurricane Category 2 96-110 mph (83-95 knots) 

Hurricane Category 3 111-129 mph (96-112 knots) 

Hurricane Category 4 130-156 mph (113-136 knots) 

Hurricane Category 5 157 mph (137) knots or greater 

Tropical Cyclone Category 1  77 mph (67 knots) or less  

Tropical Cyclone Category 2 78-102 mph (68-89 knots) 

Tropical Cyclone Category 3 103-139 mph (90-121 knots) 

Tropical Cyclone Category 4 140-173 mph (122-150 knots) 

Tropical Cyclone Category 5 174 mph (151 knots) or greater 

Super Typhoon 150 mph (130 knots) or greater 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 3: Hurricane Wind Model  SM-136 

Visual 5: Hurricane Intensity 
Saffir-Simpson Hurricane Wind Scale for the Continental United States 

Scale 
Number 
(Category) 

Sustained 
Winds 
(MPH) 

Typical of Damage Due to Hurricane Winds Hurricanes 

1 74-95 Very dangerous winds will produce some 
damage: Well-constructed frame homes could 
have damage to roof, shingles, vinyl siding and 
gutters. Large branches of trees will snap and 
shallowly rooted trees may be toppled. Extensive 
damage to power lines and poles likely will 
result in power outages that could last a few to 
several days. 

Florence (2018), 
near 
Wilmington, 
North Carolina 

2 96-110 Extremely dangerous winds will cause 
extensive damage: Well-constructed frame 
homes could sustain major roof and siding 
damage. Many shallowly rooted trees will be 
snapped or uprooted and block numerous roads. 
Near-total power loss is expected with outages 
that could last from several days to weeks. 

Frances (2004) 
in coastal Port 
St. Lucie, Florida 

3 111-129 Devastating damage will occur: Well-built 
framed homes may incur major damage or 
removal of roof decking and gable ends. Many 
trees will be snapped or uprooted, blocking 
numerous roads. Electricity and water will be 
unavailable for several days to weeks after the 
storm passes. 

Irma (2017) 
second landfall 
near Marco 
Island, Florida 

4 130-156 Catastrophic damage will occur: Well-built 
framed homes can sustain severe damage with 
loss of most of the roof structure and/or some 
exterior walls Most trees will be snapped or 
uprooted and power poles downed. Fallen trees 
and power poles will isolate residential areas. 
Power outages will last weeks to possibly 
months. Most of the area will be uninhabitable 
for weeks or months. 

Harvey (2017) 
near Aransas, 
Texas 

5 >157 Catastrophic damage will occur: A high Andrew (1992) 
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Scale 
Number 
(Category) 

Sustained 
Winds 
(MPH) 

Typical of Damage Due to Hurricane Winds Hurricanes 

percentage of framed homes will be destroyed 
with total roof failure and wall collapse. Fallen 
trees and power poles will isolate residential 
areas. Power outages will last for weeks to 
possibly months. Most of the area will be 
uninhabitable for weeks or months. 

in coastal parts 
of Cutler Ridge, 
Florida 

http://www.weather.govfos/hurricane/resources/TropicalCyclones11.pdf 
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Visual 6: Hurricane Anatomy 
 

1. Rain bands or “feeder bands”  
2. Eye  
3. Eye wall  
4. Counterclockwise rotation  

 
Hurricane Harvey. Source: NOAA 

 
*NOTE: A second outer eye wall may develop, but it can be difficult to differentiate from the 
inner eye wall.  
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Visual 7: Hurricane Anatomy: Symmetry 
 

• Each quadrant is 
symmetric  

• Strongest winds and 
highest surge (without 
coastline effects) occur in 
the right-front quadrant of 
hurricane  

• Forward speed of the 
hurricane + Rotational 
winds of the hurricane = 
highest wind speeds  

 
Image: Satellite image of Celia (2010) Cooperative 
Institute for Meteorological Studies (CIMSS), University 
of Wisconsin 
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Visual 8: Hurricane Irma, Maria, and Michael 
 

• Hurricane Irma, 2017  
• Approaching the coast of Florida 

• Hurricane Maria, 2017  
• At its strongest point, approaching 

Puerto Rico. 
• Hurricane Michael, 2018 

• Making landfall in Florida's 
Panhandle. 
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Visual 9: Hurricane Climatology 
 
Atlantic Hurricane Season: 
June 1st – November 30th 
Peak of the hurricane season  

• Peak September 10th  
• Second peak approx. October 15th  

Peaks are related to: 
• Peak ocean temperatures  
• Peak of ideal weather patterns   

 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 3: Hurricane Wind Model  SM-142 

Visual 10: Hurricane Geography 
 

• Hurricanes impacting the US mainland 
often follow one of two general paths: 
• Staying in the Atlantic and tracking 

up the East Coast  
• Tracking west of Florida and 

entering the Gulf of Mexico  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 3: Hurricane Wind Model  SM-143 

Visual 11: Hurricane Geography 
 
Major hurricane U.S. strikes:  

• Florida has the greatest number  
• North Carolina, Louisiana, Mississippi, 

Alabama, and Texas are also high 
frequency areas  
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Visual 12: Hurricane Damages and Losses 
 
Possible hurricane effects: 

• Hurricane Winds*  
• Hurricane Storm Surge*  
• Rainfall / Inland Riverine Flooding*  
• Tornadoes  
• Rip Currents and High Waves  

  
Hurricane and Tropical Storms winds can 
extend far inland from the coast.  
* Modeled by Hazus  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 3: Hurricane Wind Model  SM-145 

Visual 13: Additional Hazards 
 

• Tornadoes and severe thunderstorms 
are common for tropical systems.  

• Heavy rainfall produces additional 
riverine and coastal flooding.  

• Hurricane effects are felt much further 
inland.  

 
Hurricane Harvey (2017) Rainfall  
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Visual 14: Additional Hazards 
 
Katrina: approximately 53 tornadoes in 6 states  
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Visual 15: Discussion 3.1: Hurricane Hazard 
Goal: Review the Hurricane Hazard and the Hazus Hurricane Model.  
Groups: 3-5  
Time: 15 minutes  
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Visual 16: Discussion 3.1: Hurricane Hazard 
Questions:  
1. What are the implications of not modeling some of the hazards not traditionally generated by a 
hurricane, such as tornadoes, severe thunderstorms, rip currents?  
2. Given what we have seen in the previous slide, where (geographically) in relationship to the 
hurricane path are communities at greatest risk of a landfalling hurricane?  
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Visual 17: Wind Field Model 
Solves full non-linear equations of motion for translating hurricane; then establishes parameters 
for fast running simulation  

• Storm asymmetries  
• Changing sea-surface roughness  
• Air-sea temperature difference  
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Visual 18: Components of Hazus Hurricane Wind 
Model 
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Visual 19: Building Damage and Loss Methodology 
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Visual 20: Hurricane Model States 
  

 
• Hurricane model only applies to 23 

coastal states 
• These are the only states which can be 

modeled by the Hurricane Wind model 
AND surge model 

• Puerto Rico and US Virgin Islands wind 
model is in development and may be 
provided in a future update.  
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Visual 21: Components of Hurricane Model 
• Hurricane Database/Model 
• Inventory with Wind-Specific Features 
• Surface Roughness (Terrain) Database* 
• Tree Database* 
• Damage/Loss/Debris Functions 
• Shelter Model 

*NOTE: The surface roughness (terrain) and tree databases are unique to the Hurricane model. 
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Visual 22: Hurricane Wind Hazard Model: Track 
 
Track Model  

• Affecting Gulf Coast, Atlantic Coast, or 
Hawaii  

• Storm curvature  
• Multiple landfalls  
• Changes in intensity  
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Visual 23: Hurricane Wind Hazard Model 
 
Wind Field Model 

• Updated version of model used for 
design wind speeds in ASCE-7-98  

• Used in International Building Code 
Series  

• Allows for asymmetries (or unevenly 
distributed wind fields)  

 
Asymmetric Hurricane Irene - 2011, NOAA  
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Visual 24: Hurricane Wind Model Scenarios 
   

Probabilistic wind speed 
database: 

•  100,000 years of simulated storms  

 

Deterministic 

• Historical  
• Forecast/Advisory  
• User-defined  
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Visual 25: Damage and Loss Modeling 
 
Damage includes effects of  

• Wind pressures  
• Wind-borne debris  
• Tree blow-down  
• Rainfall  
• Storm duration  

Models damage explicitly to  
• Roof cover  
• Roof deck  
• Whole roof failures  
• Window and door failures  
• Wall damage  

 
Hurricane Irene (2011) damage in Washington, NC 
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Visual 26: Damage and Loss Modeling  
 
Loss model based on:  

• Insurance loss data  
• Correlation of 

financial damage 
with water 
infiltration and 
building damage  

Current model now includes 
storm surge:  

• Hurricane wind and 
flooding analysis is 
coupled  

 
Debris from Hurricane Irma in Marathon, Florida has been 

scheduled for removal to clear waterway in this canal, which is 
surrounded by a full time commercial trailer park. 
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Visual 27: Fast-Running Damage & Loss Functions 
 

• Includes 1,884 unique building models  
• 45 damage/loss functions for each 

building model  
• Total of ~240,000 unique damage/loss 

curves 
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Visual 28: Mitigation of Buildings 
• Hazus:  

• Uses a load and resistance approach to estimate damage and ensuing loss  
• Is able to model effects of mitigation  

• Hurricane model includes mitigation options for all building types  
• Mitigation methods include:  

• Addition of hurricane straps  
• Application of window protection  
• Effects of re-nailing roof sheathing on damage/loss  
• Application of secondary water resistance  
• Combinations of the above  
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Visual 29: Hurricane Wind Simulation 
 
Why Hurricane Categories Make a Difference: https://www.youtube.com/watch?v=lqfExHpvLRY 

 
Why Hurricane Categories Make a Difference – The Weather Channel 

 

 

http://www.youtube.com/watch?v=lqfExHpvLRY
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Visual 30: Hurricane Damage Simulation 
 

 
 

 

 

Student 
Manual 

 

Hurricane Damage Simulation  
• The video demonstrates the benefits of mitigation by showing how 

hurricane winds interact with a house un-protected by mitigation 
efforts vs. a house that has mitigation efforts. 

• The animation shows:  
• A house situated along the coast that is subjected to a hurricane 

that produces roughly the design wind speed.  
• Not long after the winds begin, damage to the roof cover begins to 

accumulate.  
• Next, a piece of wind borne debris breaches a window.  
• The rapid build-up of pressure inside the house quickly causes 

additional windows and doors to fail.  
• Now, the roof panels are beginning to fail.  
• As the wind shifts directions, the loads on the roof change and 

more panels fail.  
• Finally, the entire roof frame collapses, and the house is a total 

loss. As the video pans over to an identical, but mitigated house 
exposed to the same winds, we see only roof cover damage.  

 This damage can be easily repaired at only a small fraction of the 
total replacement value of the house.  
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Visual 31: Terrain Database 
• Surface Roughness = Terrain  

• Higher Roughness = Lower Damage (generally)  
• Hazus terrain database  

• Derived from Land Use Data  
 National Land Cover Data (NLCD) database  
 Florida Water Management District (FWMD) data  

• Roughness parameters averaged for each census tract 
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Visual 32: Tree Database 
 
Trees: 

• Increases roughness but also increases 
damage  

• Building/content loss  
• Debris removal  

Tree Coverage Database is derived from: 
• MRLC land use coverage database  
• Forest Inventory Analysis Database  
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Visual 33: Shelter Models 
Two estimates for each census tract 

• Number of displaced households 
• Number of people requiring short-term public shelter 

• Function of income class, ethnic class, ownership class, population age class 
Similar to model used for earthquake model 

• Uses building loss ratios instead of building damage states to estimate proportion of 
uninhabitable housing units 
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Visual 34: Hurricane Loss Estimation Outputs 
  

Building damage state 
probabilities  

• General Building Stock  
• Essential facilities  
• User-defined facilities  

Capital-related loss ($)  

• Building  
• Contents  

Income-related losses ($)  

• Relocation  
• Business Income  
• Rental Income  
• Wages  

Social losses  

• Displaced households  
• Short-term shelter requirements  

Debris (tons)  

• Building debris  
• Tree debris  

Summary reports  

• Inventory  
• Damage  
• Loss  
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Visual 35: Activity 3.2: Explore the Inventory 
Goals:  

• Explore Inventory 
Time: 15 minutes  
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Visual 36: Activity 3.2 – Explore the Inventory  
Task 1: Explore the General Building Stock (GBS) inventory.  
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Activity 3.2 – Explore the Inventory  
Type: Instructor-Led Activity 
Time: 15 minutes  
Goals: Explore Inventory  
Background:  
Hazard-specific inventory is inventory that is specific to one of the models. For instance, the 
hurricane-specific building types are specific to the hurricane model. There is aggregate 
inventory (demographics and General Building Stock (GBS)), Site-specific inventory and 
Hazard-specific inventory. In this activity, we will look at aggregate and Site-specific inventory. 
 

Task 1: Explore the General Building Stock (GBS) inventory  

1. Start Hazus and open the “HurricaneHarvey_CO” study region created in Exercise 1.2.  
2. From the Inventory menu click on General Building Stock > Building Count:  
 

 

 
 

 
3. On the Building Count window, note that you can show data by Building Type or By 
Occupancy. Data is shown at Census tract level by default. Note you can display by specific or 
general building types. 
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4. Click “OK” when done.  
5. From the Inventory menu click on General Building Stock>Dollar Exposure.  
6. On the Dollar Exposure window, note the tabs to display the data by building, contents, and 
the totals by occupancy or building type.  
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7. Click “OK” when done.  
8. From the Inventory menu click on Essential Facilities > Inventory.  
9. On the Essential Facilities window, note there are multiple tabs to view the different 
inventories: Medical Care Facilities, Fire Stations, Police Stations, etc.. Scroll through the table 
and note the fields that list each facility’s attribute information.  
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Note: You can click on “Map” and the facilities/inventory you are viewing will display on the 
map. This feature is available for most inventory categories.  
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10. Click “OK” when done.  
11. From the Inventory menu click on Transportation Systems.  
12. On the Transportation Systems Inventory window, note there are multiple tabs to view the 
different types: Highway, Railway, Bus, etc.  
13. Scroll through the table and note the fields that list each facility’s attribute information.  
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 3: Hurricane Wind Model  SM-174 

 
 

 
14. Click “OK” when done.  
15. From the Inventory menu click on Utility Systems.  
16. On the Utility Systems Inventory window, note there are multiple tabs to view the different 
types: Potable Water, Oil, Electric Power, etc.  
17. Scroll through the table and note the fields that list each facility’s attribute information.  
Note: The Potable Water facilities, Potable Water Pipelines, and Waste Water pipeline tables are 
empty because there are no records in the state data to aggregate for these inventory categories.  
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18. Click “OK” when done.  
19. From the Inventory menu click on Demographics.  
20. On the Demographics window, note there are multiple tabs to view the population attributes 
by the selected aggregate level.  
21. Scroll through the table to view the available data breakdowns.  
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22. Click “OK” when done.  
23. Save the map document and exit Hazus.  
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Visual 37: Lesson 3: Review 
1. What are the key components for hurricane development?  
2. What areas of the US mainland have the highest risk to major hurricanes?  
3. List four scenario types that a user can select to run the hurricane model.  
4. Which two databases are unique to the hurricane model?  
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Visual 38: Questions? 
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Lesson 4: Deterministic Storm Parameters 
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Visual 1: Lesson 4: Deterministic Storm Parameters 
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Visual 2: Goal and Objectives 
Goal: To provide an overview of the set of storm scenarios available to users in Hazus.  
After completing this lesson, you will be able to: 

• Describe the Historical Scenario options. 
• Understand the process for creating a user-defined scenario in Hazus. 
• Discuss the differences in the probabilistic analyses in Hazus. 
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Visual 3: Scenario Operations 
Hazus has six choices for defining hurricane scenarios:  

• Historic  
• Probabilistic  
• Create New:  

• Define Storm Track Manually  
• Import from Exported File (storm created in previous Hazus Study Region)  
• Import Census Tract Data File  
• Import a Hurrevac Storm Advisory 
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Visual 4: Hurricane Scenario Definition Options 
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Visual 5: Determining Risk 
 
Typically the risk of hazard occurrence is translated into a probabilistic recurrence interval 
(e.g., 1% annual change or 100-year event). 
Two approaches: 

• Historic record 
• Modeling methods 
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Visual 6: Using the Historic Record for Risk 
  

Recurrence Interval = (n+1)/m  

• n: number of years on record  
• m: rank of the event being considered  

When a good historical record 
exists, the Recurrence Interval 
and its annual chance probability 
can be computed. 

  

Year 

Maxi
mum 
Wind
s (kt) 

Rank 

Recu
rrenc
e 
Inter
val 

1989 120 3 7.00 

1991 90 8 2.63 

1992 145 1 21.00 

1993 100 6 3.50 

1995 100 6 3.50 

1996 100 6 3.50 

1997 70 12 1.75 

1998 95 7 3.00 

1999 100 6 3.50 

2002 80 10 2.10 

2003 90 8 2.63 

2004 130 2 10.50 

2005 110 5 4.20 

2007 80 10 2.10 

2008 95 7 3.00 

2011 75 11 1.91 
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2012 70 12 1.75 

2014 85 9 2.33 

2016 75 11 1.91 

2017 115 4 5.25 
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Visual 7: Using the Historic Record for Risk 
 
Potential Problems: 

• The historic record has a short timescale 
(e.g. Atlantic hurricane records 
collected from 1851-2019 and 
Northeast and North Central Pacific 
hurricane records collected from 1949-
2019). 
• This map shows the total number of 

hurricane strikes by county from 
1900-2010.  

• Some hazards have wide geographic 
variations. 
• EX: County X has been missed by 

landfalling hurricanes since 1900, 
but adjacent County Y has had 14. 
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Using the Historic Record for Risk 
• This image illustrates the total number of hurricane strikes by county 

(1900-2010).  
• Some areas have had a high number of landfalling hurricanes 

others have had few landfalls.  
 The upper arrow points to Taylor County which has had 2 

landfalls. 
 The lower arrow points to Monroe County which has had 32 

landfalls. 
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Visual 8: Historic Storm Scenario 
 
Potential Problems: 

• Pre-computed wind fields and storm 
tracks 

• Only storms that affected the study 
region can be selected 
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Visual 9: Historic Storm Region Filter 
 

• Region Filter button: Filters to select 
only the storms in which the storm track 
intersects the study region. 

• Peak Gust: Largest modeled gust speed 
over land anywhere in US. 
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Visual 10: Exercise 4.1: Historic Scenarios 
Goal:  

• Create multiple historic storm scenarios  
• Review the results  

Time: 45 minutes  
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Exercise 4.1: Historic Scenario 
Goal:  

• Create multiple historic storm scenarios  
• Review the results  

Time: 45 minutes  
Exercise Steps:  

1. Refer to Activities Document “04.1_Exercise_Historic Scenario.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 11: Exercise 4.1: Tasks 
Task 1: Open the Region and Define a Historic Scenario. 
Task 2: Run the Analysis. 
Task 3: View the Results. 
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Exercise 4.1: Historic Scenario 
• Refer to Activities Document "04.1_Exercise_Historic Scenario." 
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Exercise 4.1: Historic Scenario 
Type: Student-Led Activity  
Time: 45 minutes  
Goals:  

• Create multiple historic storm scenarios  
• Review the results  

Background:  
Hazus comes with a substantial library of historical storms. You can use the tracks and other 
characteristics of storms that occurred in the past to understand what the impact would be on a 
community if a storm of the past were to occur today given the way that buildings are 
constructed, how they are used, and where they are located. This exercise will help you explore 
the process of defining a historic storm scenario, and it will also help you explore the study 
region inventory to provide a context for understanding the impact of the hurricane on the 
exposed buildings and population. 
 

Task 1: Open the Region and Define a Historic Scenario 

1. Start Hazus and open the “HurricaneHarvey_CO” study region.  
2. From the Hazard menu, choose “Scenario” to open the Scenario wizard.  
3. Click “Next” to move past the initial window of the wizard.  
4. Verify that this Historic option is highlighted and the Activate radiobox is checked.  
5. Click “Next”. A list of historical storms that are in the Hazus database will appear.  
6. Click “Region Filter” to search only for the storms that impacted the area in which your study 
region is located.  
7. Select the UN-NAMED-1916-6 scenario.  
8. Click “Next” on the remaining windows of the wizard until you reach the last screen of the 
wizard where you should click “Finish”. This will activate the selected historic storm.  
 

Task 2: Run the Analysis 

1. From the Analysis menu choose “Run” to open the Analysis Options window.  
2. Choose “Select all” but uncheck the box for “Automated Output Options”.  
3. Click “Run Analysis” to begin the analysis.  
4. The analysis should take around 2-3 minutes.  
5. After the analysis is complete, the application will display the Analysis Completed message 
box.  
6. Click “OK” to close the box.  
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Task 3: View the Results 

You will explore some of the analysis output in the following steps and continue your 
exploration of the results in the next exercise. 
1. When the analysis is complete, navigate to the Results menu and choose "Wind Speeds."  
 

 

 
 

 
2. Click the “Peak Gust (mph)” column and then click “Map” to add the 1916-6 historic storm 
path and windspeeds as a map layer. The “Wind Speeds – Peak Gust (mph)” layer should be 
added to the map. 
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3. Click Close.  
4. Right click on the “Wind Speeds – Peak Gust (mph)” layer and open the attribute table.  
5. Use the attribute table to answer Questions A through C in the table at the end of this 
exercise.  
6. Close the Wind Speeds attribute table window.  
7. Refer to the map and describe the location of the highest windspeeds in relationship to the 
coastline and to the storm path.  
8. Click on the Results menu and then Summary Reports.  
9. Click on the Other Reports tab, select “Global Summary Report”, and then click “View”. This 
will take a few minutes to create.  
10. Use this report to answer Questions D – I in the table at the end of this exercise.  
 

Task 4: Complete Additional Scenarios 

1. Follow the steps you completed earlier in Tasks 1-3 (without opening the study region) for 
historic storm UN-NAMED-1916-6 for the following storms: UN-NAMED-1919-2 and 
Hurricane Harvey.  
2. Complete the table below and answer the question that follows.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 4: Deterministic Storm Parameters  SM-195 

Question UN-NAMED 1916-6 UN-NAMED 1919-2 Hurricane Harvey 
2017 

a. What is the 
highest peak wind 
gust in the study 
region? 

   

b. What is the highest 
sustained wind in the 
region? 

   

c. Based on the 
highest sustained 
wind in the region, 
what is the Saffir-
Simpson Category? 

   

d. How many 
buildings will be at 
least moderately 
damaged? 

   

e. How many 
residential buildings 
will be at least 
moderately damaged? 

   

f. How many 
households will be 
displaced? 

   

g. What is the 
total economic loss? 

   

h. What is the 
building related 
residential economic 
loss? (Property 
Damage) 
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Question: UN-NAMED-1919-2 and UN-NAMED-1916-6 had similar peak gust windspeeds and the 
same category storm but had different results. Why did this occur?  
Answer:  
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Visual 12: User-Defined Scenario 
 

• Import from 
• Hurrevac 
• .dat file 
• Exported file (other Hazus users) 

• Define manually* 

 

 
*Define manually should only be used if data are not available anywhere else, including 
Hurrevac. 
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Visual 13: Hurricane Data Sources: Hurrevac 
• HURRicane EVACuation – storm tracking and decision support tool developed off 

Hurricane Evacuation Studies and NHC data. 
• Translates forecast track and wind extent information from NHC text-based products into 

interactive maps and produces storm files. 
• Best available data for Hurricane Wind Loss estimation prior to landfall and until 

observed wind fields are developed.  
• Direct dynamic link within Hazus  
• Hurrevac can be used to create exercise scenarios  
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Visual 14: Hurrevac Import 
 

• Hurrevac data is integrated into the Hazus interface  
• Click on the hurricane of interest and click "Next" 
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Visual 15: Hurrevac Download 
 

• Hazus is dynamically linked to Hurrevac FTP site to provide real-time data availability  
• Advisories are available in Hazus as they become available in Hurrevac  
• Searching for the year and first letter of the storm's name will provide download 

options  
• Continuous update of advisories is crucial during response phase  
• Make sure to click the refresh button before selecting the updated Hurrevac advisory 

for an active storm 

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 4: Deterministic Storm Parameters  SM-201 

Visual 16: Activity 4.2: HURREVAC Scenario – 
Hurricane Harvey 
Goals:  

• Import Hurricane Harvey data using HURREVAC.  
Time: 10 minutes  
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Activity 4.2: HURREVAC Scenario – Hurricane Harvey 
Goals: 

• Import Hurricane Harvey data using HURREVAC.  
Time: 10 minutes  
Exercise Steps:  

1. Refer to Activities Document “04.2_Activity_HURREVAC Scenario 
– Hurricane Harvey.”  

2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 17: Activity 4.2: Tasks 
Task 1: Import the HURREVAC file. 
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Exercise 4.2: Tasks 
• Refer to Activities Document "04.2_Activity_HURREVAC Scenario 

– Hurricane Harvey." 
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Activity 4.2: HURREVAC Scenario – Hurricane Harvey 
Type: Instructor-Led Activity  
Time: 10 minutes  
Goals: Import Hurricane Harvey data using HURREVAC.  
Background: 
This exercise will help you learn to import Hurrevac to create a user defined storm. In this 
exercise we will import the final Hurricane Harvey track. During hurricane season, the forecast 
advisories for current storms will be pre-processed and you can import them into Hazus without 
having to enter values from the advisories. This can be a particularly useful capability at times 
when you are trying to determine the potential impact of an oncoming storm, or when you are 
considering what impact a past storm might have based on currently exposed inventory. In this 
exercise we will import the final Hurricane Harvey track.   
 

Task 1: Import the HURREVAC file.  

1. Open the HurricaneHarvey_CO study region.  
2. From the Hazard menu choose Scenario to open the scenario wizard.  
3. Click “Next” to advance to the scenario operation window.  
4. Click on Create New Scenario and click “Next”.  
5. Click Import Hurrevac storm advisory and click “Next”.  
6. Click on Atlantic in the Storm Files Window.  
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7. Scroll through the list and select HARVEY with the date of 2017.  
8. Click “Next” to move to the Edit Storm Track window.  
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9. Click “Next” again to move to the Windfield Calculation window. Validating the storm track 
may take up to 10 minutes to complete.  
10. Once it completes, hit “Next” four times and then “Finish”.  
11. Save your map document and keep Hazus open for the next activity.  
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Visual 18: Import Census Tract Data File 
• User-defined scenario option. 
• Import a hurricane wind data file in the .dat format with information at the census tract 

level. 
• Storm track data table will not populate because wind speeds are assigned to census tracts 

directly. 
• Also known as H*Wind. 
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Visual 19: Exercise 4.3: Harvey .dat Model 
Goals:  

• Create a scenario with .dat data. 
Time: 15 minutes  
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Exercise 4.3: Harvey .dat Model 
Goals: 

• Create a scenario with .dat data. 
Time: 15 minutes  
Exercise Steps:  

1. Refer to Activities Document “04.3_Exercise_Harvey (.dat) Model.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 20: Exercise 4.3: Tasks 
Task 1: Create a scenario from a .dat file.  
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Exercise 4.3: Tasks 
• Refer to Activities Document "04.3_Exercise_Harvey (.dat) Model." 
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Exercise 4.3: Harvey .dat Model 
Type: Student-Led Activity  
Time: 15 minutes  
Goals: Create a scenario with .dat data. 
 

Task 1: Create a scenario from a .dat file.  

1. Return to the HurricaneHarvey_CO study region, it should already be open from the previous 
activity.  
2. In the top menu, navigate to “Hazard > Scenario.” This prompts the Hurricane Management 
Window to open.  
3. Click “Next” on the welcome screen.  
 

 

 
 

 
4. Select “Create a New Scenario.” Click “Next.”  
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5. In the User Defined Scenario Type, select “Import Census Tract Data file (e.g. H*Wind).” 
Click “Next.” 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 4: Deterministic Storm Parameters  SM-211 

 
 

 
6. Enter a name for the new scenario. 
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7. Click “Browse” to navigate to and select the “Harvey_Windfield_HazusReady.dat” file saved 
in the C:\E0170_ActivityData\Exercise_4.3 folder.  
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8. Click “Next.”  
9. Click “Next” on the Storm Track Data Review.  
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10. Click “Next” on the Scenario Review. 
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11. Select “Yes. Make this scenario active”. Click “Next.” 
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12. Click “Finish” to exit the Hurricane Scenario Management Wizard.  
13. Save your map document and exit Hazus.  
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Visual 21: Import from Exported File 
• User-defined scenario type 
• Previously saved file from prior Hazus run 
• Default name will be the date of import but scenario can be renamed 
• Storm track input 
• Wind field calculation will run before activating the scenario 
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Visual 22: Exercise 4.4: Importing .bin Files 
Goal:  

• Import Hurricane Irma data using a .bin file.  
Time: 10 minutes  
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Exercise 4.4: Importing .bin Files 
Goal: 

• Import Hurricane Irma data using a .bin file.  
Time: 10 minutes  
Exercise Steps:  

1. Refer to Activities Document “04.4_Exercise_Importing .bin Files.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 23: Exercise 4.4: Tasks 
Task 1: Create the Study Region.  
Task 2: Import the .bin File. 
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Exercise 4.4: Tasks 
• Refer to Activities Document "04.4_Exercise_Importing .bin Files." 
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Exercise 4.4 – Importing .bin Files 
Type: Instructor-Led Activity  
Time: 10 minutes  
Goals: Import Hurricane Irma data using a .bin file.  
Background: 
This exercise will help you learn to import .bin files to create a user defined storm. This can be a 
particularly useful capability at times when you are trying to ascertain the potential impact of an 
oncoming storm, or when you are considering what impact a past storm might have based on 
currently exposed inventory. 
 

Task 1: Create the Study Region.  

1. Start Hazus and select Create a New Region.  
2. Click OK.  
3. Name the study region “Irma_Hurricane” and click Next.  
4. Check the boxes next to the hazards for Flood and Hurricane and click Next.  
5. Select County and click Next.  
6. Select Florida and click Next.  
7. Choose the following counties to create the study region: Hillsborough, Manatee, Pinellas, and 
Sarasota. Remember to hold the “Ctrl” key down while clicking on the county names to select 
multiple counties.  
8. Click Next when all four counties are highlighted.  
9. Click Finish.  
10. Once the aggregation is successful, click OK.  
11. Select Open a region and click OK.  
12. Click Next.  
13. Select Irma_Hurricane and click Next.  
14. Choose the radio button next to Hurricane and click Next.  
15. Click Finish.  
 

Task 2: Import the .BIN File  

1. From the Hazard menu choose Scenario.  
2. Click “Next” to advance the scenario wizard.  
3. Select Create New Scenario and click the “Next” button.  
4. Select Import from Exported File and click the “Next” button.  
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5. Name the new scenario Irma Landfall Track.  
 

 

 
 

 
6. Click the Next button.  
7. Click on the Browse button and navigate to the C:\E0170_ActivityData\Activity_4.4 folder.  
8. Select the import file named IrmaLandfallTrack.bin and click the “Open” button.  
9. Click the “Next” button to complete the import process and to perform the wind field 
calculation.  
10. Click “Next” after the application has finished computing the wind speeds.  
11. Click “Next” to move beyond the Storm Track Data window and “Next” to move through the 
Scenario Review.  
12. Continue to click “Next” again and then “Finish”.  
13. Save your map document and exit Hazus.  
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Visual 24: Define Storm Track Manually 
 
How fast is the storm moving?  

• Elapsed time for each point along the 
storm track  

• Forward translation speed of the storm 
at each point  

What is the size of the storm?  
• Radius to maximum winds  
• Radius to hurricane force (64kt, 50kt, or 

34kt winds) 
What is the intensity of the storm?  

• Maximum wind speed  
• A Holland B profile parameter  

 

 
NOTE: Answers to these questions will depend on the format of the information you have.   
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Visual 25: Parameters - Translation Speed 
How fast is the storm moving? 
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Visual 26: Translation and Rotation Speeds 
Increase in rotation speed means different % increase on right and left side of storms.  
For example below:  

• 10 mph increase in rotation speed (100 to 110 mph)  
• 8% increase in windspeed on right side of storm (120 to 130 mph)  
• 12% increase in windspeed on left side of storm (80 to 90 mph)  
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Visual 27: Converted Wind Speeds 
Typical Storm Parameters 

Saffir Simpson Scale 1 Min Mean (mph) 3 sec Gust (mph) Min Central Pressure 
(mb) 

1 74-95 90-116 980 and up 

2 96-110 117-134 965-979 

3 111-129 135-159 945-964 

4 130-156 160-189 920-944 

5 157+ 189+ 920 and below 

1 min mean = Hazus Input Windspeeds 
3 sec gust = Hazus Output Windspeeds 
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Visual 28: Parameters: Storm Size  

 

 
Radius to max winds and radii can be adjusted in the settings.xml 
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Visual 29: Parameters: Storm Intensity 
 
Maximum Wind Speed 
Profile Parameter (B)  

• Parameter that describes the rate of 
pressure drop in the storm  

• Pressure drop determines the maximum 
wind speed  
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Visual 30: Typical Storm Parameters 
Hurricane 
and Station 

Measured 
Peak Gust 
at 10m 
(m/sec) 

Anemomet
er Height 
(m) 

Wind 
Speed 
Averaging 
Time (sec) 
Mean 

Wind 
Speed 
Averaging 
Time (sec) 
Gust 

Holland's B 
Parameter 

Radius to 
Maximum 
Winds 
(km) 

Fran 
(1996), 
FPSN7 

48.3, 37.7 44.2 600 5 .95 85 

Fran 
(1996), 
DSLN7 

29.6 46.6 600 5 .95 85 

Bertha 
(1993), 
FPSN7 

45.1 44.2 600 5 1.2 70 

Emily 
(1993) 
DSLN7 

51.0, 56.7 46.6 600 5 1.7 39 

Andrew 
(1992), 
NGW LMS 

58.6 13.7 120 5 1.6 19 

Bob 
(1991), 
41001 

30.6 5.0 600 5 1.4 35 

Hugo 
(1989), 
FPSN7 

31.7 42.2 600 5 1.0 40 
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Visual 31: Storm Track Definition 
 

• Manually enter storm parameters  
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Visual 32: Hurricane Data Sources: Hurdat 
• Good to manually define storm track  

National Hurricane Center’s HURricane DATabase: https://www.nhc.noaa.gov/data/#hurdat  
• Enhanced collection of historical meteorological data  

• HURDAT2: Best Track Data  
• Atlantic and Pacific  
• Comma-delimited, text format  
• Six-hourly information on location, maximum winds, central pressure, and size of all 

known tropical and subtropical cyclones  
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Visual 33: Show Current Scenario 
 
Select Hazard > Show Current 
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Visual 34: Lesson 4: Review 
1. What are the deterministic options for hurricane scenarios in Hazus? 
2. Where (geographically within a hurricane) are the greatest hurricane windspeeds located 

and why? 
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Visual 35: Questions? 
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Lesson 5: Probabilistic Storm Parameters 
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Visual 1: Lesson 5: Probabilistic Storm Parameters 
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Visual 2: Goal and Objectives 
Goal: To provide an overview of the set of probabilistic storm scenarios available to users in 
Hazus. 
After completing this lesson, you will be able to: 

• Discuss the differences in the probabilistic analyses in Hazus 
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Visual 3: Scenario Operations 
Hazus has six choices for defining hurricane scenarios:  

• Historic  
• Probabilistic  
• Create New:  

• Define Storm Track Manually  
• Import from Exported File (storm created in previous Hazus Study Region)  
• Import Census Tract Data File  
• Import a Hurrevac Storm Advisory 
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Visual 4: Probabilistic vs. Deterministic 
Probabilistic wind speed database (Left)  

• 100,000 years of simulated storms  

Individual Storms (Right)  
• Historical 
• Forecast/Advisory  
• User-defined  
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Visual 5: Modeling Risk 
 

• The hurricane wind model was run to 
simulate 100,000 hurricane seasons.  
• Storms can vary in size, strength, 

speed, direction 
• Provides objective way to compare risk 

of different areas  
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Visual 6: Probabilistic Windspeeds 
 

• The probabilistic windspeeds in the 
Table of Contents window (next 
slide) show the overall wind risk to the 
US and are the same windspeeds as in 
Figure 4.28  

• These layers were created from the 
100,000 years worth of simulated 
storms.  

• Windspeeds were ranked for each tract 
and recurrence intervals were 
determined.    

 
Figure 4.28 in Hurricane Technical Manual 
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Visual 7: Probabilistic Windspeeds (Cont'd.) 
 
These layers answer the question:  

• What is the windspeed for this tract that 
equates to a given recurrence interval?  

• For example, 115 MPH winds for tract 
12103024901 for the 1% annual chance 
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Visual 8: Probabilistic Windspeeds 
 

• For an actual hurricane:  
• Windspeeds are not uniform across 

the storm.  
• Windspeeds are higher at eyewall 

and lower farther away.  
• Using these layers:  

• Assume the recurrence interval (100 
year) at every location in the study 
region  

• Good for building codes, but may 
not be best for planning 
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Visual 9: Probabilistic Scenario: Scenario Driven 
 

• Table of Contents windspeed 
probabilities should not be confused 
with the probabilistic scenario.  

• Table of Contents layers:  
• Provide communities with the 

recurrence interval windspeed for 
each tract.  

• Probabilistic scenario: 
• Provide communities with a 

representative recurrence interval 
event based on loss for the study 
region. 

• Losses are representative of the 
specific event, not the recurrence 
interval windspeeds.  
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Visual 10: Probabilistic Scenario: Scenario Driven  
 
For planning purposes: 

• A community needs to understand 
damages and losses from an actual 
hurricane for each recurrence interval. 

• This method answers questions such as 
"What would the damages and losses be 
for our community from a return period 
(e.g. 100-year) hurricane event?"  
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Visual 11: Probabilistic Scenario: Scenario Driven 

 

 
• Hazus searches through 100,000 year simulated database for all storms that intersect 

the study region.  
• The total losses for the region based on each storm are ranked.  
• Loss is selected, then the hurricane event is used to generate damages and losses.  
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Visual 12: Seven Return Period Events 
 
Events Sorted by Total Loss for the study region  
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Visual 13: Discussion 5.1: 500-Year Event 
Goal: Discuss the windspeed distribution for this 500 year event.  
Time: 5 minutes 
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Visual 14: Discussion 5.1: 500-Year Event  

 

 
Discuss the windspeed distribution for this 500 year event.  

• Where do you expect the highest and lowest losses? 
• Is every Census tract experiencing a 500 year event (individually)?  
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Visual 15: Outputs: Return Period Event 
Seven Return Period Events 

• Seven single storm scenarios from 100,000 year storm database 
• Representation of the return period losses for study region: 10, 20, 50, 100, 200, 500, 

1,000 years 
• Return periods are based on total direct economic loss for entire study region 

Full set of results provided 
• Damage, debris, shelter, etc. 
• Dollar losses 
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Visual 16: Study Region Characteristics & Losses 
 
There are many different ways to produce a 100-year loss for a given study region. 

 
*These very different storms can produce identical dollar losses for the same study region. 
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Visual 17: Study Region Characteristics & Losses 

 

 
Even though both of these study regions contain Charlotte County, Florida, they will have very 
different probabilistic scenarios because the events are selected by finding all probabilistic 
events that intersect the study region and ranked based upon the losses to the study region.  
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Visual 18: Uses of Probabilistic Layers 
 
Wind speed Maps in Table of Contents window  

• Mitigation plan: identifies the 
windspeed each location individually 
plans for with respect to each 
probabilistic interval (10 yr, 100 yr, 
etc.)  

• Construction design: identifies the 
windspeed buildings should be able to 
withstand 

NOTE: Wind building characteristics 
distributions can model changes in construction 
wind resistance. 
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Visual 19: Uses of Probabilistic Layers 
 
Probabilistic Event Scenarios  

• Layers used in mitigation and planning 
situations to understand overall losses to 
the jurisdiction for each recurrence 
interval event. 

• Demonstrate the damages and losses if 
an actual hurricane affected the area  

• Example: debris planning, sheltering 
planning, and response and recovery 
exercises  
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Visual 20: Probabilistic Losses 
 
Building Economic Losses  

• Seven Return Period Events 
• Annualized: the estimated long-term 

value of losses to the general building 
stock averaged on an annual basis for a 
specific hazard type 

All other results  
• Seven Return Period Events 
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Visual 21: Exercise 5.2: Probabilistic Scenario 
Goal: Run a Probabilistic Scenario. 
Time: 45 Minutes 
 

 

Student 
Manual 

 

Exercise 5.2: Probabilistic Scenario 
Goal: 

• Run a Probabilistic Scenario 
Time: 45 minutes  
Exercise Steps:  

1. Refer to Activities Document “05.2_Exercise_Probabilistic 
Scenario.”  

2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 22: Exercise 5.2: Tasks 
Task 1: Open the Region and Define a Probabilistic Scenario. 
Task 2: Run the Analysis. 
Task 3: View the Results. 
 

 

Student 
Manual 

 

Exercise 5.2: Tasks 
• Refer to Activities Document "05.2_Exercise_Probabilistic 

Scenario." 
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Activity 5.2: Probabilistic Scenarios 
Type: Student-Led Activity  
Time: 45 minutes  
Goal: Run probabilistic scenario.    
Background:  
Hazus comes with a substantial library of historical storms. You can use the tracks and other 
characteristics of storms that occurred in the past to understand what the impact would be on a 
community of a similar storm were to occur today given the way that buildings are constructed, 
how they are used, and where they are located. This exercise will help you explore the process of 
defining a probabilistic storm scenario and it will also help you explore the study region 
inventory to provide a context for understanding the impact of the hurricane on the exposed 
buildings and population.  
 

Task 1: Run the Probabilistic Analysis.  

1. Start Hazus and select “Import a region”. Import the “Probabilistic” HPR from the 
C:\E0170_ActivityData\Activity_5.2 folder.  
2. Name the imported region, “Probabilistic_HU”  
3. Once complete, select Open a Region from the Hazus startup menu and select the 
“Probabilistic_HU” region.  
4. From the Hazard menu choose “Scenario” to open the Scenario wizard.  
5. Click Next to move past the initial window of the wizard.  
6. Select Probabilistic and click “Next”. 
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7. Click “Next” to make the scenario active and then click Finish.  
8. From the Analysis menu choose “Run” to open the Analysis Options window.  
9. Uncheck the Automated Output Option radio boxes and click “Run Analysis”.   
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10. When the analysis is complete, click OK.  
11. From the Results menu, choose “Wind Speeds”.  
12. Find the 200 Year Event Peak Gust (mph) column. Question: What is the highest peak wind 
gust? Answer: Peak Wind Gust: 135  
13. Click on the 200 Year Event Peak Gust (mph) column and then “Map” to add the 
probabilistic storm path and windspeeds as map layers.  
14. “Close” this window.  
15. Right-click on the StormTrack - 200 year return period event layer in the Table of Contents 
window on the left and choose Zoom to Layer.  
16. View the probabilistic storm being used to create the 200 year event for the study region. The 
storm’s winds are modeled for each tract of the study region based on the speed, size, and 
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intensity of the probabilistic hurricane. Based on the peak wind gusts for each tract, damage and 
losses are calculated within each tract.  
17. Right-click on the Wind Speeds-200 Year Event Peak Gust (mph) layer and choose Zoom to 
Layer.  
Question: What is the geographic distribution of windspeeds for the probabilistic event of this 
study region?  
Answer:  
Question: Explain why this pattern exists.  
Answer:  
18. Click the check box next to the StormTrack - 200 year return period event and Wind Speeds - 
200 Year Event Peak Gust (mph) to turn off each layer.  
19. Click the box next to the 200 year return period peak gust (mph) layer which was created and 
populated when the study region was created, to turn it on.  
Note: Notice there is no storm track associated with this layer. This is because it was not created 
from a hurricane event.  
20. Right-click on the 200 year return period peak gust (mph) layer and select Label Features.  
21. Answer the following questions:  
Question: What is the peak wind gust for this probabilistic layer?  
Answer:  
Question: What is the geographic distribution of windspeeds for this probabilistic layer for this 
study region?  
Answer:  
Question: Explain why this pattern exists.  
Answer:  
Question: What are the major differences between the two windspeed layers?  
Answer:  
22. Right-click on the Wind Speeds - 200 Year Event Peak Gust (mph) layer and choose Open 
Attribute Table.  
23. Find tracts 48355003001 and 48355005802. (The wRtnP5 column contains the 200-year 
gusts.)  
Question: What are the peak wind gusts for these two tracts?  
Answer:  
 

Task 2: View and Compare the Results.    

You just completed an analysis of the impact to the study region from the perspective of 
individual census tracts. At the beginning of this exercise you ran the probabilistic event analysis 
where you generated seven return period events. We looked at the 200-year event, which was 
selected from the 100,000-year probabilistic storm database located in Hazus. The storm will 
affect each individual census tract in the study region differently depending on the characteristics 
(size, speed, intensity) and the proximity to the storm path of each tract.  
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• Scenario 1: If you lived in tract 48355003001 and this probabilistic event actually 
occurred, you would experience a 200-year event. This is determined by opening the 
attribute tables of the seven different return period layers, locating the census tract 
records, and determining which column the peak wind gust falls into. The peak wind gust 
for this tract is 123 mph and this falls into the “f200yr” column for this census tract 
record in each of the attribute tables of the return period layers.  

• Scenario 2: If you lived in census tract 48355005802, you would experience a 500-year 
event. In this scenario, the peak wind gust in the tract is 119 mph and this value falls into 
the “f500yr” column in each of the attribute tables of the seven return period layers.  

Question: As a county emergency manager, how would you explain the event the county as a 
whole is experiencing?  
Answer:  
2. Locate tract 48355003001.  
Question: What are the peak wind gusts for each return period?  
Answer:  

• wRtnP1 (10 year):  
• wRtnP2 (20 year):  
•  wRtnP3 (50 year):  
• wRtnP4 (100 year):  
• wRtnP5 (200 year):  
• wRtnP6 (500 year):  
•  wRtnP7 (1000 year):  

3. Close the attribute table.  
4. Answer the following questions:  
Question: Why doesn’t the winsdpeed steadily increase as the return periods get longer?  
Answer:  
Question: What might you expect for the damages and losses for this tract as the return periods 
increase? What about for the study region?  
Answer:  
5. From the Results menu select “Summary Reports”.  
6. Select the “Direct Losses” tab.  
7. Click to highlight the “Direct Economic Losses for Buildings” report.  
8. Click View to view the report.  
9. Reports for every return period are listed. Note: To view other return period reports you can 
click the arrows in the top left of the report window.  
10. In the table below, record the Cost Building Damage for each return period:  
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Results Table 

Return Period Cost Building Damage 

Annualized  

10  

20  

50  

100  

200  

500  

1000  
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Visual 23: Annualized Hurricane Loss (AHL) 
 

• The expected value of future losses 
averaged on an annual basis  

• Formula expression  
• m = events  
• n = years  

• Formula description  
• Sum of expected loss for each event, 

divided by number of years in 
simulation (n= 100,000 years)  

• Uses  
• Fundamental measure of the risk for 

mitigation strategy  
• Unbiased basis for relative ranking 

and resource allocation  
• Benefit-cost analysis of mitigation 

options  
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Visual 24: Annualized Hurricane Loss (AHL) 
Annualized Hurricane Losses are provided for 

• Building Economic losses ($) 
• Output and Employment losses ($) 

Not provided for 
• Damage 
• Debris 
• Shelter 

Called "Annualized" in direct economic results tables 
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Visual 25: Probabilistic Return Intervals vs. AHL 
• Probabilistic scenarios work inherently different from event based AHL estimates  

• Probabilistic scenarios look at a specific return interval  
• AHL looks at all potential events and is a combined value of events and years  
• Probabilistic scenarios are not calculating the impact of an event in all regions; it is 

specific to whatever is defined  
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Visual 26: Review 
1. Where can you find the two different types of probabilistic datasets? 
2. What return periods are used in probabilistic hurricane scenarios in Hazus?  
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Visual 27: Questions? 
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Lesson 6: Damage Models 
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Visual 1: Economic Loss Methodology 
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Visual 2: Lesson 6: Goal and Objectives 
Goal: To provide an overview of the damage and loss methodology for hurricane wind models in 
Hazus.  
After completing this lesson you will be able to:  

• Discuss the wind damage and loss methodology in Hazus.  
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Visual 3: The Building Envelope 
 

• Damages and losses begin with 
the building envelope 
performance, the amount of 
resistance to hurricane force 
winds.  
• Walls  
• Roofing  
• Windows  
• Doors  

• Failures to these components 
lead to more extensive damage.  

 
Mitigation Assessment Team Report: Hurricane 
Ivan in Alabama and Florida (FEMA 489) 
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Visual 4: Sub-Assembly Inventory Wind Model 
• Sub-assembly cost ratios separate the individual building components.  
• Represents the percentage of the replacement cost for each component  

• EX: if Hazus modeled a roof 100% damaged on a $100,000 one story residential 
structure, the total loss would be $3,000.  

Table of Default Residential Subassembly Cost Ratios  

Subassembly 1 Story 2 Story 3 Story 

Site Work 1% 1% 1% 

Foundation 13% 8% 5% 

Framing 13% 11% 14% 

Exterior Wall 22% 25% 26% 

Roofing 3% 2% 1% 

Interiors 32% 38% 39% 

Specialties 4% 4% 4% 

Mechanical 9% 8% 7% 

Electrical 3% 3% 3% 

Total 100% 100% 100% 

Hurricane winds do not affect all components equally, and therefore individual components must 
be modeled 
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Visual 5: Sub-Assembly Inventory Flood Model 
• Sub-assembly cost ratios were created for the surge model for combined losses.  
• 5 categories were created, but they are different than the hurricane model.  
• Therefore the hurricane sub-assemblies were aggregated into the same 5 categories, 

which prevents double counting of losses.  
Pre-FIRM 

Specific 
Occupancy 
or General 
Building 
Type 

Foundation Below 
First 
Floor 

Structure 
Frame 

Roof 
Covering 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES1: 
Single 

6% 2% 13% 5% 5% 20% 49% 100% 

RES2: MH 6% 2% 10% 3% 5% 20% 54% 100% 

RES3A: 
Duplex 

6% 2% 13% 5% 5% 20% 49% 100% 

RES3B: 3-
4 Units 

6% 2% 13% 5% 5% 20% 49% 100% 

RES3C: 5-
9 Units 

5% 1% 10% 2% 3% 10% 69% 100% 
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Visual 6: Sub-Assembly Inventory Flood Model 
Post-FIRM 

Specific 
Occupancy 
or General 
Building 
Type 

Foundation Below 
First 
Floor 

Structure 
Frame 

Roof 
Covering 

Roof 
Framing 

Exterior 
Wall 

Interiors Total 

RES1: 
Single 

11% 3% 10% 5% 5% 19% 47% 100% 

RES2: MH 8% 2% 10% 3% 5% 20% 52% 100% 

RES3A: 
Duplex 

11% 3% 10% 5% 5% 19% 47% 100% 

RES3B: 3-
4 Units 

11% 3% 10% 5% 5% 19% 47% 100% 

RES3C: 5-
9 Units 

10% 1% 9% 2% 3% 9% 66% 100% 
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Visual 7: Damages from Hurricane Winds 
 

• Wind pressure: the effect of the force of 
the wind on a building  

• Windborne Debris (Missiles): damage 
caused by building debris being 
airborne and damaging other structures  

• Roof types are referred to as 
“ballasted.”  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 6: Damage Models  SM-276 

Visual 8: Damages from Hurricane Winds 
 
Duration: longer durations (more damage) vs. 
shorter durations (less damage) of hurricanes 
when the windspeeds are equal  
Rainfall: after roofing materials or openings 
fail, water can damage the inside of a structure  
Atmospheric pressure: difference in 
atmospheric pressure causing damage  
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Visual 9: Damage States  
 
Damage results are reported by average 
percentage of buildings in each damage state: 

• None  
• Minor  
• Moderate  
• Severe  
• Destruction  

Damage state:  
• Function of amount of damage to key 

components 
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Visual 10: Damage States 
• Different damage state definitions for each building type  
• See the Hazus Hurricane Model Technical Manual  

Damage 
State 

Qualitativ
e Damage 
Descripti
on 

Roof 
Cover 
Failure 

Window 
Door 
Failures 

Roof 
Deck 

Missile 
Impacts 
on Walls 

Roof 
Structure 
Failure 

Wall 
Structure 
Failure 

0 No 
Damage 
or Very 
Minor 
Damage 
Little or 
no visible 
damage 
from the 
outside. 
No or 
very 
limited 
water 
penetratio
n. 

Less than 
or equal 
to 2% 

No No No No No 

1 Minor 
Damage 
Moderate 
roof 
cover loss 
that can 
be 
covered 
to prevent 
additional 
water 
entering 
the 
building. 
Marks or 
dents on 
walls 
requiring 

Greater 
than 2% 
and less 
than or 
equal to 
15% 

One 
window, 
door, or 
garage 
door 
failure 

No <5 
Impacts 

No No 
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Damage 
State 

Qualitativ
e Damage 
Descripti
on 

Roof 
Cover 
Failure 

Window 
Door 
Failures 

Roof 
Deck 

Missile 
Impacts 
on Walls 

Roof 
Structure 
Failure 

Wall 
Structure 
Failure 

painting 
or 
patching 
for repair 

Damage States for Residential Construction Classes 
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Visual 11: Damage States 
• Different damage state definitions for each building type  
• See the Hazus Hurricane Model Technical Manual  

Damage 
State 

Qualitativ
e Damage 
Descripti
on 

Roof 
Cover 
Failure 

Window 
Door 
Failures 

Roof 
Deck 

Missile 
Impacts 
on Walls 

Roof 
Structure 
Failure 

Wall 
Structure 
Failure 

2 No 
Damage 
or Very 
Minor 
Damage 
Little or 
no visible 
damage 
from the 
outside. 
No or 
very 
limited 
water 
penetratio
n. 

>15% 
and less 
than or 
equal to 
50% 

Greater 
than 1 
and less 
than or 
equal to 
the 
larger of 
"20%" 
and "3" 

1 to 3 
panels 

Typically 
5 to 10 
impacts 

No No 

3 Severe 
Damage 
Major 
window 
damage 
or roof 
sheathing 
loss. 
Major 
roof 
cover 
loss. 
Extensive 
damage 
to interior 
from 
water. 

>50% greater t
han the 
larger of 
"20%" 
and "3" 
and less 
than or 
equal to 
50% 

>3 
panels an
d Less 
than or 
equal to 
25% 

Typically 
10 to 20 
impacts 

No No 
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Damage 
State 

Qualitativ
e Damage 
Descripti
on 

Roof 
Cover 
Failure 

Window 
Door 
Failures 

Roof 
Deck 

Missile 
Impacts 
on Walls 

Roof 
Structure 
Failure 

Wall 
Structure 
Failure 

4 Destructi
on 
Complete 
roof 
failure 
and/or 
failure of 
wall 
frame. 
Loss of 
more than 
50% of 
roof 
sheathing. 

Typically 
> 50% 

>50% >25% Typically 
>20 
impacts 

Yes Yes 

Damage States for Residential Construction Classes 
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Visual 12: Examining Damage and Loss Curves 
 
Analysis Menu  

• Damage  
• Loss  
• Loss of use  
• Debris  
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Visual 13: Damage Curve Viewer 
 

• Select a Building Type  
• Click to Select different parameters  
• For 140 mph speed, there is a 35 

percent chance that the building will 
have at least severe damage  
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Visual 14: Four Curve Viewers 
 

• Building Damage  
• Building Loss  
• Building Loss of Use  
• Debris 
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Visual 15: Demonstration 6.1: Curve Viewers 
Goal: Review and discuss curve viewers 
Time: 10 minutes  
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Demonstration 6.1: Curve Viewers  
Type: Instructor-Led Activity  
Time: 10 minutes  
Goal: Review and discuss curve viewers  
Background:  
In order to show the losses from hurricane winds and storm surge, the sub-assembly losses were 
created. Sub-assembly loss curves for flooding were developed. After the damages to these 
components have been calculated, the % damage is then applied to the % of the replacement cost 
from the cost ratios. The losses for each component are totaled to get a total loss. 
 

Task 1: Show Damage and Loss Curve viewers  

1. For this demonstration, open the “Irma_Hurricane” study region created in Exercise 4.4.  
Note: If you did not create this study region, the HPR is provided in the 
C:\E0170_ActivityData\Demonstration_6.1 folder.  
2. Choose the Hurricane hazard.  
3. To view the damage and loss curves click on Analysis.  
4. Then click on each loss, damage and debris viewers and discuss how the GUIs work.  
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Task 2: Discuss Damage and Loss Curve modification examples 

1. Provide some examples of changing the wind building characteristics and how the curves 
change. 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 6: Damage Models  SM-288 

 
 

 
2. Switch the hazard to the Flood model.  
3. Go to Analysis > Damage Functions > Buildings.  
4. In the bottom left corner click Library.  
5. View the depth damage curves for RES1 structures.  
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6. Discuss how these curves change with water depth.  
7. Exit Hazus.  
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Visual 16: Tree Blow-Down Model 
 
Tree effects during wind storms:  

• Positive 
• Provide shelter to structures 
• Reduces wind pressure  

• Negative  
• Falling trees produce strike hazard 

to structure  
• Fallen trees add to amount of debris 

to dispose of after storm  
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Visual 17: Tree Model 
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Visual 18: Hazus Tree Coverage Database 
• Tree Inventory Database is derived from:  

• Multi-Restoration Land Consortium (MRLC) land use coverage database  
 Same data used for terrain database  

• Forest Inventory Analysis (FIA) Database  
• Developed by U.S. Forest Service (USFS)  
• Updated every 5 years  
• Nationwide inventory by species  
• Field survey and statistical analysis  
• Contains tree count and tree diameter distribution  
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Visual 19: Tree Database in Hazus 
 
Tree types 

• Deciduous 
• Coniferous 
• Mixed Tree Density (stems per acre) 

Tree height 
• Distribution between 3 broad 

categories: 
• 30 - 40 ft 
• 40 - 60 ft 
• 60 + ft 
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Visual 20: Damage Resulting from Trees 
 
Simulations of amount of damage:  

• Tree drop tests at Clemson University  
• Derived relationship of impact energy 

and damage severity  
• Cost estimated using data from 

RSMeans 2018 
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Visual 21: Tree Damage from Hurricane Irma (2017) 
Hazus tree model accounts for different types of tree damage that may occur.  

 

 
Photo taken in Gospel Island, FL after Hurricane Irma, September 2017 
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Visual 22: Loss Curves as Function of Tree Density 
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Visual 23: Loss Curves as Function of Tree Height 
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Visual 24: Loss Curves as Function of Tree Type 
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Visual 25: Exercise 6.2: Surface Roughness  
Goal:  

• Modify the surface roughness parameters in order to see the effect on the damages and 
losses. 

Time: 30 minutes  
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Visual 26: Exercise 6.2: Tasks 
Task 1: Define the default scenario. 
Task 2: Adjust the Surface Roughness to a Rural setting.  
Task 3: Adjust the Surface Roughness to an Urban setting.  
Task 4: View and Compare Results.  
Task 5: Restore the Census Tract to the default setting.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 6: Damage Models  SM-301 

Exercise 6.2: Surface Roughness 
Type: Student-Led Activity  
Time: 30 minutes  
Goal: Modify the surface roughness parameters in order to see the effect on the damages and 
losses.  
Background:  
Hazus comes with a substantial library of damage functions. Many of these functions depend on 
surface roughness. In areas with high surface roughness the damages from winds decrease 
because of the easing of the winds as a result of friction. In the areas with lower surface 
roughness, damages are generally greater because there is less friction. In this short exercise you 
will explore the impact of the surface roughness values by altering those values and then 
recording the changes in the damages.  
 

Task 1: Define the default scenario 

1. Start Hazus and select Open a region, click Next.  
2. Select HurricaneHarvey_CO and click Next.  
3. Click Finish.  
4. Once the study region is open in Hazus, navigate to Hazard and then Scenario.  
5. Click Next on the Scenario Wizard.  
6. Select Historic and then click Next.  
7. Click the Region Filter box to limit the historic storm options to only those that intersected the 
study region.  
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8. Select the 2017 Hurricane Harvey – Observed FEMA storm and click Next.  
9. Click next on the scenario review window.  
10. Click next to make the scenario active.  
11. Click Finish.  
12. Select “Analysis > Run” to open the Analysis Options window.  
13. Uncheck the Automated Output Options radio box.  
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14. Click “Run Analysis”.  
15. Click “OK” when the analysis completes.  
16. From the Results menu click Wind Speeds.  
17. Click on the column header for Peak Gust (mph) and then click “Map”.  
18. In the table under the Peak Gust (mph) column find census tract 48355003001.  
19. In the table located at the end of this exercise, record the Peak Wind Gust in the row for 
Scenario 1.  
20. Close the Wind Speeds by Census Tract window.  
21. Navigate to Results and Summary Reports.  
22. Click on the Direct Losses tab and view the Direct Economic Loss for Buildings report.  
23. Record the Total Direct Economic Loss in the row for Scenario 1 in the table at the end of 
the exercise.  
24. Close the Summary Reports window.  
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Task 2: Adjust the Surface Roughness to a Rural Setting 

1. From the Analysis menu choose “Parameters” then “Terrain”.  
2. Find census tract 48355003001 and change the surface roughness from 0.34 to 0.04. This 
value (0.04) simulates an agricultural setting.  
3. Click OK.  
4. Click “Yes” you want to update modified data.  
 

 

 
 

 
5. From the Analysis menu choose “Run” to open the Analysis Options window.  
6. Uncheck the Automated Output Options and then “Run analysis”.  
7. Click “OK” when the analysis completes.  
8. From the Results menu click Wind Speeds and “Map” the Peak Wind Gusts.  
9. In the attribute table of the Wind Speeds – Peak Gust (mph) layer, find census tract 
48355003001.  
10. In the table at the end of this exercise, record the Peak Wind Gust in the row for Scenario 2.  
11. Close the Wind Speeds by Census Tract window.  
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12. Navigate to Results and Summary Reports.  
13. Click on the Direct Losses tab and view the Direct Economic Loss for Buildings report.  
14. Record the Total Direct Economic Loss in the row for Scenario 2 in the table at the end of 
the exercise.  
15. Close the Summary Reports window.  
 

Task 3: Adjust the Surface Roughness to an Urban Setting.  

1. From the Analysis menu choose “Parameters” then “Terrain”.  
2. Find census tract 48355003001 and change the surface roughness to 0.70. This is to simulate a 
highly urban landscape.  
3. Click “OK” and indicate “Yes” you want to update your modified data.  
4. Go to “Analysis” then “Run”.  
5. Uncheck the Automated Output Options and “Run analysis”.  
6. Click “OK” when the analysis completes.  
7. From the Results menu click Wind Speeds and “Map” the Peak Wind Gusts.  
8. In the attribute table of the Wind Speeds – Peak Gust (mph) layer find census tract 
48355003001.  
9. In the table at the end of this exercise, record the Peak Wind Gust in the row for Scenario 3.  
10. Close the Wind Speeds by Census Tract window.  
11. Navigate to Results and Summary Reports.  
12. Click on the Direct Losses tab and view the Direct Economic Loss for Buildings report.  
13. Record the Total Direct Economic Loss in the row for Scenario 3 in the table at the end of 
the exercise.  
14. Close the Summary Reports window.  
 

Task 4: View and Compare Results  

Results Table for Census Tract 48355003001 

Scenario Peak Gust Total Direct Economic Loss 

1. Default Surface Roughness: 0.34   

2. Surface Roughness: 0.04   

3. Surface Roughness: 0.70   
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Task 5: Restore the Census Tract to the default setting  

1. To return the census tract’s surface roughness to the default value click on the Analysis menu.  
2. Choose “Parameters” then “Terrain”.  
3. Find census tract 48355003001 and change the surface roughness back to 0.34.  
4. Click “OK” and indicate “Yes” you want to update your modified data.  
5. Save your map document and exit Hazus.  
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Visual 27: Lesson 6: Review 
1. What parameters define the Hazus wind damage models?  
2. How does Hazus display damage curves?  
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Visual 28: Questions? 
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Lesson 7: Hurricane Model Results 
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Visual 1: Lesson 7: Hurricane Model Results 
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Visual 2: Goal and Objectives 
Goal: To provide an overview of the set of results and how they can be viewed in Hazus. 
After completing this lesson, you will be able to: 

• Understand the damage and loss outputs. 
• Interpret the meaning of the results. 
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Visual 3: Results Formats 
  

 
• Tables 
• Maps 
• Reports 
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Visual 4: Viewing Results 
 

• Results menus are enabled once a 
hurricane scenario has been run and 
“Analysis > Run” has been selected.  
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Visual 5: Tables 

 

 
• Results align with inventory and analysis.  
• Tables populate only for damaged inventory / tracts.  
• Fields can be thematically mapped.  
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Visual 6: Hazard Maps 
 

• To show the hazard map choose 
“Results > Wind Speeds.”  

• Click on the column you wish to map.  
• Click “Map.” 
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Visual 7: Windspeed Results 
Peak wind gust: 3 second gust speeds 

• Hazus damages and losses are given as a function of the gust speed. 
Sustained winds: one minute average 

• Used for hurricane category determination 
  
NOTE: In study regions that have hurricane and flood hazards, the windspeeds are displayed on 
the block level; however, windspeeds are only calculated at the tract level and every block in 
each tract is assigned the same value. 
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Visual 8: Demonstration 7.1: Viewing Results & 
Reports 
Goal:  

• View results and reports from a hurricane analysis. 
Time: 40 Minutes 
 

 

Student 
Manual 

 

Demonstration 7.1: Viewing Results & Reports 
Goal: View results and reports from a hurricane analysis. 
Time: 40 minutes  
Exercise Steps:  

1. Listen to instructor’s directions.  
2. Ask questions if clarification is needed.  
3. Watch the instructor's demonstration. 
4. Ask any final questions.  
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Visual 9: Demonstration 7.1: Tasks 
Task 1: Import HPR 
Task 2: View General Building Stock Damage  
Task 3: View Essential Facilities Losses 
Task 4: View Debris 
Task 5: View Shelter Needs 
Task 6: Overview of Viewing Reports 
Task 7: Toolbar 
Task 8: Inventory Reports 
Task 9: Building Reports 
Task 10: Induced Losses 
Task 11: Direct Losses Reports 
Task 12: Other Report Options 
 

 

Student 
Manual 

 

Demonstration 7.1: Tasks 
• Refer to Activities Document “Demonstration07.1_Viewing Results 

& Reports.”  
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Visual 10: Automated Output Options 
 

• Automatically saves reports  
• Creates thematic maps of results 
• Drawback: Increases analysis 

processing time (up to an hour increase 
in some cases) 
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Visual 11: Automated Output Options 
 

• Output reports are automatically saved 
in the study region folder.  

• Four different output formats:  
• PDF 
• Word 
• Excel 
• HTML 
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Visual 12: Automated Output Options 
 

• Select Results: When the analysis is 
complete a thematic map is 
automatically created.  

• Layer(s): automatically appears in the 
table of contents window.  
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Visual 13: Results Table: Export 
 
Formats  

• TXT 
• CSV 
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Visual 14: Summary Report: Export 
 

• PDF 
• RTF 
• DOC 
• XLS 
• CSV 
• TXT 
• XML 
• Etc. 

 

 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 7: Hurricane Model Results  SM-324 

Visual 15: Exercise 7.2: Hurricane Results 
Goal:  

• Learn methods for displaying hurricane results.  
Time: 30 minutes 
 

 

Student 
Manual 

 

Hurricane Results 
Goal: Learn methods for displaying hurricane results. 
Time: 30 minutes 
Exercise Steps: 

1. Refer to Activities Document “07.2_Exercise_Hurricane Results” 
2. Listen to instructor’s directions. 
3. Ask questions if clarification is needed. 
4. Work individually on the goal. 
5. Ask questions to the instructor if needed. 
6. Complete the assigned goal. 
7. Be prepared to share their answers/results. 
8. Ask any final questions.  
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Visual 16: Exercise 7.2: Tasks 
Task 1: Import the Hurricane Michael HPR.  
Task 2: Open the Scenario.  
Task 3: Prepare the Results in the Map. 
Task 4: Visualize Building Damage and Dollar Losses.  
 

 

Student 
Manual 

 

Exercise 7.2: Tasks 
• Refer to Activities Document “07.2_Exercise_Hurricane Results” 
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Exercise 7.2: Hurricane Results 
Type: Student-Led Activity  
Time: 30 minutes  
Goal: Learn methods for displaying hurricane results.  
Background:  
Understanding, interpreting, and communicating the results in Hazus is vital. This exercise will 
examine results in Hazus to allow you to become more familiar with where they are stored. 
Additionally, this exercise will help you focus on how to interpret the information that Hazus 
generates.  
 

Task 1: Import the Hurricane Michael HPR.  

1. Start Hazus and import the HurricaneMichael HPR from the 
C:\E0170_ActivityData\Exercise_7.2 folder.  
2. Name the region Hurricane_Michael.  
3. Once the import is complete, click Open a Study region, select the study region name and 
click Next.  
4. Click Finish.  
 

Task 2: Open the Scenario.   

1. Navigate to the Hazard menu and then click Show Current to ensure the historic Michael 
scenario is the active scenario. 
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Task 3: Prepare the Results in the Map.  

1. From the Results menu choose “Shelter” to open the Shelter Analysis Results.  
2. Click on the Short Term Shelter Needs column and click “Map”.  
 

 

 
 

 
3. Click “Close” to close the Shelter Analysis Results. 
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4. Right-click on the Shelter - Short Term Shelter Needs layer and select Properties.  
5. Select the Symbology tab.  
6. In the Show window on the left side of the Layer Properties window, select Quantities.  
7. Under Quantities select “Dot density”.  
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8. In the Field Selection window choose ShortTermShelterNeeds and then click the right arrow.  
9. Double-click on the Circle symbol to the left of ShortTermShelterNeeds.  
 

 

 
 

 
10. Click on the down arrow next to the color and select Mars Red. 
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11. Click “OK”.  
12. Change the Dot Value to “1”.  
 

 

 
 

 
13. Click “OK”. The dot density map provides a slightly different view of the results. This helps 
find clusters with the data and identifying areas of the greatest concern.  
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14. From the Results menu choose Essential Facilities.  
15. Click on the Schools tab and map the schools with minor damage.  
16. Close the Essential Facilities window.  
17. Right click on the Schools – Minor Damage in the Table of Contents and click Properties.  
18. Click on the Symbology tab and choose Features: Single Symbol.  
19. Click on the Symbol to activate the symbol selector and search for “School”.  
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20. Click on the Labels tab and check the box next to Label features in this layer. 
21. Change the label field to Name. 
22. Change the font to Calibri and size 16. 
23. Click the "Symbol..." button under Text Symbol. 
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24. Click the "Edit Symbol" button. 
25. Choose the Mask tab and then the radio button next to Halo. 
26. Change the Size to 1. 
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27. Click "OK" through the next three screens to display the schools with labels on the map. 
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28. Answer the following question. 
Question: How could this information be used?  
 

Task 4: Visualize Building Damage and Dollar Losses.  

1. Turn off or remove the Shelter - Short Term Shelter Needs and the Schools-Minor Damage 
layers.  
2. From the Results Menu, choose General Building Stock > Building Economic Loss > By 
Occupancy.  
3. Click on the All Occupancies radio button under View Results By and then select the Building 
column and click “Map”.  
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4. Once finished click “Close”.  
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5. Click the “Add Data” button, navigate to C:\E0170_ActivityData\Exercise_7.2 folder and 
double click on the TotalExposure.mdb. This database was prepared for this activity by 
exporting the Total Exposure values from the General Building Stock inventory in Hazus.  
6. Click to highlight the TotalExposure table and click Add.  
 

 

 
 

 
7. Click on the “List by Drawing Order” button at the top of the table of contents window.  
8. Right-click on the Building Loss - All ($K) layer and select Joins and Relates > Join.  
9. Select “Join Attributes” from a table from the “What do you want to join to this layer” option.  
10. Under Option 2 select TotalExposure using the drop down arrow.  
11. Select Tract from the drop down arrow in Option 1 and Tract in Option 3.  
12. Select “Keep all records”.  
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13. Click “OK” when finished and select “Yes” if asked if you want to index the table.  
14. Right-click on the Building Loss - All ($K) layer and select Properties.  
15. Select the Symbology tab, if it is not already selected, and then select Quantities > Graduated 
colors, if not already selected.  
16. Under Value select Building.  
17. Under Normalization select TotalExposure.  
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18. Click “OK”. The layer you have created is Total Building Loss over Total Building Exposure 
for each tract. This is a building loss ratio map. 
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19. You have just created a building loss ratio layer. This represents the percentage of the total 
building exposure that is damaged for each census block. Answer the following:  
Question: What are some uses for this layer?  
 
20. Save your map and exit Hazus when you are finished. 
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Visual 17: Lesson 7: Review 
1. How are the general building stock damages reported? 
2. What is the Rapid Loss Assessment? 
3. What are the three main formats a user can use to display his/her results? 
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Visual 18: Questions? 
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Lesson 8: Economic Loss Methodology 
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Visual 1: Lesson 8: Economic Loss Methodology 
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Visual 2: Lesson 8: Goal and Objectives 
Goal: To provide an overview of the economic loss methodology in the hurricane wind model.  
After completing this lesson you will be able to:  

• Discuss the economic loss outputs.  
• Understand the parameters associated with this methodology.  
• Describe the appropriate use of these outputs.  
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Visual 3: Direct Economic Loss Outputs 
  

• Building Loss  
• Contents Loss  
• Business Inventory Loss  
• Relocation Expense  
• Loss of Income  
• Rental Income  
• Wage Income  
• Output Loss  
• Employment Loss  
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Visual 4: Building/Content Loss Model: 
Development  

• Physically-based damage-to-loss model 
• Computes direct economic losses using 

• Explicit costing  
 Windows, doors, sheathing, roof cover, etc.  

• Implicit costing  
 Estimates of volume of water entering through failed windows, doors, etc. 

• Details of loss models found in Section 8 of the Hurricane Technical Manual  
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Visual 5: Loss Model 
Hazus loss models are based upon building types:  

• Residential  
• Exterior vs. interior losses  

• Manufactured homes  
• Includes damage to foundation and frame  
• Includes serviceability replacements (85% of ultimate capacity)  

• Commercial buildings  
• Total cost distributed differently  
• Sub-assembly costs used instead of unit costs  
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Visual 6: Residential Damage-to-Loss Methodology 
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Visual 7: Loss of Use 
• Building Loss Ratio: Loss to the building divided by the replacement cost of the building. 
• Building loss ratio is used as an indicator of reconstruction time.  
• A multiplier is applied to the total reconstruction time to determine the loss of use to a 

structure.  

Occupancy 0% Building 
Loss Ratio 

2% Building 
Loss Ratio 

10% Building 
Loss Ratio 

50% Building 
Loss Ratio 

100% 
Building Loss 
Ratio 

RES1 0 0 0.5 1 1 

COM1 0.05 0.1 0.1 0.3 0.4 
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Visual 8: Loss of Use  
 
Loss of Use Multiplier  

• Reflects ability of business to relocate 
and thus minimize impact on income 
loss  

• At low levels of loss, business continues 
to operate in existing facility  

• At high levels of loss, business will 
decide to relocate and resume operation  
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Visual 9: Loss of Use Model 
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Visual 10: Business Inventory Losses 
• Function of contents loss ratio and square footage 
• Estimated for following occupancies: 

• COM1: Retail Trade 
• COM2: Wholesale Trade 
• IND1: Heavy 
• IND2: Light 
• IND3: Food/Drugs/Chemicals 
• IND4: Metals/Minerals Processing 
• IND5: High Technology 
• IND6: Construction 
• AGR1: Agriculture 

  
INV = FA x SALES x BI x CL 

• FA: Floor Area 
• SALES: Annual gross sales per square foot 
• BI: Business Inventory % 
• CL: Content Loss Ration (0-1) 
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Visual 11: Business Inventory Losses  
• National Averages  

• May not apply to your community 
• Updates can be obtained from U.S. Department of Commerce’s Bureau of Economic 

Analysis or local state.  
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Visual 12: Discussion 8.1: Loss Estimates  
Goal: Participate in a class discussion about loss estimates.  
Time: 10 minutes  
Questions:  
1. How are loss of use estimates and business inventory losses used in mitigation planning or 
response and recovery planning?  
2. Where are potential sources from which we might obtain credible values to put in the analysis 
tables?  
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Visual 13: Rental Income Loss 
Addresses the remainder of population in census tract that is not owner-occupied.  
RYi = FAi x (1-00%i) x RENTi x LOUi  
FAi = Floor Area  
1-00%i = % of Renter-Occupied  
RENTi = RENT (sq.ft/day)  
LOUi = Loss of Use in Days  
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Visual 14: Relocation Loss 
Costs associated with moving out of an unusable building:  

• Disruption costs: cost of shifting business to new facility  
• Rental costs: cost of renting new facility while old facility is repaired  

Assumptions: 
• Building owners incur expense of moving tenants  
• Renter has no new rental expenses  
• The following occupancies will not relocate  

• COM8: Entertainment & Recreation  
• COM9: Theaters  
• COM10: Parking  
• IND1: Heavy Industry  
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Visual 15: Relocation Loss  
RELi = FAi x DCi x pi(damage > Minor) + FAi x 00%i x RENTi x LOUi  
FAi = Floor Area 
DCi = Disruption cost per square foot 
pi(damage > Minor) = Fractino of buildings with damage state of at least moderate 
00%i = % of Owner-Occupied  
RENTi = RENT (sq.ft/day)  
LOUi = Loss of Use in Days  
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Visual 16: Loss of Income 
• Business income (profit) loss occurs when building damage disrupts economic activity.  
• Data is based on IMPLAN system from U.S. Department of Commerce Bureau of 

Analysis.  
  
YLOSi = (1-RFi) x FAi x INCi x LOUi x MODi 
RFi = Recapture Factor 
FAi = Floor Area 
INCi = Income per day (per sq. ft.) 
LOUi = Loss in Use in Days 
MODi = Loss of Use Multiplier 
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Visual 17: Loss of Income 
Occupancy Description Recapture Factor 

RES1 -3 Private Residences 0 

RES4 -6 Hotel/Motel Institutions 0.6 

COM1 -2 Retail/Wholesale Trade 0.87 

COM3 Personal & Repair Service 0.51 

COM4 -5 Financial 0.9 

COM6 -10 Hospital, Entertainment, 
Parking 

0.6 

IND1 -6 Industrial 0.98 

AGR1 Agricultural 0.75 

EDU1 Education 0.6 

EDU2 College/university 0.6 

GOV1 General Service 0.8 

GOV2 Emergency Response 0 

REL1 Churches 0.6 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 8: Economic Loss Methodology  SM-361 

Visual 18: Wage, Employment, and Output Losses 
Same as business income loss: 
LOSSi,n = (1-RFi) x FAi x INCi x LOUi x MODi 
Replace INCi with: 
Wage Losses: WAGEi = $/SF/day 
Employment Losses: EMPLOYi = work day/SF/day 
Output Losses: OUTPUTi = $/SF/day 
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Visual 19: Loss Model Validation 
 

• Comparison to insurance claim data  
• Five sets of insurance loss data from 

three insurance companies  
• Bhinderwala (1995)  
• Two proprietary data sets  
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Visual 20: Loss Model Validation 
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Visual 21: Loss Model Validation: Comparison  
 
Validation completed by performing analysis of 
specific storms: 

• Hurricane Andrew 
• Hurricane Hugo 
• Hurricane Erin 
• Hurricane Opal 

Simulation: 
• Wind field and wind loads 
• Terrain model 
• Damage, loss models 
• Inventory 
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Visual 22: Loss Function Viewer 
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Visual 23: Exercise 8.2: Economic Loss Parameter 
Goals:  

• Run a historical scenario.  
• Modify the economic loss parameters.  

Time: 60 minutes  
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Visual 24: Exercise 8.2: Tasks  
Task 1: Run the default Historic Hurricane Michael Scenario.  
Task 2: Modify Annual Gross Sales Parameter.  
Task 3: Modify the Business Inventory Parameter. 
Task 4: Modify the Rental and Disruption Costs Parameter. 
Task 5: Modify the Percent Owner Occupied Parameter. 
Task 6: Modify the Wages and Capital Related Income Parameter. 
Task 7: Compare the Results of Modifying the Economic Loss Parameters.  
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Exercise 8.2: Economic Loss Parameter 
Type: Student-Led Activity  
Time: 60 minutes  
Goals:  

• Run a historical scenario. 
• Modify the economic loss parameters.  

Background:  
In this exercise you are going to use current values to update the parameters responsible for 
calculating economic losses. Many of the default values in Hazus are out-of-date and the values 
are based on national averages. If you are interested in the economic outputs from Hazus, it is 
important you update the appropriate inputs. In this exercise you will update the economic loss 
parameters.  
Note: If you have trouble generating any of the Global Summary Reports for the six cases, the 
reports are provided in the C:\E0170_ActivityData\Exercise_8.3\Results folder.  
 

Task 1: Run the default Historic Hurricane Michael Scenario.  
1. Open Hazus.  
2. Create a new region with the following paramenters:  

• Name: Economic_Parameter  
• Hazard: Hurricane  
• Aggregation level: County  
• State: Florida  
• Counties: Bay and Gulf  

3. Open the region.  
4. From the Hazard menu choose Senario.  
5. Click Next.  
6. Choose Historic and click Next.  
7. Click Region Filter.  
8. Select “2018 Hurricane Michael – Observed FEMA” and click Next.  
9. Click Next.  
10. Click Next to make the scenario active.  
11. Click Finish.  
12. From the Analysis menu select “Run”.  
13. Choose Select All except for “Automated Output Options”  
14. Click “Run Analysis”.  
15. When the analysis has finished, click “OK” to close the window.  
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16. From the Results menu click on “Summary Reports”.  
17. Select the Other tab, and click to highlight the “Global Summary Report” .  
18. Click View to view the report.  
19. Use the Global Summary report to fill out the table at the end of this exercise for Case 1.  
 

Task 2: Modify Annual Gross Sales Parameter  

The parameters in the Building Economic Data table were created many years ago and are out of 
date. Furthermore, many of the values are based upon national averages. To get accurate results 
for the economic loss parameters you must update these tables. State workforce development, 
trade agencies, and labor statistics offices may provide you with more up-to-date information. As 
is the case with most input data in Hazus, the more local the economic information you acquire, 
the more precise your results will be.  
1. From the Analysis menu choose “Parameters” > “Building Economic”.  
2. Select the Business Inventory tab. Make sure Annual Gross Sales ($ per sq. ft.) is selected 
from the drop-down menu.  
 

 

 
 

 
3. Change the values of COM1 and COM2 to “100”. Based on national averages, the default 
Hazus values are too low. The values you will enter represent bottom end values for national 
averages today.  
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4. Click “OK” and then “Yes” to save your changes.  
5. From the Analysis menu select “Run”.  
6. Choose Select All except “Automated Output Options”.  
7. Click “Run Analysis”.  
8. When the analysis has finished, click “OK” to close the window.  
9. From the Results menu click on “Summary Reports”.  
10. Select the Other tab, and open the “Global Summary Report” .  
11. Click View to view the report.  
12. Use the report to fill out the table at the end of this exercise for Case 2.  
 

Task 3: Modify the Business Inventory Parameter 

1. From the Analysis menu choose “Parameters” > “Building Economic”.  
2. Select the Business Inventory tab.  
3. Select Business Inventory (% of gross annual sales) from the Table Type drop-down menu.  
4. Based on national averages, the default Hazus values appear to be too low. The % of gross 
annual sales for retail and whole sale trade is nearly all of these industries total sales in today’s 
market  
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5. Change the values of COM1 and COM2 to “90”.  
6. Click “OK” and then “Yes” to save your changes.  
7. From the Analysis menu select “Run”.  
8. Choose Select All except for “Automated Output Options”  
9. Click “Run Analysis”.  
10. When the analysis has finished, click “OK” to close the window.  
11. From the Results menu click on “Summary Reports”.  
12. Select the Other tab, and open the “Global Summary Report”.  
13. Click View to view the report.  
14. Use the report to fill out the table at the end of this exercise for Case 3.  
 

Task 4: Modify the Rental and Disruption Costs Parameter 

1. From the Analysis menu choose “Parameters” > “Building Economic”.  
2. Select the Income Loss tab and “Rental and Disruption Costs ($ per sq ft): from the Table 
Type drop-down menu.  
3. Change the values of COM1 and COM2 to “1.25” for Rental Costs/month and “0.04” for 
Rental Costs/day.  
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4. Click “OK” and then “Yes” to save your changes.  
5. From the Analysis menu select “Run”.  
6. Choose Select All except for “Automated Output Options”  
7. Click “Run Analysis”.  
8. When the analysis has finished, click “OK” to close the window.  
9. From the Results menu click on Summary Reports.  
10. Select the Other tab, and open the “Global Summary Report”.  
11. Click View to view the report.  
12. Use the report to fill out the table at the end of this exercise for Case 4.  
 

Task 5: Modify the Percent Owner Occupied Parameter 

1. From the “Analysis” menu choose “Parameters > Building Economic”.  
2. Select the Income Loss tab and “Percentage Owner Occupied” from the Table Type drop-
down menu.  
3. Scroll down and change the values of RES1 to “82.6” for % Owner Occupied. This is an 
opportunity for you or other local officials to integrate more detailed data.  
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4. Click “OK” and then “Yes” to save your change.  
5. From the Analysis menu select “Run”.  
6. Choose Select All except for “Automated Output Options”.  
7. Click “Run Analysis”.  
8. When the analysis has finished, click “OK” to close the window.  
9. From the Results menu click on” Summary Reports”.  
10. Select the Other tab, and open the “Global Summary Report”.  
11. Click View to view the report.  
12. Use the report to fill out the table at the end of this exercise for Case 5.  
 

Task 6: Modify the Wages and Capital Related Income Parameter 

1. From the Analysis menu choose “Parameters” > “Building Economic”.  
2. Select the Income Loss tab and “(Wages and Capital Related Income)” from the Table Type 
drop-down menu.  
3. Change the values of COM1 and COM2 to the following:  

• Income/year to 40.000  
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• Income/day to 0.109  
• Employment to 0.000  

 

 

 
 

 
4. Click “OK” and then “Yes” to save your changes.  
5. From the Analysis menu select “Run”.  
6. Choose Select All except for “Automated Output Options”.  
7. Click “Run Analysis”.  
8. When the analysis has finished, click “OK” to close the window.  
9. From the Results menu click on” Summary Reports”.  
10. Select the Other tab, and open the “Global Summary Report”.  
11. Click View to view the report.  
12. Use the report to fill out the table at the end of this exercise for Case 6.  
13. When you are finished filling out the table and answering the questions below, save your 
map document and exit Hazus.  
 

Task 7: Compare the Results of Modifying the Economic Loss 
Parameters.  

Case Scenario Description Inventory 
Losses 

Income 
Losses 

Relocation 
Losses 

Rental 
Losses 

Wage 
Losses 
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Case Scenario Description Inventory 
Losses 

Income 
Losses 

Relocation 
Losses 

Rental 
Losses 

Wage 
Losses 

1 Hazus Default Building 
Economics 

     

2 Set COM1 and COM2 
Sales/SQFT to 100 

     

3 Set COM1 and COM2 
business inventory to 90. 

     

4 Set COM1 and rental costs 
to $1.25/SQFT/Month 

     

5 Set Owner Occupied to 
82.6% 

     

6 Set Income(40, 0.109) and 
Employment (0.000) 

     

 

Questions 

Use the technical manuals or presentation slides to answer the following questions  
1. Why did the Rental Losses decrease when the Owner Occupied values were increased to 
82.6%? 
2. Why didn’t the Wage Losses ever change?  
3. Why did the relocation loss results change?  
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Visual 25: Lesson 8: Review 
1. Why are the Building Loss of Use results important for planning?  
2. Where can you find the input parameters that determine the economic loss results?  
3. What confidence should you place on results that use the default inputs for economic 

losses? Why?  
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Visual 26: Questions? 
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Lesson 9: Shelter and Debris Models 
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Visual 1: Lesson 9: Shelter and Debris Models 
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Visual 2: Lesson 9: Goal and Objectives 
Goal: To describe the shelter and debris models. 
After completing this lesson, you will be able to: 

• Understand the shelter and debris parameters. 
• Demonstrate how to modify the parameters. 
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Visual 3: Shelter Model 
Follows model used for earthquake hazard. 

• Uses building loss ratios instead of building damage states to estimate proportion of 
uninhabitable housing units  

Two estimates for each census tract 
• Number of displaced households 
• Number of people requiring short-term public shelter 

• Function of income class, ethnic class, ownership class, population age class 
NOTE: Discussed in Technical Manual (Chapter 11) 
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-382 

Visual 4: Shelter Model Methodology 
 
Step 1: Estimate number of uninhabitable 
households resulting from wind damage.  

• Mean loss ratio (loss/building value) 
used to predict fraction of uninhabitable 
units  

• Function derived from simulations of 
damage and loss for single-family and 
multi-family buildings  

• Analyzed for each census tract  
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Visual 5: Shelter Model Methodology 
Step 2: Calculate number of displaced households. 

• Add displaced houses from previous step 
• Multiply by occupancy rate 

• Estimated from census data 
Step 3: Repeat for each census tract. 
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Visual 6: Shelter Model Methodology 
 
Step 4: Estimate number of people in shelters. 

• Based on fraction of displaced households 
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Visual 7: Shelter Estimates: Weighting Factors 
 

• Same factors as earthquake model 
• Defaults to only income and ethnicity 

affecting shelter estimates  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-386 

Visual 8: Shelter Estimates: Income Weighting 
Factors 
Proportion of people in a given class that will go to a public shelter: 
Excerpt of Table 11.2-2 for Household Income weighting factors 

Symbol Description Default Value 

(Fi)1 Income < $10000 0.62 

(Fi)2 $10000 < Income < $15000 0.42 

(Fi)3 $15000 < Income < $25000 0.29 

(Fi)4 $25000 < Income < $35000 0.22 

(Fi)5 $35000 < Income 0.13 
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Visual 9: Shelter Estimates: Ethnicity Weighting 
Factors 
Excerpt of Table 11.2-2 for Ethnicity weighting factors 

Symbol Description Default Value 

(Fe)1 White 0.24 

(Fe)2 Black 0.48 

(Fe)3 Hispanic 0.47 

(Fe)4 Asian 0.26 

(Fe)5 Native American 0.26 
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Visual 10: Shelter Estimates: Weighting Factors 
Weight factor is a product of two sets of factors  

• Weighting Factors 
• Modification Factors  
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Visual 11: Debris Model 
Eleven categories of debris resulting from wind events (Public Assistance Program and Policy 
Guide, 2018):  

• Vegetative Debris  
• Construction and Demolition Debris 
• Hazardous Waste  
• Household Hazardous Waste  
• White Goods  
• Electronic Waste  
• Soil, Mud, and Sand  
• Vehicles and Vessels  
• Putrescent Debris  
• Infectious Waste  
• Chemical, Biological, and Nuclear – Contaminated Debris  

NOTE: Chapters 10 and 12 in the Hurricane Model Technical Manual 
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Visual 12: Building Debris Model 
Development of debris curves 

• Based on load-resistance damage states 
• Component unit weights 
• Typical density of debris type 
• Debris type distribution of damaged components 
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Visual 13: Component Unit Weight 
• Exterior building components: Weights from RS Means 2018  
• Interior building components: Weights from RS Means 2018  
• Contents: Estimated based on sustained live loads from ASCE 7-98  
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Visual 14: Viewing Building Debris Curves 
 

• Each specific building type has a set of 
debris functions related to terrain.  

• Rougher terrains: Less building debris 
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Visual 15: Debris Model: Validation 
Storm Region Actual 

Weight 
(tons) 

Actual 
Volume 
(cubic 
yards) 

Modeled 
Weight 
(tons) 

Modeled 
Volume 
(cubic 
yards) 

Model/Actu
al Weight 

Model/Actu
al Volume 

Hugo South 
Carolin
a 

- 15,500,00
0 

951,009 9,130,843 - 0.59 

Hugo USAC
E 
Admin. 
Region 

- 4,589,559 782,480 7,366,394 - 1.61 

Andre
w 

Dade 
County 

2,900,00
0 

40,000,00
0 

3,396,99
1 

35,323,08
0 

1.17 0.88 

• Statistics reported in published papers  
• Limitations of comparisons  

• Hugo South Carolina comparison region may be larger than assumed from paper  
• Hazus debris model = ~ +/- 30%  
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Visual 16: Tree Debris Model 
• Estimates based on 

• Tree coverage database 
• Tree blow-down model  

• Expected green weight of tree stems for trees greater than 30 ft. tall 
• Eligible tree debris 

• Debris estimates made for all areas. 
• Unpopulated areas may not be collected. 

• Volume based on 10 cubic yards / ton. 
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Visual 17: Demonstration 9.1 – Shelter and Tree 
Parameters 
Goal:  

• Show how to view shelter and tree parameters 
Time: 10 Minutes 
 

 

Student 
Manual 

 

Demonstration 9.1: Shelter and Debris Parameters 
Goal: Show how to view shelter and tree parameters 
Time: 10 Minutes 
Demonstration Steps:  

1. Listen to instructor’s directions.  
2. Ask questions if clarification is needed.  
3. Watch the instructor’s demonstration.  
4. Ask any final questions. 
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Demonstration 9.1 – Shelter and Tree Parameters 
Type: Instructor-Led Demonstration 
Time: 10 minutes  
Goal: Show how to view shelter and tree parameters  
Background:  
In this demonstration you will explore the shelter and tree parameters. The default values for the 
sheltering parameters are based upon national assumptions. In this exercise you will investigate 
the role these parameters play in the calculations of the sheltering results. Tree parameters are 
also based upon national datasets and you will modify the tree parameters to explore the changes 
to the results. 
 

Task 1: Review Shelter Parameters 

1. Navigate to the C:\E0170_ActivityData\Demonstration_9.1 folder and import the 
HurricaneMichael HPR.  
2. Name the study region “ShelterTree”.  
3. Open the study region and go to Analysis > Parameters > Shelter  
4. Discuss the Weighting Factors (Age, Ethnic, Income, Ownership) and their values.  
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5. Discuss the Modification Factor classes (Income, Ethnicity, Ownership, Age) and the values 
associated with each of the factors.  
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6. Demonstrate that you can modify these values. 
 

Task 2: Review Tree Parameters 

1. Go to Analysis > Parameters > Trees. 
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2. Discuss tree parameters including predominant tree type, stems per acre, tree height, and tree 
collection factor.  
3. Demonstrate that you can modify these values.  
Question for the participants: Where can you as a user obtain information that can improve the 
shelter parameter?  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-400 

Visual 18: Exercise 9.2: Tree and Sheltering 
Parameters 
Goal: 

• Explore the impact of altering tree and sheltering parameters. 
Time: 45 Minutes 
 

 

Student 
Manual 

 

Exercise 9.2: Tree and Sheltering Parameters 
Goal: Explore the impact of altering tree and sheltering parameters.  
Time: 45 Minutes  

1. Refer to Activities Document “09.2_Exercise_Tree and Sheltering 
Parameters.”  

2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 19: Exercise 9.2: Tasks 
Task 1: Open the Study Region  
Task 2: Explore Sensitivity to Shelter Parameters.  
Task 3: Compare Shelter Parameter Modification Results.  
Task 4: Explore Sensitivity of Debris to Tree Damage. 
Task 5: Compare Tree Density Modification Results. 
 

 

Student 
Manual 

 

Exercise 9.2: Tasks 
• Refer to Activities Document “09.2_Exercise_Tree and Sheltering 

Parameters.”  
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Exercise 9.2: Tree and Sheltering Parameter 
Type: Student-Led Activity  
Time: 45 minutes  
Goals: Explore the impact of altering tree and sheltering parameters.  
Background:  
In this exercise you will explore the sheltering and tree parameters in Hazus. The default values 
for the sheltering parameters are based upon national assumptions. In this exercise you will 
investigate the role these parameters play in the calculations of the sheltering results. Tree 
parameters are also based upon national datasets and you will modify the tree parameters to 
explore the changes to the results. 
 

Task 1: Open the Study Region  
1. Open Hazus.  
2. Select Open a region and click OK.  
3. Click Next.  
4. Select the Economic_Parameter study region (created in Exercise 8.2) and click Next.  
5. Click Finish.  
6. From the Hazard menu choose Show Current.  
7. The Historic Hurricane Michael should be the active scenario.  
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8. Click “Close”. 
 

Task 2: Explore Sensitivity to Shelter Parameters 

In this section of the exercise you will explore the impacts that the shelter parameters have on 
estimation of shelter needs. As you explore these impacts, you will fill in the table named Shelter 
Parameters Comparison which is found at the end of the exercise. The first row of this table, 
which shows the results of the Hurricane Michael scenario using default shelter estimation 
parameters, has been filled in for you.  
1. From the Inventory menu choose “Demographics” to open the demographics table.  
2. Click on the FemaleOver65 field name and then click “Map”.  
3. Click on the MaleOver65 field name and then click “Map”.  
4. Click “OK” to exit the demographics window.  
5. Toggle between the Demographics – MaleOver65 and Demographics – FemaleOver65 layers, 
and in the space below describe where the over 65 populations reside in this study region.  
Answer:  
6. From the Analysis menu choose “Parameters” > “Shelter” to open the Shelter Parameters 
window.  
7. Click the Weighting Factors tab. The default values show no consideration is given to either 
age or home ownership. Also notice that income is the most important factor by default.  
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8. Change the value for the Age weight factor to 1.0.  
9. Change all other weighting factors to zero. This will make the age the only factor considered 
for sheltering.  
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-405 

 
 

 
10. Click “OK” on the Shelter Parameters window.  
11. Click “Yes” to indicate you want to save the changes.  
12. From the Analysis menu choose “Run”.  
13. Choose Select All.  
14. Uncheck the Automated Output Options.  
15. Click “Run Analysis”.  
16. When the analysis has finished, click “OK” to close the window.  
17. From the Results menu click on Shelter.  
18. Click on the Short Term Shelter Needs column, click “Map.  
19. Close the Shelter Results window.  
20. Label the map to show the number of people requiring shelter.  
21. Write down which census tract has the most people requiring shelter.  
Answer:  
22. Record the number of displaced households and the number of people requiring shelter in the 
row labeled Case 2 of the Shelter Parameters Comparison table at the end of the exercise.  
23. From the Analysis menu choose “Parameters” > “Shelter” to open the Shelter Parameters 
window.  
24. Click the Modification Factors tab.  
25. Select Age from the Class drop down menu.  
26. Change the value for Population Over 65 yrs to 1.00. This will mean that 100% of this age 
group that is displaced from the hurricane will require shelter.  
27. Do not alter the other factors.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-406 

 

 
 

 
28. Click the “OK” button and then “Yes” when prompted to save your changes.  
29. From the Analysis menu choose “Run”.  
30. Select all of the outputs except the Automated Output Options.  
31. Click “Run Analysis”.  
32. When the analysis is done click OK.  
33. Record the number of displaced households and the number of people requiring shelter in the 
row labeled Case 3 of the Shelter Parameters Comparison table.  
34. Open the Shelter Parameters Weighting Factors table and change the value for the Ethnicity 
weight factor to 1.0.  
35. Change all other weighting factors to zero. 
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36. Click “OK” and then “Yes” when prompted to indicate whether you want to save your 
changes.  
37. From the Analysis menu choose Run.  
38. Select all of the outputs except the Automated Output Options.  
39. Click “Run analysis”.  
40. Record the number of displaced households and the number of people requiring shelter in the 
row labeled Case 4 of the Shelter Parameters Comparison table at the end of the exercise.  
41. Open the Shelter Parameters Weighting Factors table and change the value for the Income 
weight factor to 1.0.  
42. Change all other weighting factors to zero.  
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43. Click the “OK” button and then “Yes” when prompted to save your changes.  
44. From the Analysis menu choose “Run”.  
45. Select all of the outputs except the Automated Output Options.  
46. Click “Run analysis”.  
47. Record the number of displaced households and the number of people requiring shelter in the 
row labeled Case 5 of the Shelter Parameters Comparison table at the end of the exercise.  
48. Open the Shelter Parameters Weighting Factors table and change the value for the Ownership 
weight factor to 1.0.  
49. Change all other weighting factors to zero.  
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50. Click “OK” and then “Yes” when prompted to save your changes.  
51. Run the analysis and record the number of displaced households and the number of people 
requiring shelter in the row labeled Case 6 of the Shelter Parameters Comparison table at the end 
of the exercise.  
 

 Task 3: Compare Shelter Parameter Modification Results.   

1. Review the results of modifying the different weighting factors. Consider how modifying 
these factors might help you better represent the impacts of a hurricane in your community. 
 

Task 4: View and Compare Results 

Shelter Parameters Comparison 

Case Shelter Parameters Displaced 
Households 

People in 
Shelter 

1 Hurricane Celia Hazus Default 8,018 4,816 

2 Set Age Weight Factor to 1.0 and all others to 0   

3 Set the Over 65 Age Modification Factor to 1.00   

4 Set Ethnic Weight Factor to 1.0 and all others to 
0 
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Case Shelter Parameters Displaced 
Households 

People in 
Shelter 

5 Set Income Weight Factor to 1.0 and all others 
to 0 

  

6 Set Ownership Weight Factor to 1.0 and all 
others to 0 

  

 

Questions 

1. Which weighting factor(s) change had the greatest impact on the shelter results. 
2. Why didn't the displaced households values change in any case?  
3. Why did Case 2 and Case 6 have the exact same sheltering result? 
4. Why did the income weight make little difference in this study region? 
 
2. Once you are finished, replace the values with the Original Sheltering Parameters. Use the 
following graphics as a guide. You have made changes to only the Weighting factors table and 
the Age Modification Factors table. 
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Task 4: Explore Sensitivity of Debris to Tree Damage. 

In this section of the exercise you will explore the impact that changing input parameters has on 
estimation of tree debris. As you explore these impacts, you will fill in the table named Tree 
Density Parameters Comparison which is found at the end of the exercise. The first column of 
this table, which shows the results of the Hurricane Michael scenario using default parameters, 
has been filled in for you.  
1. From the Analysis menu choose “Parameters” > “Trees” to open the Tree Parameters window.  
2. Change all of the values in the Stems per Acre column to 400. • Note: You can copy (CTRL + 
C) and paste (CTRL + V) values to save time.  
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3. This change will illustrate an example where the default tree inventory has been severely 
underestimated.  
4. Click “OK” to close the Tree Parameters window and click “Yes” when asked if you want to 
update the modified data.  
5. From the Analysis menu choose “Run”.  
6. Select all of the outputs except the Automated Output Options  
7. Click Run Analysis.  
8. Explore the results and fill in the column labeled 400 Stems Per Acre of the Tree Density 
Parameters Comparison table located at the end of the exercise.  
9. Change all of the values in the Stems per Acre column of the Tree Parameters table to 50.  
10. This change will illustrate an example where the default tree inventory has been slightly 
underestimated.  
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11. Run the analysis and use the results to fill in the 50 stems per acre column of the Tree 
Density Parameters Comparison table.  
12. Change all of the values in the Tree Collection Factor column of the Tree Parameters table to 
0.90.  
 

 

 
 

 
13. Run the analysis and fill in the Tree Collection Factor 0.90 column of the Tree Density 
Parameters Comparison table. Since you didn’t change the inventory to the default amounts, you 
can only compare the results from this step with the ones from the previous step (50 stems per 
acre).  
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14. When the exercise is complete, save your map document and exit Hazus.  
 

Task 5: Compare Tree Density Modification Results. 

Parameter Hurricane  
Michael Hazus 
Default 

400 Stems per 
Acre 

50 Stems per 
Acre 

Tree Collection 
Factor 0.90 

Displaced 
Households 

8,018       

Residential 
Property Damage 
Total 

$3.2 B       

Debris: Trees 
(tons) 

2,774,289       

Debris: Eligible 
Tree Debris 
(tons) 

29,446       

 

Questions 

1. Why was there a change to the number of displaced households due to changes in the stems 
per acre? 
Answer:  
2. Why did the amount of Tree Debris decrease from the 50 steps per acre analysis to the Tree 
Collection Factor analysis?  
Answer:  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 9: Shelter and Debris Models  SM-415 

Visual 20: Lesson 9: Review 
1. What are the four factors modeled in Hazus that impact sheltering estimates? 
2. What are the only types of debris modeled in the Hazus Hurricane Model? 
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Visual 21: Questions? 
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Lesson 10: Hurricane Surge Model 
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Visual 1: Lesson 10: Hurricane Surge Model 
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Visual 2: Lesson 10: Goal and Objectives 
Goal: To provide an overview of the storm surge model within Hazus. 
After completing this lesson, you will be able to: 

• Discuss the causes for storm surge. 
• Describe the Hazus surge model components. 
• Understand the procedure for running a hurricane surge in Hazus. 
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Visual 3: Hurricane Scenario Definition Options 
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Visual 4: Sources of Storm Surge 
 

1. Hurricanes (i.e. 
Hurricane Katrina)  

2. Extratropical Cyclones 
and Nor’easters  
• Edmund Fitzgerald 

(1975): 15-20 foot 
waves in Great 
Lakes  

• Storm of the Century 
(1993): 12 foot 
waves in Atlantic  

3. Subtropical Storms 

 
https://earthobservatory.nasa.gov/IOTD/view.php?id=46662 
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Visual 5: What Causes a Storm Surge? 
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Visual 6: Factors Influencing a Surge's Size 
 

• Storm surge: abnormal rise of water generated by a storm, over and above the predicted 
astronomical tides  

• Storm tide: water level rise due to the combination of storm surge and the astronomical 
tide  
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Visual 7: Factors Influencing a Surge's Size 
 

• Wave breaking can increase the height 
of the surge and is dependent on the 
continental shelf.  
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Visual 8: Factors Influencing a Surge's Size 
 
Wind and Storm Motion  

• Strongest winds and thus highest surge 
(without coastline effects) occur in the 
right - front quadrant of hurricane  

• Here the forward speed of the hurricane 
is added to the rotational winds of the 
hurricane to achieve the highest wind 
speeds  
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Visual 9: Storm Surge Dynamics 
  

 

The hurricane’s surface winds 
push against the water, and 
water from below moves upward 
to replace the displaced water.  

 

The bulge of water and current 
slam into the continental shelf 
and are forced upward and 
inward.  
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Visual 10: Coastline Effects and Surge Size 
 

• Orientation of the hurricane with 
respect to the coastline can influence 
the surge magnitude.  

• Water can ‘pile up’ with favorable 
orientations. If hurricane winds are 
pushing against the coastline, water is 
caught along the coast.  

• Water can also be trapped in bays.  
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Visual 11: Surge Demonstration 
 
Hurricane Dennis Surge: 
https://www.nhc.noaa.gov/surge/HistoricalRuns/?large&parm=2005_dennis#contents 

 
Hurricane Dennis (2005) 

 

 

http://www.nhc.noaa.gov/surge/HistoricalRuns/?large&parm=2005_dennis#contents


August 2020 E0170: Hazus for Hurricanes 

Lesson 10: Hurricane Surge Model  SM-429 

Visual 12: Discussion 10.1: Storm Surge 
Goal: Discuss the previous animation and answer the questions.  
Time: 10 Minutes 
Questions:  

1. How does the orientation of the coastline effect the storm surge depth?  
2. Where are the highest storm surges?  
3. How can a surge affect an area (geographically) that is not in close proximity to the 

hurricane path?  
 

 

Student 
Manual 

 

Discussion 10.1: Storm Surge 
Goal: Discuss the previous animation and answer the questions. 
Time: 10 minutes  
Discussion Steps:  

1. Listen to instructor’s directions.  
2. Ask questions if they need directions clarified.  
3. Discuss the questions with your group.  
4. Designate a group member to share your answers with the class.  
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Visual 13: Hurricane Storm Surge Overview 
 
Hurricane Model  

• Windspeed and direction  
Surge Model  

• SLOSH (sea, land, ocean)  
• SWAN (near shore)  

Wind and Surge are combined for aggregate 
inventory damages and losses only.  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 10: Hurricane Surge Model  SM-431 

Visual 14: SLOSH 
• SLOSH = Sea, Lake, and Overland Surge from Hurricanes  
• Numeric Model initialized on a grid that requires the following inputs:  

• Basin selection: SLOSH is packaged with pre-defined basins that have bathymetry 
(NGDC) and elevation information (USGS) for each grid cell.  

• Hurricane characteristics: direction of movement, radius to maximum winds, 
pressure, location, direction, and speed 
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Visual 15: SLOSH 
 

• Produces reasonably accurate estimates 
of surge and runs quickly  

• Emergency management community is 
familiar and comfortable with using this 
model.  

• Does not explicitly model tide.  
• Tide is generalized by treating it as 

a fixed increase or decrease in initial 
water level based on predicted tide 
at time of landfall in the absence of 
storm surge and waves.  
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Visual 16: SLOSH Basins 
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Visual 17: Domains in SWAN Runs 
 
Domains  

• Deep Water: Red  
• Near Shore: Blue 
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Visual 18: SWAN 
 

• Simulating Waves Nearshore  
• Created by Delft University of 

Technology  
• Models:  

• Wave propagation  
• Wave generation from wind  
• Wave interactions, dissipation, 

transmission, and diffraction  
• Others 
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Visual 19: Coupled Surge and Wave Modeling 
• SLOSH and SWAN codes have been coupled together.  
• Methodology bridges gap between existing Hazus Hurricane Wind and Hazus Coastal 

Flood models  
• SLOSH is run first to update water elevations.  

• SWAN uses water elevations produced by SLOSH.  
• Result is larger modeled wave heights in areas where waves are depth-limited.  

• SWAN is run to update wave stresses.  
• Wave stresses are added to wind stress in SLOSH.  
• Increases modeled storm surge due to wave setup  
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Visual 20: Overland Waves 
• Model uses 1-D transects and simplified WHAFIS-like methodology to propagate waves 

inland from the shoreline.  
• Where each transect intersects the coastline, use the modeled significant wave height 

from SWAN to estimate the controlling wave height, Hc = min(0.78 ds, 1.6 Hs) where ds 
= still water depth at the coast line.  

• Wave crest elevation = SWEL + 0.7 Hc  
• Neglect wave regeneration and wave dissipation  
• Neglect wave run-up and dune erosion  

• Use V-zone damage functions where Hc ≥ 1.5 ft  
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Visual 21: User Work Flow 
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Visual 22: Activity 10.2: Hurricane Storm Surge  
Goal:  

• Create a combined Flood/Hurricane study region. 
Time: 10 minutes 
 

 

Student 
Manual 

 

Storm Surge 
Goal: Create a combined Flood/Hurricane Study Region 
Time: 10 minutes 
Exercise Steps: 

1. Refer to Activities Document “10.2_Activity_Hurricane Storm 
Surge” 

2. Listen to instructor’s directions. 
3. Ask questions if clarification is needed. 
4. Work individually on the goal. 
5. Ask questions to the instructor if needed. 
6. Complete the assigned goal. 
7. Be prepared to share their answers/results. 
8. Ask any final questions.  
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Visual 23: Exercise 10.2: Tasks 
Task 1: Create a Surge Study Region 
Task 2: Create a Surge Scenario 
Task 3: Run a Surge Analysis  
 

 

Student 
Manual 

 

Activity 10.2: Tasks 
• Refer to Activities Document “10.2_Activity_Hurricane Storm 

Surge” 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 10: Hurricane Surge Model  SM-441 

Activity 10.2 – Hurricane Storm Surge  
Type: Instructor-Led Activity  
Time: 10 minutes  
Goals: Create a combined Flood/Hurricane study region 
Background:  
The storm surge model is a powerful application that allows users to understand the combined 
losses from hurricane winds and storm surge. This application provides a more realistic set of 
losses than can be produced by separately analyzing flood and wind losses. By using this 
approach, mitigators and planners can have a more comprehensive look at what to expect and 
prepare for in their community. 
In this exercise you will build a study region for Pinellas, Florida. You will go through the steps 
of running the analysis based on the Hurricane Irma historical scenario. In your next activity, you 
will then import a study region for which the storm surge analysis has already completed in 
which you will move to the flood model, run the analysis, and view the results.  
 

Task 1: Create a new Surge scenario   

1. Create a new study region based on the following parameters:  
• Study Region Name: IrmaStormSurge  
• Hazard Type: Hurricane and Flood  
• State: Florida  
• County: Pinellas  

2. Open the “IrmaStormSurge” study region  
3. Select the radio button next to the hurricane hazard and click Next.  
4. Click Finish.  
 

Task 2: Create a Surge Scenario 

1. From the Hazard menu select Scenario to open the scenario wizard.  
2. Click “Next” to advance beyond the welcome screen.  
3. Select “Historic” from the Hurricane Scenario options and make sure the radio button is 
selected next to “Activate”.  
4. Click “Next” to advance the wizard.  
5. Click on the Region Filter button. This will only list the hurricanes that affected your study 
region.  
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6. Select “Hurricane Irma – Observed FEMA” and click “Next”. 
 

 

 
 

 
7. On the scenario review screen make sure you have selected the correct storm and then click 
“Next”. 
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8. Select “Yes. Make this scenario active” and then click “Next”.  
9. Exit the wizard by clicking “Finish” on the final screen.  
 

Task 3: Run a Surge Analysis  

1. From the Analysis menu make sure the “Set Optimized Analysis Mode” is set to OFF. 
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2. When set to ON Hazus will calculate the wind hazard on the tract level. Since we are running 
the storm surge model, we want this set to OFF so it will run on the block level to combine block 
level wind results with block level flood results.  
3. Open the Analysis menu by choosing “Analysis > Run”. This is the step that you would take 
to begin the damage and loss calculations for the Hurricane Wilma scenario.  
4. Click Select All and then uncheck Automated Output Options. Make sure to select “No 
Waves” for Storm Surge.  
 

 

 
 

 
5. Click on “Run Analysis”.  
6. The Initial Water Level window will appear. For this activity we estimated 2 feet. Instead of 
entering a value and running the analysis, click cancel on this window.  
7. Click “Cancel” on the analysis options window.  
8. Running the storm surge model can take > 1 hour to complete. Instead we will exit this region 
and import one that has completed already. The only step you are missing by not running the 
analysis is watching the status bars progress as the surge model completes.  
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9. Exit Hazus.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 10: Hurricane Surge Model  SM-446 

Visual 24: Coastal Surge Hazard Modeling Options 
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Visual 25: Initial Water Level 
 
Pre-storm tide anomaly is the difference between: 

• The observed tide  
• The predicted tide approximately two days before landfall (i.e., before the effects of 

storm surge or waves reach the study region) 
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Visual 26: Flood Hazard Type and User Data 
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Visual 27: Depth Grids 
 

• Depict variable flood depths throughout 
the determined flood extent for an event  

• May be produced for a range of flood 
events  
• Most commonly the 0.2-percent, 1-

percent, 2-percent, 4-percent, and 
10-percent annual chance flood 
events  

• Many are available for download from 
FEMA MSC  

• Can be created from raw data  
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Visual 28: Defining Topography 
 

• Required DEM extents automatically 
determined by Hazus  

• You can use USGS national map DEM 
or provide your own more detailed 
DEM  

• Terrain Data in Esri GRID format (Ex. 
High resolution community/county 
specific LiDAR, NED 10m or NED 
30m) 
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Visual 29: Delineate Floodplain 
 

• Inundation limits  
• Transects  

• Depth-limited wave heights 
• Zone determination  

• A-zone  
• Coastal A-zone  
• V-zone   
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Visual 30: Surge Model 
 

• Wind losses created first in the 
hurricane model.  

• Storm surge depths are input into the 
flood model. 

• Flood (surge) damages and losses 
utilize the flood depth damage curves. 

• The combined analysis utilizes a new 
set of curves that combine the flood and 
wind losses.   
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Visual 31: Flood Depth-Damage Curves 
Damage to buildings and infrastructure is estimated using depth-damage curves.  
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Visual 32: Depth-Damage Functions 
 
Depth-damage functions are applied to relevant 
depth.  

• Buildings: first-floor height 
• Coastal Buildings: Bottom of first 

finished floor  
• Equipment: height above first floor  
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Visual 33: Viewing Depth Damage Curves 
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Visual 34: Viewing Depth Damage Curves 
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Visual 35: FEMA Flood Zone A 
The Special Flood Hazard Area (except coastal V Zones) shown on a community's Flood 
Insurance Rate Map.  There are five types of A Zones:   

Zone Description 

A SFHA where no base flood elevation is 
provided. 

A# Numbered A Zones (e.g., A7 or A14), SFHA 
where the FIRM shows a base flood elevation 
in relation to NGVD.  

AE SFHA where base flood elevations are 
provided. AE Zone delineations are now used 
on new FIRMs instead of A# Zones.  

AO SFHA with sheet flow, ponding, or shallow 
flooding. Base flood depths (feet above grade) 
are provided.  

AH Shallow flooding SFHA. Base flood elevations 
in relation to NGVD are provided.  
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Visual 36: FEMA Flood Zone V 
The Special Flood Hazard Area subject to coastal high hazard flooding.  
There are three types of V Zones:  

Zone Description 

V SFHA where no base flood elevation is 
provided. 

V# Numbered V Zones (e.g., V7 or V14), SFHA 
where the FIRM shows a base flood elevation 
in relation to NGVD.  

VE SFHA where base flood elevations are 
provided. VE Zone delineations are now used 
on new FIRMs instead of V# Zones.  
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Visual 37: FEMA Flood Zone C 
• Area of minimal flood hazard.  
• Usually depicted on Flood Insurance Rate Maps as above the 500-year flood level.  
• B and C Zones may have flooding that does not meet the criteria to be mapped as a 

Special Flood Hazard Area.  
• Especially ponding and local drainage problems.  
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Visual 38: GBS Flood Loss Estimation 
 
Hazus performs an area weighted assessment of 
damage for aggregate inventory.  

• Number of grid cells at a given depth is 
counted and then divided by total 
number of cells within census block.  

• Result is used to “weight” damage at 
that flood depth for each occupancy. 

• This approach is most appropriate for 
large areas.  
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Visual 39: GBS Loss Estimation Methodology  
 

• Assumes that inventory is evenly 
distributed across each census block.  
• EX: If 25% of the block has 2 

feet of water, it is assumed that 25% 
of the 4 single family dwellings in 
the block are in 2 feet of water.  

• Losses reported as totals for each 
occupancy and building type rather than 
for each building.  
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Visual 40: Combined Flood and Wind Losses 
Table 8.132 in the Hurricane Technical Manual 

Sub-Assembly Pre-FIRM Foundation A Zone 
Conditions 

Pre-FIRM Foundation CA/V 
Zone Conditions 

Foundation Start damaging foundation at 
80% (first non-zero value is at 
90%) damage and max 
damage at 50% Pre-FIRM 
value (e.g. 3% if foundation 
represents 6% of the structure 
value) 

Start damaging foundation at 
50% damage (first non-zero 
value is at 60%) and max at 
80% Pre-FIRM value (e.g. 5% 
if foundation represents 6% of 
the structure value) 

Below First Floor Start damaging BFF at 0% 
damage (first non-zero value 
is 10%) and achieve 100% 
pre-FIRM value by 40% 
building damage 

Start damaging BFF at 0% 
damage (first non-zero value 
is 10%) and achieve 100% 
pre-FIRM value at 20% 
building damage 

Structure Frame Start damaging structure 
frame at 70% damage (first 
non-zero value is 80%) and 
achieve 100% Pre-FIRM 
value at 100% building 
damage 

Start damaging structure 
frame at 10% damage (first 
non-zero value is 20%) and 
achieve 100% Pre-FIRM 
value at 90% building damage 

Roof Cover Same as Structure Same as Structure 

Roof Frame Same as Structure Same as Structure 

Exterior Walls Start damaging exterior walls 
at 0% damage (first non-zero 
value at 10%) and reach 
maximum (100%) at 100% 
building damage. Ensure that 
exterior is always below 
interior. 

Start damaging exterior walls 
at 10% damage (first non-zero 
value is 20%) and reach 
maximum (100%) pre-FIRM 
value at 90% building 
damage. 

Interiors Start damaging interior at 0% 
damage (first non-zero value 
at 10%) and reach maximum 
Pre-FIRM value (100%) at 

Start damaging interiors at 0% 
damage (first non-zero value 
at 10%) and reach maximum 
Pre-FIRM value (100%) at 
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Sub-Assembly Pre-FIRM Foundation A Zone 
Conditions 

Pre-FIRM Foundation CA/V 
Zone Conditions 

80% building damage. 80% building damage. 
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Visual 41: Combined Flood and Wind Losses 
• Losses from wind and surge are combined using the combined losses tables.  

• EX: When wind losses are 50% and flood losses are 20%, the combined loss is 
62.5%.  

 0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100% 

0% 0% 10% 20% 30% 40% 50% 60% 70% 80% 90% 100% 

10% 10% 19.5
% 

28.7
% 

37.9
% 

47.1
% 

56.2
% 

65.3
% 

74.5
% 

84.4
% 

94.3
% 

100% 

20% 20% 29.1
% 

37.5
% 

45.9
% 

54.3
% 

62.5
% 

70.9
% 

79.4
% 

89.1
% 

98.9
% 

100% 

30% 30% 38.8
% 

46.7
% 

54.5
% 

62.3
% 

70.0
% 

77.8
% 

85.7
% 

95.0
% 

100.0
% 

100% 

40% 40% 48.4
% 

55.7
% 

62.8
% 

69.9
% 

76.9
% 

84.0
% 

91.2
% 

100.0
% 

100.0
% 

100% 

50% 50% 58.0
% 

62.6
% 

71.1
% 

77.5
% 

83.8
% 

90.3
% 

96.9
% 

100.0
% 

100.0
% 

100% 

60% 60% 67.6
% 

73.5
% 

79.3
% 

85.0
% 

90.6
% 

96.4
% 

100.0
% 

100.0
% 

100.0
% 

100% 

70% 70% 77.2
% 

82.4
% 

87.5
% 

92.5
% 

97.3
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100% 

80% 80% 86.8
% 

91.4
% 

95.7
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100% 

90% 90% 96.4
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100.0
% 

100% 

100
% 

100% 100% 100% 100% 100% 100% 100% 100% 100% 100% 100% 

Column Headers represent Wind-Only Building Loss percentages, Row Labels represent Flood-
Only Building Loss percentages. 
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Visual 42: Combined Flood and Wind Losses 
 

• The flood model (surge) calculates 
losses on the census block level: in a 
combined hurricane/flood model the 
hurricane wind model will calculate 
losses on the block level.  

• Combined losses can only be calculated 
on the GBS inventory: user-defined 
facilities and site-specific facilities 
cannot be analyzed using the combined 
analysis.  

 

 
NOTE: The Set Optimization option is only available in flood/hurricane regions. If you are not 
interested in combined surge/wind, select this to run the hurricane model at the tract level 
(faster). 
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Visual 43: Wind-Only Economic Loss Table 
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Visual 44: Combined Wind & Flood Loss Table 
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Visual 45: Combined Wind & Flood Loss Table 
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Visual 46: Combined Loss Summary Report 
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Visual 47: Exercise 10.3: Surge Menu 
Goals: 

• Explore the Surge menu items in the hurricane model and flood model. Discuss the 
reports and tables from the combined losses. 

Time: 45 Minutes 
 

 

Student 
Manual 

 

Exercise 10.3: Surge Menu 
Goals: 

• Explore the Surge menu items in the hurricane model and flood 
model.  

• Discuss the reports and tables from the combined losses.  
Time: 45 minutes 

1. Refer to Activities Document “10.3_Exercise_Surge Menu.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Follow along to complete the task with the instructor.  
5. Complete the goal assigned.  
6. Ask any final questions.  
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Visual 48: Exercise 10.3: Tasks 
Task 1: Define User Data    
Task 2: Create a New Scenario 
Task 3: Run the Surge Analysis 
Task 4: View Reports and Discuss Map Options  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 10: Hurricane Surge Model  SM-472 

Activity 10.3: Surge Menu 
Type: Instructor-Led Activity  
Time: 45 minutes  
Goal: Explore the Surge menu items in the hurricane model and flood model. Discuss the reports 
and tables from the combined losses. 
Background:  
This activity is a continuation of the previous activity in which you created a combined 
Flood/Hurricane study region and defined your analysis. This activity begins as if the analysis 
had just finished. Using an imported study region, you will move to the flood model, run the 
analysis, and view the results in table and report forms. 
 

Task 1: Define User Data    
1. Open Hazus.  
2. Select Import a region and then click OK.  
3. Navigate to C:\E0170_ActivityData\Activity_10.3 folder and select the Irma_Surge.hpr and 
click “Open”.  
4. Name the imported region “Irma_Surge”. If you receive a duplicate log file error for 
“Irma_Surge” name this study region “Irma_Surge_HUFL”.  
5. Click “OK”.  
6. When the import finishes, “Open” the region and when prompted, indicate that you wish to 
open the Hurricane hazard.  
7. From the Analysis menu select “Show Coastal Surge Status”.  
 

 

 
 

 
8. Click “OK”.  
9. Click the Switch Hazard button and change the hazard to Flood. You can also find the switch 
hazard option in the File menu.  
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10. Click “Yes” if you are asked to save changes to HazusHu.mxd.  
11. Open the Hazard menu to choose Flood Hazard Type.  
12. Select “Coastal Surge” and click “OK”.  
 

 

 
 

 
13. From the Hazard menu choose User Data and select the DEM tab.  
14. Click Determine required DEM extent.  
15. Once complete, click Download and Unzip All.  
16. Click OK when complete.  
17. Click Yes to incorporate the DEM data into the study region.  
18. Click OK.  
19. Click Yes on the Process window. This should take less than a minute.  
20. Click OK when complete.  
21. Navigate to the Hazard menu and choose User Data again.  
22. Click the Coastal Surge tab.  
23. This window specifies the location of the surge grids that will be used in the analysis. You 
can view these datasets in ArcGIS. Note that the location of your data may be different than the 
example shown below if your software was installed to point to a different location for study 
regions.  
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24. Click “OK” to process the DEM and click “Yes” to acknowledge you want to proceed. This 
will take less than a minute to complete.  
25. Click “OK” once the DEM processing is complete.  
 

Task 2: Create a New Scenario. 

1. From the Hazard menu choose “Scenario > New”.  
2. Name the scenario Irma_Surge and click OK. This prompts the shoreline wizard to populate.  
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3. Accept the default shoreline limits by clicking “Next”. We will use the default assumptions for 
the shoreline.  
4. Choose “Open Coast (full exposure)” for the Wave exposure. We are choosing this for speed. 
Many of the shorelines are actually protected from wave exposure.  
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5. Click “Finish”.  
6. From the Hazard menu choose “Coastal > Delineate Floodplain”. This will take approximately 
5 minutes to complete.  
7. Once completed, click “OK”. You should now see the storm surge flood depth grid appear on 
the map.  
 

Task 3: Run the Surge Analysis 

1. From the Analysis menu choose “Run”.  
2. Click Select All and then unselect the “What-If” option. If you do not unselect the What-If 
option the combined losses may not populate.  
3. Click “OK” to start the analysis. This will take approximately 10 minutes to complete. If you 
have not taken a break, this is a good time for a short break.  
4. When prompted enter September 12 as the flood date and click “OK”.  
5. Click “OK” once the flood analysis has completed.  
6. From the Analysis menu choose Combined Wind and Flood…This initializes the combined 
hurricane wind and surge analysis.  
7. Click OK to begin the analysis.  
8. Click “OK” when you are informed that the combined analysis has completed.  
 

 

 
 

 

Task 4: View Reports and Discuss Map Options  

1. From the Results menu choose View Current Scenario Results By…  
2. Under Available Results choose “Mix0”.  
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3. Click “OK”.  
4. From the Results menu choose Combined Wind and Flood Loss. This table contains the flood 
only, wind only, and combined losses for each census block.  
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5. Close the Combined FL/HU Surge Direct Economic Losses For Full Replacement Value 
window.  
6. From the Results menu choose Summary Reports.  
7. Click on the Losses tab.  
8. Click on the “Combined Wind and Surge Loss” report and then click “View”. This is the 
combined losses report.  
 

 

 
 

 
9. “Close” the report.  
10. Click the Switch Hazard button and go back to the Hurricane hazard.  
11. When prompted, click “Yes” to save your changes.  
12. Under the Results menu choose Combined Wind and Surge Loss > By Occupancy.  
13. The table shows the combined losses. “Close” the window when you have viewed the layout.  
14. From the Results menu choose Summary Reports.  
15. Click on the Direct Losses tab.  
16. Click on the Combined Wind and Surge Loss report and then click “View". Notice that the 
losses reported in this report are identical to the report that you viewed in the flood model. This 
report is provided in both the hurricane and flood models for the user’s convenience.  
17. Close the Summary Report.  
18. When you are finished click “Save”.  
19. Exit Hazus.  
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Visual 49: Lesson 10: Review 
1. What are the causes of a storm surge?  
2. What are the Hazus surge model components?  
3. What is the procedure for running a hurricane surge in Hazus?  
4. How do the hurricane and flood model damage and loss analyses differ (not combined)?  
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Visual 50: Questions? 
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Lesson 11: Mitigation Analysis 
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Visual 1: Lesson 11: Mitigation Analysis  
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Visual 2: Lesson 11: Goal and Objectives 
Goal: To provide an overview of the mitigation analysis provided in Hazus.  
After completing this lesson you will be able to:  

• Understand the common mitigation practices for hurricanes.  
• Explain how mitigation is modeled in Hazus.  
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Visual 3: Applying Mitigation 
• In Hazus: Modifying wind building mapping scheme  
• Can be applied:  

• One technique at a time  
• Many techniques at once  

• Can be applied geographically:  
• Entire region  
• Specific census tracts  

• Applies to all building classes  
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Visual 4: Possible Uses of Mitigation Options 
Identify mitigation options with best return on investment. 

• Answers depend on local hurricane climatology and building stock 
• Additional information required: mitigation cost data 

Predict impact of building stock changes: 
• New building codes 
• New construction trends 
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Visual 5: Mitigation of Damage: Options for… 
 
Single-Family or Multi-Family Residential:  

• Roof covering  
• Secondary water resistance  
• Roof sheathing attachment  
• Roof framing attachment  
• Opening protection  

Manufactured Homes: 
• Tie-downs  
• Opening protection   
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Visual 6: Mitigation of Damage: Options for… 
Commercial buildings (low-rise strip mall buildings):  

• Shutters on all windows and entry doors  
• Roof-wall connection clips/straps  
• Superior wood roof deck attachment  
• Superior metal roof deck attachment  

Commercially engineered buildings, low rise industrial buildings, and pre-engineered metal 
buildings:  

• Superior metal roof deck attachment  
• Opening protection  
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Visual 7: Roof Covering 
• Best solution to mitigate loss of roof cover:  

• Replacement of inferior products with superior ones  
• Consider life span of roof:  

• Shingles: 10-25 years  
• Tiles: 50+ years  

• Consider cost of replacement:  
• Shingles: Approx. $3,000-5,000 (relatively cheap)  
• Tiles: Approx. $20,000 (relatively expensive)  

• Hazus model does not include models for concrete tiles or metal roofs (except Hawaii)  
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Visual 8: Shingle Roof Covering Standards 
Testing Standards:  

• ASTM D7158 (modified to 115 mph)  
• SFBC PA 107 or PA 108: Dade County test for wind resistance of shingles  
• UL 997 modified to 110 mph: Make sure it is high wind version of test  

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 11: Mitigation Analysis  SM-490 

Visual 9: Secondary Water Resistance (SWR) 
Applied on all plywood joints  
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Visual 10: Secondary Water Resistance (SWR)  
 

• Roof cover loss is likely.  
• SWR serves as backup in event of roof 

covering losses. 
• Self-adhering waterproof 

underlayment  
• Meets ASTM D 1970  
• Apply at time of normal re-roofing  

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 11: Mitigation Analysis  SM-492 

Visual 11: Roof Sheathing Attachment 
 
Re-nail with tighter nail spacing:  

• SSTD 10-99: Latest code 
requirements are 6”x6” spacing 
in high wind areas  

• Re-nail during re-roofing option  
Re-nail with stronger fasteners: 

• Larger nails 
• Ring shank nails  
• Screws  

 
Not a good option for expensive roof coverings such 
as tile or slate 
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Visual 12: Roof Framing Attachment 
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Visual 13: Opening Protection 
Openings include: 

• Windows 
• Doors (including patio and French doors) 
• Sliding glass doors 
• Garage doors 
• Skylights 

Protection takes two forms: 
• Replace existing fenestration with one that is impact-resistant 
• Install external protection devices that are impact-resistant 
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Visual 14: Opening Protection 
Large Missile Impact Test: 

• Firing a 2x4 at approximately 50ft/s at product 
• Product passes if it remains operable after resisting impacts 

Four Dominant Impact Standards: 
• ASTM E 1996 - 9lm missile 
• SBCCISSTD 12-97 
• Dade County South Florida Building Code PA 201 
• Florida Building Code TAS 201 

Small Missile Impact Test: 
• Approx. 20 pieces of gravel are fired with a cannon at the product 

  
NOTE: These tests also include a pressure cycling component 
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Visual 15: Opening Protection 
 

 
 

 

 

Student 
Manual 

 

 Opening Protection 
• Transcript of the video: 

• 00:01 "Ready" 
• 00:03 "Fire" 

• The video demonstrates a large missile impact test where a 9lb 2x4 is 
shot from an air cannon at a shutter specimen. The shutter withstands 
the impact of the missile.   

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 11: Mitigation Analysis  SM-497 

Visual 16: External Protection Devices (Shutters) 
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Visual 17: Shutters vs. Impact Resistant 
Replacement of doors/windows vs. external protection devices 
Exceptions: 

• Garage doors: Large spans make shuttering difficult 
• Entry doors: One entry door to the building is replaced with an impact resistant product 

to allow for egress regulations in building code 
• Skylights: Very few external protection devices exist 
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Visual 18: Replacement Garage Door 
 
Impact door features: 

• Ribs to reinforce panel  
• Heavy track  

Alternative retrofit: 
• Post system  
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Visual 19: Other Information 
 
Fortified for Safer Living: 

• By Institute for Business and Home Safety  
• For more information visit: disastersafety.org 

Blueprint for Safety: 
• By Federal Alliance for Safe Homes  

For more information visit: www.flash.org  
Coastal Construction Manual: 

• Principles and Practices of … Residential Buildings in 
Coastal Areas  

• FEMA P-55, 4th Edition (2011)  
• For more information visit: https://www.fema.gov/media-

library/assets/documents/3293  

 
 

 

https://www.fema.gov/media-library/assets/documents/3293
https://www.fema.gov/media-library/assets/documents/3293
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Visual 20: Mitigation Benefits (SE Florida) 
Single-Family Homes Reduction in Annualized Hurricane Losses 

(AHL)  

Install Shutters 17% to 46%  

Upgrade Roof 3% to 49%  

Add Secondary Water Resistance 3% to 35%  

Upgrade Roof and Add SWR 4% to 57%   

Install Shutters and Upgrade Roof 46% to 71%  

Shutters, Upgrade Roof and SWR 51% to 85%  

  

Manufactured Homes  Reduction in AHL  

Foundation Tie-Down 9% to 25%  
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Visual 21: Discussion 11.1: Mitigation Options 
Goal: 

• Discuss mitigation options.  
Time: 10 minutes  
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Visual 22: Exercise 11.2: Mitigation Actions 
Goals:  

• Run various mitigation scenarios.  
• Compare and contrast the results.  

Time: 45 minutes  
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Visual 23: Exercise 11.2: Tasks 
Task 1: Create a Study Region 
Task 2: View the Pre-Mitigation Annualized Loss Estimates.  
Task 3: Create and Apply a Mitigation Mapping Scheme. 
Task 4: View the Post-Mitigation Annualized Loss Estimates.  
Task 5: Compare the Estimated Losses  
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Exercise 11.2: Mitigation Actions 
Type: Student-Led Activity  
Time: 45 minutes  
Goals:  

• Run various mitigation scenarios.  
• Compare and contrast the results.  

Background:  
This exercise illustrates the type of strategies you can pursue for evaluating the risk posed by 
hurricanes. To examine this risk, you will import a completed probabilistic analysis, examine its 
losses, implement mitigation strategies to the building stock, and examine the reduction in 
annualized losses from the hurricane. This type of approach is often useful when developing 
mitigation strategies since communities work with limited resources and they must use the best 
information available, often prepared with tools such as Hazus, to apply those resources in the 
most effective manner possible. 
 

Task 1: Create a Study Region.  

1. Double-click the Hazus icon on your desktop.  
2. Click Create a New Region and click OK.  
3. Click Next.  
4. Enter Michael_Mitigation as the study region name.  
5. Check the box next to the Hurricane hazard.  
6. Click Next.  
7. Click No to using the Hurricane Scenario Wizard to create the study region.  
8. Select County and click Next.  
9. Choose Florida and then click Next.  
10. Select Gulf county and then click Next.  
11. Click Finish and open the region  
 

Task 2: View the Pre-Mitigation Annualized Loss Estimates.  

1. From the Hazard menu choose Scenario.  
2. Click Next.  
3. Choose Probabilistic and make sure radio button next to Activate is filled.  
4. Click Next.  
5. Click Next on the Activate Scenario window.  
6. Click Finish.  
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7. Go to Analysis and then Run.  
8. Select all except for the Automated Output Options and click Run Analysis.  
9. From the Results choose General Building Stock > Building Economic Loss > by Occupancy 
to open the Building Economic Loss by Occupancy window.  
10. Click the Direct Economic Loss tab and verify that View Results by All Occupancies is 
selected.  
11. Change the Return Period to “Annualized”.  
 

 

 
 

 
12. Select the Total column and click the “Map” button. This will add the layer “Total Loss - All 
- Annualized ($K)” to the map.  
13. Click “Close” to close the Building Economic Loss by Occupancy window.  
14. Right-click the Total Loss - All Annualized ($K) layer and choose “Data” > “Export Data” to 
open the Export Data window. Note: This layer will be used to compare the pre-mitigation losses 
with the post mitigation losses to calculate the savings associated with applying the mitigation 
actions.  
15. In the Export Data window click on the “Browse” folder icon.  
16. Navigate to C:\E0170_ActivityData\Exercise_11.2 and name the file 
“Total_Loss_Annualized_Before”.  
17. Change the Save as type drop-down menu to “Shapefile”.  
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18. Click “Save” to close the Saving Data window.  
19. Click “OK” to close the Export Data window.  
20. Answer “Yes” to add the exported data to the map as a layer.  
 

Task 3: Create and Apply a Mitigation Mapping Scheme. 

1. From the Inventory menu choose General Building Stock > Wind Building Characteristics 
Distribution to open the Wind Building Characteristics Distribution window.  
2. At the bottom of the window click on Florida_North and then click “View”.  
3. Double-click on the Wood folder and then click on WSF1 – Single Family Homes, 1 Story – 
Wood.  
4. Scroll down to the Shutters Category. Note: The percentage of homes with shutters (8%) and 
the percentage without (92%). We will apply a mitigation scheme that will increase this 
percentage later.  
5. Click “OK” to close the Wind Building Characteristics Distribution Window.  
6. Click on “Gulf, FL” from the Counties selection box. Notice all of the census tracts in Gulf, 
FL are assigned the Florida_North mapping scheme.  
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7. Select the Florida_North mapping scheme on the bottom half of the window and indicate that 
you want to create a new Mapping scheme by clicking “Mitigate”.  
8. Name the new Mapping Scheme Florida_North_Mitigated and change the percentage of 
Shutters on All Windows and Entry Doors for Single Family Homes to 100%.  
Note: This will simulate a program that would provide incentives to existing residential housing 
to shutter and require all new housing to be constructed with shutters.  
9. Click the check box to Mitigate next to the 100% increase.  
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10. Click “OK” to close the Mitigate Hurricane Building Characteristics Scheme window. In the 
next few steps you will apply the new mitigated mapping scheme to the whole study region.  
11. Select Gulf, FL from the counties in the middle box. Select the County List radio button.  
12. Under the County column in the window to the far right select Gulf, FL.  
13. Choose Florida_North_Mitigated from the Mapping Schemes drop-down box.  
14. Click “Apply” to ensure the mitigation options are applied.  
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 11: Mitigation Analysis  SM-510 

 
 

 
15. Click “OK” to close the Wind Building Characteristics Distribution window.  
16. Navigate to the Analysis menu and click on “Analysis > Run”. Select all of the options 
except the Automated Output Options and then click “Run Analysis”.  
17. Once the analysis has finished click “OK”.  
 

Task 4:  View the Post-Mitigation Annualized Loss Estimates.  

1. From the Inventory menu choose General Building Stock > Wind Building Characteristics 
Distribution to open the Wind Building Characteristics Distribution window.  
2. At the bottom of the window click on Florida_North_Mitigated and then “View.”  
3. Double-click on the Wood folder and click on WSF1 – Single Family Homes, 1 Story – 
Wood.  
4. Scroll down to the Shutters Category. The percentage of shutters should have increased to 
100%.  
5. Click “OK” to close the Florida_North_Mitigation mapping scheme.  
6. Click “OK” to close the Wind Building Characteristics Distribution window.  
7. From the Results menu choose General Building Stock > Building Economic Loss > By 
Occupancy to open the Building Economic Loss by Occupancy window.  
8. Click the Direct Economic Loss tab and verify that View Results by All Occupancies is 
selected.  
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9. Click Annualized from the Return Period drop down selection.  
10. Select the Total column and click on “Map”. This will add the layer “Total Loss - All - 
Annualized ($K)” to the map.  
 

 

 
 

 
11. Click “Close” to close the Building Economic Loss by Occupancy window.  
12. Right-click the Total Loss - All - Annualized ($K) layer and choose Data > Export Data from 
the layer context menu to open the Saving Data window.  
13. In the Saving Data window click on “Browse”.  
14. Navigate to C:\E0170_ActivityData\Exercise_11.2 and name the file 
Total_Loss_Annualized_After.shp  
15. Select Shapefile from the Save as type drop-down menu.  
16. Click “Save” to close the Saving Data window.  
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17. Click “OK” to close the Export Data window.  
18. Answer “Yes” to add the exported data to the map as a layer.  
 

Task 5: Compare the Estimated Losses  

In the following section you will be using ArcGIS tools to compare the total annualized losses 
pre and post mitigation. You should have exported two layers:  

• Total annualized losses calculated by Hazus without mitigation options applied  
• A layer of total annualized losses calculated by Hazus with all of the mitigation options 

applied.  
The Intersect tool in the ArcToolbox will be used to combine the results into one layer. Once this 
layer has been created you will then calculate the differences in losses within each census tract.  
1. From the Geoprocesssing menu choose “Intersect”.  
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2. For Input feature class select both the Total_Loss_Annualized_After layer and the 
Total_Loss_Annualized_Before layer.  
3. For Output feature class, click “Browse” and navigate to the 
C:\E0170_ActivityData\Exercise_11.2 folder and enter “Savings”.  
4. Click “Save”. Leave all of the other default settings as they are.  
Note: If necessary, use the arrows to move the position of the before and after layers. They must 
be in the order shown for the process to work correctly. The Intersect window should appear as 
shown below.  
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5. Click “OK” to complete the intersect process.  
6. Right-click on the Savings layer (which should have appeared at the top of the table of 
contents) and choose “Open Attribute Table” to view the attributes of the data.  
Tip: If the Savings layer does not appear in the Table of Contents window, use the Add Data 
button and add it to the table of contents window.  
7. Click Table Options in the Savings table and select “Add Field”.  
8. Enter “Savings” as the field name and select “Double” as the field type.  
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9. Click “OK” to add the new field which should appear at the end of the table. 
 

 

 
 

 
10. Right-click on the Savings field and select “Field Calculator”.  
Tip: If asked, click “Yes” when prompted to indicate that you know that your edits cannot be 
undone. The field calculator allows calculations on fields in the attribute table.    
11. Create an expression that says [Total] - [Total_1] as shown below. This expression produces 
an output that reflects the savings resulting from your mitigation action.  
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12. Click “OK” to run the calculation and to update the Savings field.  
13. Close the Savings table by clicking Close in the upper right corner of the table window.  
14. Right-click on the Savings layer and choose “Properties” to open the Layer Properties 
window.  
15. Click the Symbology tab to view the Symbology options.  
16. Select the Graduated colors option under the Quantities menu.  
17. Select “Savings” as the value field.  
18. Select “Total” as the field by which to normalize.  
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Note: Normalizing data is very important since it establishes a foundation by which to compare 
values. For instance, population totals are often normalized by the area in which the population is 
located, thus creating a population density.  
 

 

 
 

 
19. Click on the Labels tab.  
20. Click in the check box next to Label features in this layer to turn the labeling on in this layer.  
21. Click Expression to open the Label Expression window and enter “Round (100*[Savings]/ 
[Total] ,2)” as the label expression. This expression produces a label that shows the percentage 
of savings and rounds the value to two decimal places.  
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22. Click “OK” to close the Label Expression window and then “OK” to close the Layer 
Properties window and to update the map. The values shown on the map represent percentage 
reduction of total losses that were achieved through the mitigation measures that you imposed on 
the region. Notice the spatial differences in these reductions.  
23. Use the layer to answer the following questions:  
This exercise demonstrates what the overall reduction in annual losses would be for only Single 
Family Residential homes if every home in the community had shutters or an increase of 92% of 
shuttering (8% was already assumed to have shuttering).  
 

Question Answer 
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Question Answer 

What is the minimum percentage of savings 
after mitigating the study region? 

 

What is the maximum percentage of savings 
after mitigating the study region? 

 

What was the total savings (in dollars)?  

 
24. Exit Hazus and select “Yes” when prompted to indicate whether you wish to save your 
changes. 
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Visual 24: Lesson 11: Review 
1. What are the four occupancy types that can be mitigated in Hazus?  
2. What are two types of opening protection?  
3. What is the potential reduction in loss from shuttering a structure?  
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Visual 25: Questions? 
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Lesson 12: Hazus for Response and Recovery 
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Visual 1: Lesson 12: Hazus for Response and 
Recovery 
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Visual 2: Lesson 12: Goal and Objectives 
Goal: To provide an overview of how to set up Hazus for response and recovery operations. 
After completing this lesson, you will be able to: 

• Read and understand a Tropical Forecast Advisory. 
• Understand how to input a Tropical Forecast Advisory into Hazus. 
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Visual 3: Hazus for Response and Recovery 
• Predicting effects of hurricanes: Warning time of hurricanes is typically 3-5 days  
• During hurricane season: Advisories are issued every six hours for all tropical storms 

with intermediate advisories for landfalling for rapidly changing storms  
• Current position/strength and predicted position/strength can be used to make estimates 

of likely damage. 
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Visual 4: When to Start Running Hazus 
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Visual 5: Obtaining Storm Data 
 

• Tools for manual entry of storm data:  
• Designed to allow users to run 

analysis in Hazus based on forecast 
advisories.  

• National Hurricane Center of the 
National Weather Service offers 
several products. 

• Forecast advisories contain all 
information needed for Hazus. 
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Visual 6: User Defined (Single Storm) Scenario 
 

• User-Defined Scenario Type offers four 
options for data 

• Hurrevac or Census tract data file 
should be used for recovery once 
observed data are available  
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Visual 7: Typical Storm Parameters 
Typical Storm Parameters 

Saffir Simpson Scale 1 Min Mean (mph) 3 sec Gust (mph) Min Central Pressure 
(mb) 

1 74-95 90-116 980 and greater 

2 96-110 117-134 965-979 

3 111-129 135-159 945-964 

4 130-156 160-189 920-944 

5 157+ 189+ 920 and below 

1 min mean = Hazus Input Windspeeds 
3 sec gust = Hazus Output Windspeeds 
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Visual 8: Using Forecast Advisories 
 

• Forecast advisories: Text files that are 
available for download.  

• Contain storm data:  
• Lat/Long 
• Central pressure  
• Radius to hurricane winds  
• Translation speed of storm  

• Units: 
• Times - UTC. 
• Distances - nautical miles. 
• Wind speeds - knots. 
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Visual 9: Using Forecast Advisories 
To run the uncertainty analysis, user must enter the times in standard advisory format (0 , 9, 21, 
33, 45, 69).  

 

 
 

 

Times in Standard Advisory 
Format 

Day of Current Month Forecast Time 

0 hours Start Time 29 0300Z 



August 2020 E0170: Hazus for Hurricanes 

Lesson 12: Hazus for Response and Recovery  SM-532 

Times in Standard Advisory 
Format 

Day of Current Month Forecast Time 

9 hours from Start Time 29 1200Z 

21 hours from Start Time 30 0000Z 

33 hours from Start Time 30 1200Z 

45 hours from Start Time 31 0000Z 

69 hours from Start Time 01 0000Z 
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Visual 10: Editing Storm Information 
 

• Delete rows by right-clicking on header. 
• Make sure there is only one blank row 

at bottom before clicking “Next.” 
• “Time (hours)” format needed for 

Uncertainty Analysis. 
• “Central Pressure (mbar)” and “Inland” 

taken from Advisory.  
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Visual 11: Entering in Forecast Advisories 
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Visual 12: Using NHC Advisories 
Forecast advisories: 

• Conservative estimates 
• Don't update central pressure 
• Don't update radius to wind speeds realistically 

Hazus model enforces a realistic relationship between radius, central pressure, and wind speeds. 
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Visual 13: Hurrevac 
 

• HURRicane EVACuation 
• Taken from NHC advisory information 
• Historical storms database 
• Eliminates entering information from 

the text-based advisories 
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Visual 14: Response and Recovery Points 
 

• There are uncertainties within Hazus. 
• Forecasts are subject to changes in track 

and intensity. 
• Causes changes in damage and loss 

estimations. 
• Damages and losses are based on 

windspeeds.  
• If these change, damage and loss 

calculations also change. 
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Visual 15: Track Comparison 
 

• Changes in position of a hurricane 
track can make significant 
changes to results.  

• Discussed further in the next 
section  

 

 
NHC official track forecasts (dashed blue lines) for Hurricane Irma from 0000 UTC 5 
September 2017 to 0000 UTC 12 September 2017. The best track is given by the white line 
with positions given at 6 hour intervals.  
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Visual 16: Errors in Forecasts 
  
  

 
"Official forecast intensity 
errors were above the mean 
official errors for the previous 
5-year period through 48 
hours, then considerably 
lower than average after that 
through 5 days. A 
homogenous comparison of 
the official intensity errors 
with selected guidance 
models is given in Table 7b. 
The NHC intensity forecast 
performed better than all of 
the intensity model guidance 
at 12, 96, and 120 hours, but 
was worse than all of 
guidance at 36 and 48 hours. 
This unusual dichotomy 
appears to be due to the 
cyclone weakening faster than 
expected over land at 36 and 
48 hours, but NHC correctly 
forecasting Harvey to stay a 
weak cyclone at long range, 
with almost every forecast 
point verifying over land." 
NHC Tropical Cyclone 
Report - Hurricane Harvey, 
May 2018 

 
NHC Tropical Cyclone Report – Hurricane Harvey, May 
2018        
https://www.nhc.noaa.gov/data/tcr/AL092017_Harvey.pdf 
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Visual 17: Demonstration 12.1: Forecast Advisory 
Uncertainties 
Goal: Discuss and demonstrate Forecast Advisory uncertainties.  
Time: 45 Minutes 
 

 

Student 
Manual 

 

Demonstration 12.1: Forecast Advisory Uncertainties 
Goal: Discuss and demonstrate Forecast Advisory uncertainties  
Time: 45 minutes  
Exercise Steps:  

1. Listen to instructor’s directions.  
2. Ask questions if clarification is needed.  
3. Watch the instructor's demonstration. 
4. Ask any final questions.  
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Visual 18: Exercise 12.2 Forecast Advisory 
Goals: 

• Run various user-defined scenarios.  
• Compare the results.  

Time: 30 Minutes 
 

 

Student 
Manual 

 

Exercise 12.2: Forecast Advisory 
Goals: 

• Run various user-defined scenarios.  
• Compare the results.  

Time: 30 minutes 
1. Refer to Activities Document “12.2_Exercise_Forecast Advisory.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal. 
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal. 
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 19: Exercise 12.2: Tasks 
Task 1: Investigate Hurricane Harvey Scenarios.  
Task 2: Import the Final Track using HURREVAC. 
Task 3: Explore the use of H*Wind files.  
Task 4: Compare the results. 
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Exercise 12.2 - Forecast Advisory 
Type: Student-Led Activity  
Time: 30 minutes  
Goals: 

• Run various user-defined scenarios 
• Compare the results 

Background: This exercise will help you learn to use forecasts and advisories available from the 
National Weather Service to create a user defined storm. This can be a particularly useful 
capability at times when you are trying to ascertain the potential impact of an oncoming storm, 
or when you are considering what impact a past storm might have based on currently exposed 
inventory.  
 

Task 1: Investigate Hurricane Harvey Scenarios 

1. Start Hazus.  
2. Create a study region with the following parameters:  

• Name: Harvey_Forecast  
• Hazard: Hurricane  
• County Level • State: Texas  
• Counties: Aransas and Nueces  

3. Open the Study region, and from the Hazard menu choose Scenario.  
4. Click Next to advance the scenario wizard.  
5. Select Create New Scenario and then Next.  
6. Select Define Storm Track Manually and click Next.  
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7. Name the new scenario ForecastAdvisory21 and click Next. This forecast is for Hurricane 
Harvey Forecast Advisory 21.  
8. Select the values shown below (Times and Radius to 64/50/34 Knot Winds).  
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9. Click Next to view the Interactive Storm Track Definition window.  
10. The first portion of Forecast Advisory 21 is on the next page. You can view the full advisory 
as a PDF located at C:\E0170_ActivityData\Exercise¬_12.2\Harvey Forecast Advisory 21.pdf.  
11. The beginning of the advisory contains descriptive information about the hurricane as well as 
the current location. Review this information. Try to interpret the information in the forecast on 
your own. Compare your results with the graphic after the advisory. Ensure that your values 
match those in the graphic.  
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12. Numbers have been added to the Forecast Advisory and the Edit Storm Track window to 
show where you can find the information required in the Hazus Edit Storm Track window. 
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• Note the longitude should include a negative sign  
• The radius must be converted from nautical miles to miles (*1.15)  
• The wind speed must be converted from knots to miles per hour (*1.15).  
• If the storm is inland, the words INLAND will appear on the advisory.  

 

 
13. Note the following key points:  

• Longitude should include a negative sign.  
• The radius must be converted from nautical miles to miles (multiply number in forecast 

by 1.15). 
• The wind speed must be converted from knots to miles per hour (multiply number in 

forecast by 1.15).  
• If the storm is inland, the words INLAND will appear on the advisory.  

14. Enter these values into the Edit Storm Track window.  
15. When completed, the Edit Storm Track window should look like the graphic below. 
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16. For the Central Pressure parameter, only the initial pressure is provided in the forecast 
advisory. You can create a reasonable central pressure number for the following advisories by 
using the table below.  

Saffir-Simpson 
Category 

Minimum 
Central Pressure 
mb 

Maximum Sustained Wind 
Speed (Over water) 
m/s 

Maximum Sustained Wind 
Speed (Over water) 
mph 

1 >= 980 33.1-42.0 74-94 

2 979-965 42.0-49.6 94-110 

3 964-945 49.6-58.1 110-130 

4 944-920 58.1-69.3 130-155 

5 <920 >69.3 >155 
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17. Use the following portion of the Forecast Advisory to complete the next line of the storm 
track. 
 

 

 
 

 
18. The Edit Storm Track window should now look like the following graphic.  

• The forecast box has been checked since this is a forecasted location of the hurricane.  
• Time indicates 9 hours. This is derived by counting the number of hours from the time of 

the first forecast point of the hurricane (1500Z) to the current time of the forecast point 
(0000Z) using a 24 hour scale.  
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19. Continue to add the rows to the storm track window using the rest of the forecast advisory 
below.   
 
17. Continue to add the rows to the storm track window using the rest of the forecast 
advisory below.   

 

 
 

 
20. Your final Edit Storm Track window should look the same as the one below. 
 
18. Your final Edit Storm Track window should look the same as the one below.  
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21. Click Next to move to the windfield calculations window.  
22. Click Next until prompted to indicate you would like to make this the active scenario.  
23. Click Next and then Finish to complete the wizard.  
24. From the Analysis menu select Run to open the Analysis Options menu.  
25. Click Select All to choose all of the analysis options except the Rapid Loss Options and the 
Automated Output Options.  
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26. Click Run Analysis to begin the analysis.  
27. Click OK when prompted to acknowledge that the analysis has completed.  
28. Open the Global Summary Report. This report is also provided in the folder 
C:\E0170_ActivityData\Exercise_12.2\Forecast Advisory 21 Global Summary Report.pdf.  
29. Use the report to complete the questions for the Forecast Advisory column in the table found 
at the end of the exercise.  
30. When you have completed the questions, close the Summary Reports window.  
 

Task 2: Import the Final Track using HURREVAC.  

In the next portion of the exercise you will import the final track for the same storm but this time 
using input generated from Hurrevac. The intent of this step is to demonstrate the difference 
between using a forecast advisory and a final storm track. The final storm track represents the 
actual track of the storm, whereas the forecast track is a projection of where the storm is 
forecasted to go.  
1. From the Hazard menu choose Scenario to open the scenario wizard.  
2. Click Next to advance to the scenario operation window.  
3. Click on Create New Scenario and click Next.  
4. Click Import Hurrevac storm advisory and click Next.  
5. Click the Download button.  
6. From the dropdown menu for Select Storm Letter, choose “H”. For the year select “2017”.  
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7. Click Download.  
8. When downloaded successfully click OK and then Close.  
9. Scroll through the list and select HARVEY with the date of 2017.  

• There are multiple Harvey entries, make sure you select the one from 2017.  
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10. Click Next to move to the Edit Storm Track window.  
11. Click Next again to move to the Windfield Calculation window.  
12. Once it completes hit Next four times and then Finish. Validating the storm track may take 
up to 2 minutes to complete.  
13. Run the analysis with all options selected except the Rapid Loss Options and the Automated 
Output Options.  
14. From the Results menu choose Summary Reports.  
15. Click the Other Reports tab, view the Global Summary Report. This report is also provided 
in the folder C:\E0170_ActivityData\Exercise_12.2\Hurrevac Global Summary Report.pdf.  
16. Use the report to complete the questions for Hurrevac Import in the table found at the end of 
the exercise.  
17. When you have completed the questions, close the Summary Reports window.  
 

Task 3: Explore the use of H*Wind files 

H*Wind files formatted for Hazus are special products and not widely circulated. They are 
produced by the Hurricane Research Division. This is a great dataset because it provides 
observational data recorded during the hurricane’s movement over land. This analysis compares 
track data with windfield computed by Hazus to observational data of actual winds measured 
from the hurricane. 
1. From the Hazard menu choose Scenario to open the scenario wizard.  
2. Click Next to advance to the scenario operation window.  
3. Click on Create New Scenario and click Next.  
4. Click Import from H*Wind File and click Next.  
5. Name the scenario Harvey_Hwind and click Next.  
6. Click browse and navigate to the C:\E0170_ActivityData\Exercise_12.2 folder.  
7. Select Harvey_Windfield_HazusReady.dat.  
8. Click Open and Next until you can click Finish.  
9. Run the analysis with all options selected except the Rapid Loss Options and the Automated 
Output Options.  
10. From the Results menu choose Summary Reports.  
11. Click the Other Reports tab, view the Global Summary Report. This report is also provided 
in the C:\E0170_ActivityData\Exercise_12.2\Hwind Global Summary Report.pdf.  
12. Use the report to complete the questions for H*Wind Import in the table found at the end of 
the exercise.  
13. Click Save and then close Hazus.  
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Task 4: Compare the results. 

Observe the difference in the results obtained by using updated forecast advisories. Due to the 
complex nature of hurricanes it is important that you consider early forecast advisories as general 
approximations of what may happen if a hurricane retains its current path and if it follows 
predictions exactly as they are defined in the forecast. However, due to the possibility of 
significant changes that might occur during the course of a hurricane’s evolution, information 
produced from early forecast advisories should be carefully used and distributed with caution. 

Question Forecast Advisory Hurrevac Import H*Wind Import 

What is the peak wind 
gust (mph) for the 
study region? 

      

How many 
Residential Buildings 
have been damaged? 
(minor, moderate, 
severe, and destroyed) 

      

What is the total 
estimated economic 
loss? 

      

How many people 
will require short term 
shelter? 

   

What is the total 
amount of debris 
generated? 
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Visual 20: Hurricane Recovery Timeline 
Length of recovery operations:  

• Days (Short-term): Resource Allocation  
• Weeks/Months (Intermediate): Clean up operations  
• Months/Years (Long-term): Rebuilding  
• Recovery groups: Economic, Health and Social Services, Housing, Natural and Cultural 

Resources 
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Visual 21: Lesson 12: Review 
1. How many hours are between the current location of a hurricane and the first forecast 

point?  
2. What is the elapsed time sequence required to run the uncertainty analysis when entering 

values into Hazus from a forecast advisory?  
3. What is the conversion factor from nautical miles to miles?  
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Visual 22: Questions? 
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Lesson 13: Considerations When Reviewing 
Results 
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Visual 1: Lesson 13: Considerations When 
Reviewing Results 
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Visual 2: Lesson 13: Goal and Objectives 
Goal: To provide an overview of considerations when reviewing results in the Hazus wind 
model.  
After completing this lesson you will be able to:  

• Understand forecast errors for landfalling hurricanes.  
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Visual 3: Sources of Uncertainty 
Wind Speed Estimates Only 116 years of storm data  

Incomplete/noisy observations 

Rainfall Model Simplified model based on limited data 

Terrain Roughness Land use is used to calculate surface 
roughness.  
Changes in land use 
Direction and transition effects. 

Load & Resistance Model Pressure coefficients 
Missile debris sources & transport 
Fatigue effects not modeled 
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Visual 4: Sources of Uncertainty 
Damage-to-Loss Model   Limited validation of implicit 

loss models 
 

Building Stock Distribution  Model building types 
Incomplete or incorrect 
inventory data 

 

Fast-Running Loss Functions   Average loss as function of 
peak gust 

 

Business Interruption Analysis parameters based on 
national averages 
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Visual 5: Treatment of Uncertainties 
• Hazus produces “best estimate results,” but there is no explicit treatment or estimation of 

uncertainty.  
• Potential impact of uncertainties can be assessed through multiple sensitivity analyses.  

• Intensity, size, speed, and track of scenario storms  
• Distributions of construction characteristics  
• Building valuation  
• Terrain and tree coverage  
• Economic and shelter model parameters  
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Visual 6: Uncertainty in Hazus 
• As a hurricane approaches landfall, the amount of uncertainty on its landfalling location 

decreases.  
• In Hazus, as you import forecast advisory information (Hurrevac or from NHC) over time 

in the days before a hurricane landfall, the uncertainty ranges will narrow, indicating it is 
too close for the hurricane to miss the study region.  
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Visual 7: Example: Sensitivity to Wind Speed 
 

 
 

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 13: Considerations When Reviewing Results  SM-567 

Visual 8: Example: Sensitivity to Terrain 
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Visual 9: Ranking of Uncertainties 
Smaller storms and/or smaller study regions will generally have greater uncertainties.  

• Individual building / single storm  
• Regional loss / single storm  
• Regional return period losses / probabilistic  
• Regional annualized losses / probabilistic 

(Ranked from most to least uncertain)  
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Visual 10: Real-Time Hurricane Modeling 
 
While hurricane forecasts are improving, errors 
still exist.  

• 24 hour forecasts have a positional error 
of approximately 40 miles.  

• When compared to a city or county, this 
can have major consequences for 
damage and loss modeling.  

 

 
https://www.nhc.noaa.gov/verification/verify5.shtml 
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Visual 11: Real-Time Hurricane Modeling 
 
Intensity forecasts also have 
errors: 24 hour forecasts (10 
mph)  

• 120 to 130 mph  
• 10 mph increase, 8% 

increase  
• WSF1 goes from 

10% loss to 25%  
• 130 to 140 mph  

• Changes from 25% 
to 50% loss  

• See Building Loss 
Function Viewer  

 
While the positional forecasts have improved considerably, 
the intensity forecasts have remained nearly the same. 
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Visual 12: Recommendations 
• Understand dependency of modules and analysis parameters.  
• Enhance inventory data:  

• Building value, square footage, count  
• Occupancy mapping schemes  
• Wind building characteristics  

• Enhance terrain modeling using recent remote sensing data and/or local land use 
databases.  

• Develop local estimates for economic and shelter parameters.  
• Run sensitivity cases to see range of results.  
• Present results with appropriate caveats.  
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Visual 13: Exercise 13.1: Sensitivity of Hurricane 
Storm Parameters 
Goal:  

• Modify uncertain and sensitive variables in Hazus.  
• Run multiple scenarios.  
• Compare the results.  

Time: 45 minutes  
 

 

Student 
Manual 

 

Exercise 13.1: Sensitivity of Hurricane Storm Parameters 
Goal:  

• Modify uncertain and sensitive variables in Hazus.  
• Run multiple scenarios. 
• Compare the results.  

Time: 45 Minutes  
1. Refer to Activities Document “13.1_Exercise_Sensitivity of 

Hurricane Storm Parameters.”  
2. Listen to instructor’s directions.  
3. Ask questions if clarification is needed.  
4. Work individually on the goal.  
5. Ask questions to the instructor if needed.  
6. Complete the assigned goal.  
7. Be prepared to share your answers/results.  
8. Ask any final questions.  
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Visual 14: Exercise 13.1: Tasks 
Task 1: Create an Irma Study Region   
Task 2: Run the default landfall track scenario  
Task 3: Run the scenario with a modified speed.   
Task 4: Run the scenario with a modified size.  
Task 5: Run the scenario with a modified intensity.   
 

 

Student 
Manual 

 

Exercise 13.1 - Tasks 
• Refer to Activities Document “13.1_Exercise_Sensitivity of 

Hurricane Storm Parameters.”  
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Exercise 13.1: Sensitivity of Hurricane Storm 

Parameters 
Type: Student-Led Activity  
Time: 45 minutes  
Goals:  

• Modify uncertain and sensitive variables in Hazus.  
• Run multiple scenarios. 
• Compare the results.  

Background:  
This exercise will explore the impact of changing various parameters that define the course, 
speed, and strength of a hurricane. It is very important that you are aware of the differences that 
these types of inputs can produce with respect to predicted damages. This exercise only alters the 
hurricane parameters just slightly and illustrates the impact on the damage and loss estimates. 
 

Task 1: Create an Irma Study Region   
1. Start Hazus  
2. Create a new study region with the following parameters:  

• Name: Irma_Landfall  
• Aggregation level: County 
• State: Florida  
• Counties: Hillsborough and Pinellas  
• Hazard type: Hurricane 

 

Task 2: Run the default landfall track scenario  

1. From the Hazard menu choose “Scenario”.  
2. Click “Next” to advance the Scenario wizard.  
3. Select Create New Scenario and click “Next”.  
4. Select Import from Exported File and click “Next”.  
5. Name the new scenario Irma Landfall Track. This storm was created by entering latitude, 
longitude, wind speed, and central pressure information from forecast advisory information.  
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6. Click “Next”.  
7. Click on Browse and navigate to the C:\E0170_ActivityData\Exercise_13.1 folder. 
8. Select the import file named IrmaLandfallTrack.bin and click “Open”.  
9. Click “Next” to complete the import process and to perform the wind field calculation.  
10. Click “Next” after the application has finished computing the wind speeds.  
11. Click “Next” to move beyond the Storm Track Data window.  
12. Click “Next” to move through the Scenario Review.  
13. Click “Next” again  
14. Click Finish.  
15. From the Hazard menu choose Show Current.  
16. Click the Data tab. The data tab of the Current Hazard box should show the following 
information.  
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17. Click “Close” to close the Current Hazard window.  
18. From the Analysis select “Run” to open the Analysis Options menu.  
19. Select all of the options except the Rapid Loss Options and the Automated Output Options.  
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20. Click “Run Analysis” to begin the analysis. The analysis will take a few moments to 
complete.  
21. Click “OK” when prompted to acknowledge that the analysis has completed.  
22. Answer the questions for the column titled Irma Landfall Track found in the Results Table 
located at the end of the exercise.  
Note: Hints for answering these types of questions can be found in earlier exercises. You can 
also ask your instructor for assistance.  
 

Task 3: Run the scenario with a modified speed.   

In this task of you will copy the Irma Landfall Track scenario and modify the parameters to 
explore the impact of changing the speed of the storm.  
1. From the Hazard menu choose Scenario to start the Scenario Wizard.  
2. Click “Next”.  
3. Select the Irma Landfall Track scenario and select “Copy”.  
4. Click “Next”.  
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5. Name the new scenario Irma Change of Speed.  
6. Click “Next”.  
7. Edit the new scenario by selecting the Irma Change of Speed scenario, selecting “Edit”.  
8. Click “Next”.  
 

 

 
 

 
9. Click next until you reach the Edit Storm Track table.  
10. Scroll down to the bottom of the table where the boxes are checked in the Inland column.  
11. Edit the Time (Hours) column in the data table by increasing the times as shown below. This 
shows a faster moving hurricane than the previously modeled hurricane.  
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11. Complete the scenario wizard. Make the scenario active.  
12. Navigate to the Analysis menu and click "Run." Select all of the options except the Rapid 
Loss Options and the Automated Output Options. 
13. Answer the questions in the Results Table at the end of this exercise in the column 
entitled Irma Change of Speed.  
14. Return to this page and continue with the exercise after you have filled in the Irma Change 
of Speed column.  

 

 
12. Complete the scenario wizard and make the scenario active.  
13. Navigate to the Analysis menu and then click Run.  
14. Select all of the options except the Rapid Loss Options and the Automated Output Options.  
15. When the analysis is complete, click OK.  
16. Answer the questions in the Results Table at the end of this exercise in the column titled 
“Irma Change Speed”.  
17. Return to this page and continue with the exercise after you have filled in the Irma Change of 
Speed column.  
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Task 4: Run the scenario with a modified size.   

In this part of the exercise you will copy the Irma Landfall Track scenario and modify the 
parameters to explore the impact of changing the size of the storm.  
1. From the Hazard menu choose Scenario to start the scenario wizard.  
2. Click “Next”.  
3. Select the Irma Landfall Track scenario and “Copy”. Then click “Next”.  
4. Name the new scenario Irma Change of Size and click “Next”.  
5. Edit the new scenario by selecting the Irma Change of Size scenario, selecting “Edit”, and 
then clicking “Next” until you get to the data table.  
6. Scroll down to the bottom of the table where the boxes are checked in the Inland column.  
7. Edit the Radius to 64/50/34 Knot Winds (miles) column in the data table by increasing the 
miles as shown below. This shows a larger hurricane than the previously modeled hurricane.  
 

 

 
8. Complete the Scenario wizard and make the scenario active.  
9. Navigate to the Analysis menu and then click Run. Select all of the options except the Rapid 
Loss Options and the Automated Output Options.  
10. Answer the questions in the Results Table at the end of this exercise in the column titled 
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“Irma Change Size”.  
 

 
8. Complete the Scenario wizard and make the scenario active.  
9. Navigate to the Analysis menu and then click Run.  
10. Select all of the options except the Rapid Loss Options and the Automated Output Options.  
11. Answer the questions in the Results Table at the end of this exercise in the column titled 
“Irma Change Size”.  
 

Task 5: Run the scenario with a modified intensity.   

In the final portion of the exercise you will copy the Irma Landfall Track scenario and modify 
the parameters to explore the impact of changing the intensity of the storm.  
1. From the Hazard menu choose Scenario to start the Scenario Wizard. Click “Next”.  
2. Select the Irma Landfall Track scenario and select Copy. Then click “Next”.  
3. Name the new scenario Irma Change of Intensity and click “Next”.  
4. Edit the new scenario by selecting the Irma Change of Intensity scenario, selecting “Edit”, and 
then clicking “Next” until you get to the data table.  
5. Scroll down to the bottom of the table where the boxes are checked in the Inland column.  
6. Edit the Wind Speed column in the data table by increasing the wind speeds, by approximately 
10 mph, as shown below. This shows a stronger hurricane than the previously modeled 
hurricane.  
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7. Complete the Scenario wizard. Make the scenario active.  
8. Navigate to the Analysis menu and then click Run. Select all of the options except the Rapid 
Loss Options and the Automated Output Options.  
9. Answer the questions in the Results Table at the end of this exercise in the column titled “Irma 
Change Intensity”.  
 
Results Table 

Question Irma Landfa
ll Track 

Irma 
Change 
Speed 

Irma 
Change Size 

Irma Chang
e Intensity  

a) What is the maximum peak gust 
wind speed on land in the study area? 

    

b) How many Residential 
Buildings have been damaged? 
(minor, moderate, severe, destroyed) 
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Question Irma Landfa
ll Track 

Irma 
Change 
Speed 

Irma 
Change Size 

Irma Chang
e Intensity  

c) What is the Total Direct 
Economic Loss for the region? 

    

d) How many expected 
displaced households are there in the 
region? 

    

e) What is the total estimated 
debris in tons? 

    

 
Observe the difference in the results that you can obtain by using altered forecast advisories. Due 
to the complex nature of hurricanes, you must consider early forecast advisories as general 
approximations of what may happen if a hurricane retains its current path and if it follows 
predictions exactly as they are defined in the forecast. However, due to the possibility of 
significant changes that might occur during the course of a hurricanes evolution, information 
produced from early forecast advisories should be carefully used and distributed with extreme 
caution.  
10. Save your map document and exit Hazus.  
 



August 2020 E0170: Hazus for Hurricanes 

Lesson 13: Considerations When Reviewing Results  SM-584 

Visual 15: Lesson 13: Review 
1. What are two types of forecast errors for landfalling hurricanes?  
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Visual 16: Questions? 
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Lesson 14: Capstone Exercise 
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Visual 1: Lesson 14: Capstone Exercise 
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Visual 2: Lesson 14: Goal and Objectives 
Goal: To complete and present the Capstone Exercise  
Objectives:  

• Develop hurricane mitigation plan for chosen county OR  
• Develop hurricane response and recovery plan for chosen county.  
• Create PowerPoint presentation  
• Present to class in groups of 3-4  
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Visual 3: Capstone Exercise Explanation 
• The county planning board has hired your team to give a 20-minute PowerPoint 

presentation at its next public meeting on the severity of hurricane hazards in the county 
and the possible methods for mitigating or responding to future hurricane damage in that 
county.  

• You, as the consultant and a Hazus expert, have decided to use Hazus to analyze the 
county’s hurricane risk.  

• The results of your study will be presented at the monthly commissioners meeting.  
• Each group will present while the remaining participants assume the role of the 

commissioners.  
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Visual 4: Capstone Exercise Explanation 
Required issues to be addressed:  

• Which major hurricane(s) have impacted this region in the past?  
• What damage would the worst of these storms produce if it happened again today? 
• What is the approximate return period for the worst historic storm?  
• Summarize the number and value of buildings at risk to hurricanes.  
• Provide a map of essential facilities, high potential loss facilities, and any additional 

features you deem important for risk communication.  
• What are potential benefits of mandating shutters on all new single-family dwellings? 
• Summarize the assumptions made in your benefit analysis.  
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Visual 5: Capstone Exercise Explanation 
Presenter Guidelines:  

• Prepare using PowerPoint  
• Include maps, tables, or other media you deem appropriate  
• Information should be primarily derived from Hazus, but may be supplemented by other 

sources  
• 10-15 minutes in length  

Commissioner Guidelines  
• Class will assume the role of commissioners  
• Commissioners may ask questions related to the presentation  

 



August 2020 E0170: Hazus for Hurricanes 

Lesson 14: Capstone Exercise  SM-592 

Visual 6: Capstone Exercise 
• Allow groups time to work on their presentation.  
• Break as needed.  
• Additional work time will be provided after lunch.  
• Presentations will begin at 2:30pm.  
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Lesson 15: Course Wrap-Up 
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Visual 1: Lesson 15: Course Wrap Up 
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Visual 2: Lesson 15: Goal and Objectives 
Goal: To review the major themes of the course and discuss opportunities for learning more 
about Hazus.  
After completing this lesson you will be able to:  

• Identify courses and other opportunities for training available to enhance your Hazus 
skills.  

• Identify additional resources available to explore to enhance your Hazus experience.  
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Visual 3: Hazus Training 
Courses to Consider:  

• E0190: ArcGIS for Emergency Managers  
• E0172: Hazus for Floods  
• E0174: Hazus for Earthquake and Tsunami  
• E0317: Comprehensive Data Management for Hazus  
• E0177: Advanced Hazus Applications  
• E0179: Application of Hazus for Disaster Operations 
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Visual 4: Become A Hazus Expert! 
Hazus Trained User  

• E0190 ArcGIS for Emergency Managers (or prior GIS experience may substitute)  
• E0313 Basic Hazus  
• E0317 Comprehensive Data Management (CDMS) 
• Minimum of two of the following: 

• E0170 Hazus for Hurricanes 
• E0172 Hazus for Floods 
• E0174 Hazus for Earthquakes and Tsunami 

Hazus Practitioner  
• E0190 ArcGIS for Emergency Managers (or prior GIS experience may substitute)   
• E0313 Basic Hazus 
• E0317 Comprehensive Data Management (CDMS)  
• Minimum of two of the following:  

• E0170 Hazus for Hurricanes 
• E0172 Hazus for Floods 
• E0174 Hazus for Earthquakes and Tsunami  

• E0179 Application of Hazus for Disaster Operations 
• E0177 Advanced Hazus Applications 
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Visual 5: Hazus Community Participation 
 

• Hazus User Conference 
• Quarterly Newsletter  
• National Hazus User Group calls  
• Local Hazus User Groups  
• Hazus Outreach Email: hazus-

outreach@riskmapcds.com  

 
 

 

mailto:hazus-outreach@riskmapcds.com
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Visual 6: FEMA Hazus Website 
 

 
Primary FEMA resource for updated Hazus 
information:  
FEMA Hazus Website: 
https://www.fema.gov/hazus  

 
 

 

http://www.fema.gov/hazus
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Visual 7: Additional Resources 
Hazus YouTube Videos – http://bit.ly/HAZUS  

• 21 short (3-7 min) tutorials on all parts of Hazus. 
Hazus GitHub - https://github.com/nhrap-hazus  

• Site of published Hazus Open Source tools, such as Hazus FAST. 
• Hazus Training Data and Student Guides - Site TBD 

New Natural Hazards Risk Assessment Program website - https://www.fema.gov/nhrap 
• Document Container of methods and research applications - https://www.fema.gov/media-

library/assets/documents/180915  
 

http://bit.ly/HAZUS
http://github.com/nhrap-hazus
http://www.fema.gov/nhrap
http://www.fema.gov/media-library/assets/documents/180915
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Visual 8: Getting Help 
• Email Hazus Help Desk 

• hazus-support@riskmapcds.com 
• Consult the User Manuals and Technical Manuals 

https://www.fema.gov/hazus-mh-user-technical-manuals  
 

mailto:hazus-support@riskmapcds.com
http://www.fema.gov/hazus-mh-user-technical-manuals
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Visual 9: Questions? 
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Appendix: Activity Data Zip File Hurricane 
 
E0170 Activity Data 

 

https://fema.kenexa.com/lcms/servlet/ObjectLaunch?object_id=EA522052415325610DF71303003F4289&output_type_id=3&viewer_id=6EE72052415325FB2F64133E00014ED1&theme_id=fematheme
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